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1 Introduction 

1.1 Introduction to the Guide 

This guide introduces you to QuickBooks—Intuit’s easy-to-use, powerful accounting system for small 

businesses. The guide contains 16 lessons in addition to this chapter. 

This guide is designed to teach you how to use many of the features available in QuickBooks Financial 

Software for Windows. The main focus of this guide is on how to use the features in QuickBooks Pro, 

but it also contains exercises for features available only in QuickBooks Premier and QuickBooks 

Accountant Edition. This guide does not cover how to use the features in QuickBooks Online Edition, 

or QuickBooks Easy Start. 

While this guide does not specifically address how to use QuickBooks Enterprise Solutions, many of 

the procedures described in the guide will work with Enterprise Solutions editions. If you restore the 

exercise file using a QuickBooks Enterprise Solutions Version 13.0 product, QuickBooks walks you 

through the file update process that is necessary for Enterprise Solutions to be able to read the file. 

Most of the step-by-step instructions and screen captures in this guide were created with QuickBooks 

Pro and QuickBooks Premier 2013. Your screens may differ, and some instructions may vary slightly, 

if you are using a different edition.  

1.2 Objectives 

After completing the QuickBooks Learning Guide, you should be able to: 

 Create a new QuickBooks company. 

 Modify the preset chart of accounts to suit your needs. 

 Add information to company lists, or edit information in company lists. 

 Open and use registers for any QuickBooks balance sheet accounts. 

 Reconcile a QuickBooks chequing account. 

 Track credit card transactions. 

 Invoice customers. 

 Create sales orders. 

 Generate customer statements. 

 Receive payments from customers and make bank deposits. 

 Write QuickBooks cheques and assign amounts to specific expense accounts. 

 Work with asset and liability accounts in QuickBooks. 

 Enter bills into QuickBooks accounts payable. 

 Pay bills. 

 Create and customize QuickBooks reports and graphs. 

 Save reports and forms as Portable Document Format (PDF) files. 
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 Export QuickBooks reports to Microsoft® Excel. 

 Set up inventory and build finished goods. 

 Convert units of measure. 

 Track and pay sales tax. 

 Understand QuickBooks payroll features. 

 Create estimates and do progress invoicing. 

 Track time. 

 Pay nonemployees for time worked. 

 Customize QuickBooks sales forms. 

 Review the QuickBooks Premier Accountant Edition 

1.3 Toggling between QuickBooks editions 

We’ve provided you with this edition of the software because QuickBooks: Premier Accountant 

Edition 2013 gives you the ability to toggle among different QuickBooks editions. QuickBooks 

Premier Accountant edition allows you to switch to each of the QuickBooks Premier industry-specific 

editions—as well as to QuickBooks Pro and QuickBooks Easy Start. This may be useful to teach 

students about features available to support different industries, such as construction, non-profit, or 

retail. 

Toggling between QuickBooks editions offers the following benefits: 

 If you are teaching a class for a specific audience (such as non-profits or contractors), you can 

toggle to that edition and use the appropriate edition for the students. 

 When working with students or clients, toggling can help you evaluate which edition is right for 

them. 

You can toggle to any of the QuickBooks: Premier 2013 industry-specific editions as well 

as QuickBooks: Pro and QuickBooks: Easy Start. You don’t need to be logged in as 

Administrator, nor does QuickBooks need to be in single-user mode. 

Note:  QuickBooks does not support integrated applications while in toggle mode. 

Close any applications that share data with QuickBooks before toggling. 

1.3.1 To switch to a different edition: 

1. From the File menu, choose Toggle to Another Edition. 

2. When prompted, choose the edition of QuickBooks you want to use. Then click Next. 
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3. The Select QuickBooks Industry window displays the Edition that was chosen.  

Click Toggle to close QuickBooks and reopen as the edition you selected 

4. Read any messages and click OK. 

QuickBooks will notify you if there are changes in feature availability in a different edition. 

QuickBooks now closes and reopens as the edition you selected. Once reopened, the application 

title bar shows that you are running QuickBooks Accountant Edition configured as the current 

open edition, for example: “QuickBooks Premier: Professional Services 2013 (via Accountant 

Edition).” 

5. When you are done, go to the File menu and choose Toggle to Another Edition to return to 

QuickBooks Premier Accountant Edition. 
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1.4 Integrating QuickBooks with other products 

The following are required if you plan to use the integration features available in QuickBooks. 

 Microsoft® Word 2003, 2007, 2010 if you plan to use the QuickBooks Letters and Envelopes 

feature. 

 Microsoft® Excel 2003, 2007, 2010 if you plan to use the features in QuickBooks that integrate 

with Microsoft Excel. 

 Microsoft® Outlook 2003, 2007, 2010 if you want to synchronize with contact management 

software. Contact synchronization with Outlook requires QuickBooks Contact Sync for Outlook 

(the download is available at no charge). 

1.5 About the exercise file 

An exercise file is included with this training guide. Install the downloaded file to your computer’s 

hard disk as described below. You’ll use a copy of this file to complete the lessons in this guide. 

We recommend that you make a copy of the exercise file and store it in a safe place in case the original 

becomes damaged. 

1.5.1 Using the exercise file in each lesson 

For each lesson in this guide, except for lessons 1 and 2, you’ll restore a copy of the exercise file 

qblesson.qbb, and use that file to complete the lesson. The qblesson.qbb file you copy into the QBtrain 

directory on your hard disk is a QuickBooks backup copy. 

This means that at the start of each lesson, you’ll be restoring a new qblesson file. 

Instructions on how to restore the file are given at the beginning of each lesson. 

1.5.2 Installing the exercise file 

1.5.2.1 To install the exercise file on your hard disk: 

1. Download the exercise file to your hard disk. 

2. Right Click on your Windows desktop. 

3. Click New, then click Folder. 

4. Type QBtrain, and then press Enter. 

5. Open your Downloads folder.  

6. Select qblesson.qbb. 

7. Drag qblesson.qbb to the QBtrain folder on your hard disk. 

Your exercise file is now installed in the QBtrain folder on your hard drive. 

1.5.3 Exercise transaction dates 

The exercise file for use with this training guide was created in QuickBooks Pro and QuickBooks 

Premier 2013 with the date set to 12/31/2014. When you open the exercise file in QuickBooks, 

QuickBooks automatically sets the sample data file date to 12/31/2014. When you close the exercise 
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file, use your own QuickBooks company file, or exit QuickBooks, your system and QuickBooks dates 

will return to the current date. 

1.6 QuickStart Tips 

Many of the lessons in the QuickBooks Learning Guide include sections called QuickStart Tips. 

QuickStart Tips provide information that you may find helpful when you finish this self-study course 

and are ready to set up your own company data file in QuickBooks. 

1.7 Teaching Methodology and Methods 

This course is divided into 16 lessons and combines lectures with hands-on student participation. We 

encourage you to pick and choose lessons to fit the needs of your students, or to fit your own teaching 

objectives. 

Each lesson begins with a list of student objectives, supporting materials available, and instructor 

preparation.  

Some lessons in this course include one or more handouts. We encourage you to use the handouts 

provided with a lesson; they summarize or illustrate the main points of your lecture, and are helpful for 

students to refer to later. If you choose not to distribute a copy of each handout to all your students, 

you can display the handouts on an overhead projector as you explain the basic concepts. 

In addition, we’ve made the handouts available for download in Portable Document Format (PDF) 

from the Instructor’s Resource Center web site, which allows you to print the handouts as desired. 

To maximize hands-on practice with QuickBooks, a computer lab with one computer per student is 

ideal. If this is unavailable, you can teach the course with up to three students sharing a computer. 

However, sharing computers lengthens the course and reduces the effectiveness of student learning. 

Each lesson contains special notes that help you present the material. These notes are printed 

 in italics and appear at key places in the lessons. 

On the Instructor’s Resource Center web site, you’ll find Microsoft® PowerPoint presentations 

available for your use in the classroom lecture. 

1.8 Instructor preparation 

If you are new to the latest version of QuickBooks and want to see a list of new features, go to the 

QuickBooks Learning Center (from the Help menu, choose Learning Center), then click the “What’s 

New” tab. Another way to get information about what’s new in this version is to visit 

www.quickbooks.ca, which describes the new features in each edition.. 

1.9 Student prerequisites 

No knowledge of finances or accounting is needed to use QuickBooks. Students should, however, have 

a basic knowledge of the computer operating system and know how to move files around, create 

folders or directories, copy files to and from disks, and run applications. 
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2 Lesson 1: Getting Started 

2.1 Lesson Objectives 

 To gain an overview of the course and the topics to be covered  

 To know how QuickBooks works and how you can get around in QuickBooks  

 To learn common business terms used by QuickBooks  

 To see how to exit QuickBooks  

2.2 Supporting materials  

 PowerPoint file: Lesson 1  

2.3 Instructor preparation  

 Make sure you’ve read the sections called “Teaching methodology and methods” and 

“Instructor preparation” in the introduction to this guide.  

 Install QuickBooks on your computer’s hard disk.  

 Review this lesson, including the examples, to make sure you’re familiar with the material. 

 Ensure that all students have a copy of qblesson.qbb on their computer’s hard disk.  

2.4 To start this lesson  

Before you perform the following steps, make sure you have installed the exercise file  

(qblesson.qbb) on your hard disk. See “Installing the exercise file” in the introduction  

to this guide if you haven’t installed it. 

The following steps restore the exercise file to its original state so that the data in the file  

matches what you see on the screen as you proceed through each lesson. 

2.4.1 To restore the exercise file (qblesson.qbb): 

1. From the File menu in QuickBooks, choose Open or Restore Company. 

 QuickBooks displays the Open or Restore Company window.  

2. Select Restore a backup copy and click Next.  

3. Select Local backup and click Next.  

4. In the Open Backup Copy window, navigate to your c:\QBtrain directory.  

5. Select the qblesson.qbb file, and then click Open. 

6. In the Open or Restore Company window, click Next. 

7. Navigate to your C:\QBtrain directory. 

8. In the File name field of the Save Company File as window, type lesson1 and then click Save. 

9. Click OK when you see the message that the file has been successfully restored. 

10. If the Set up an External Accountant User window appears, click the “Do not show this again 

checkbox, and then click OK. 
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2.5 Course introduction  

This course is an introduction to QuickBooks. Its main objective is to introduce you to the basic 

features in QuickBooks and give you an opportunity for hands-on practice. You’ll learn about the types 

of information you need to track in your business, and you’ll see how to enter that information and 

track it in QuickBooks. By the time you complete the course, you’ll have a good idea of all that 

QuickBooks offers, you’ll be familiar with the most common tasks, and you’ll know where to find 

information about more advanced features.  

Depending on the size of your class, you may want to spend a little time inquiring about your students’ 

backgrounds—whether they own a business or are the bookkeeper for a small business, for example, or 

whether any of them have experience with accounting. This information can help you gear the course 

towards your students’ particular needs.  

2.6 Introducing QuickBooks  

Although most small business owners are worried about revenue, running a business involves a lot of 

other tasks. Depending on the type of business, you need to invoice customers, record payments from 

customers, pay your own bills to outside vendors, manage inventory, and analyze your financial data to 

see where you need to focus your next efforts. QuickBooks is a tool you can use to automate the tasks 

you’re already performing as a business owner or to set up a new business.  

Tell your students that they will see a demonstration of how QuickBooks works in a few minutes so 

they can get an overall view of the program. But first, here’s an overview of some of the basic features 

they’ll be seeing in the demo.  

When you’re working in QuickBooks, you’ll spend most of your time using a form, a list, or a register. 

Since these are so basic to QuickBooks, we’re going to spend a few minutes introducing them.  

2.6.1 Using forms  

You record most of your daily business transactions on a QuickBooks form, which looks just like a 

paper form. Here’s an example of the form you use when you want to record a bill from one of your 

vendors.  
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The form is intuitive—you already know how to fill out a form. But after you provide the information 

on a QuickBooks form, QuickBooks does the accounting for you in the background. For example, 

when you record a bill (using the Enter Bills window) QuickBooks enters transactions in your 

Accounts Payable register to show the expense you incurred. When you then write a cheque (using the 

Pay Bills window) to record the payment you made. (Accounts Payable is the money owed by your 

business to vendors) it also records the cheque in your chequing account, keeping your records up to 

date, and providing a running balance of what you owe at any time.  

2.6.2 Using lists  

The list is another basic QuickBooks feature. You fill out most QuickBooks forms by selecting entries 

from a list.  

You may want to point out that in the Enter Bills window above, the information in the Vendor, 

Terms, Account, and Customer:Job fields is pulled from lists.  

QuickBooks has lists where you can store information about customers, vendors, employees, items or 

services you sell, and so on. Lists save you time and help you enter information consistently and 

correctly.  

When you’re filling out an invoice form and you select a customer name from the Customer:Job list, 

QuickBooks not only fills in the name but also fills in the address, the payment terms, and the 

customer’s sales tax, based on the information previously entered about that customer.  

Here’s an example of the Customers & Jobs list in the Customer Centre.  

 

QuickBooks lets you complete a variety of activities from lists, using the menu buttons located at the 

top of each list. For example, to fill out an invoice for a customer, first select the customer from the 

Customers & Jobs list, and then choose Invoices from the New Transactions menu button.  
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2.6.3 Using registers  

In addition to forms and lists, you’ll also work with registers in QuickBooks. Just as you use your 

paper cheque book register to see a record of all the transactions in your chequing account—cheques 

you’ve written, other withdrawals you’ve made from your account, and deposits—a QuickBooks 

register contains a record of all the activity in one account. Almost every QuickBooks account has its 

own register.  

You may want to explain to students that Accounts Receivable is the record of money owed to a 

business, that is, the outstanding invoices for which a business has not received payment.  

Here’s an example of the register for an accounts receivable account.  

 

The register shows information about invoices written to customers—the date of the invoice, the date 

it’s due, the name of the customer, and the amount. It also shows payments you’ve received against 

your invoices. The right column of the register gives you a running balance of all your Accounts 

Receivable, so you always know how much you’re owed.  

2.7 Getting around in QuickBooks  
QuickBooks maximizes your work space and gives you quick access to the features and reports that 

you use most. In this section you’ll learn how to do the following:  

 Find information to help you get started using QuickBooks  

 Manage your open windows  

 Compare windows side by side  

 Customize navigation features  

 Use Customer, Vendor, and Employee Centres  

2.7.1 Finding information to help you get started  

If you’re new to QuickBooks, the QuickBooks Learning Centre window displays when you open a 

company file. This window guides you through the steps you need to complete after you’ve set up your 

company file. To display the QuickBooks Learning Centre window, choose QuickBooks Learning 
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Centre from the Help menu.  

If you’re upgrading from a previous version, QuickBooks displays the What’s New window. This 

window contains information about new features and explains how to find what you need to start 

working with the latest version.  

2.7.2 Managing your open windows  

To give you more room to work on the task at hand, QuickBooks displays one window at a time. When 

you open a window, it appears in front of other windows that you previously opened.  

The Open Window list keeps track of the windows that are open. Use the Open Window list to switch 

between windows while you work. To switch to another open window, just click the title of the 

window that you want to display.  

 

2.7.2.1 To show or hide the Open Window list:  

 From the View menu, choose Open Window List.  

If the list is currently displayed, a checkmark appears to the left of the menu item.  

For comparison purposes, you may wish to display more than one window at a time. You can easily 

switch between viewing one window at a time and viewing multiple windows. When you choose 

Multiple Windows from the View menu, QuickBooks tiles the windows in the main area. You can then 

move and resize the windows as needed.  

2.7.2.2 To view multiple windows:  

 From the View menu, choose Multiple Windows.  

2.7.3 Using the menu bar  

You can find all of the QuickBooks commands on the menu bar.  

 

Many commands available on the menu bar can be added to the icon bar.  

2.7.4 Using the icon bar  

 

Another feature that makes it easy to get around in QuickBooks is the icon bar. 

In addition to deciding which features to add to the icon bar, you can add or remove icons, change the 
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order in which the icons display, insert spaces between icons, and edit icons by changing the icon text, 

graphic, or tooltip. You can add colour to the icon bar in the General section of the QuickBooks 

preferences.  

For instructions on how to customize the icon bar, search the onscreen Help for icon bar, and then 

choose “Customize the Icon Bar” from the list of topics that displays.  

Note:  The icon bar also gives you easy access to QuickBooks Centres. 

 

QuickBooks Centres — one each for Customers, Vendors, Employees, and Reports give you quick 

access to common tasks. Each Centre gathers in a single place all of the relevant transactions as well as 

other information, such as names and addresses of customers, vendors, or employees.  

 The Customer Centre gives you access to all of your customers and jobs, contact and billing 

information for each customer, and customer transactions. Here you can quickly find and print 

customer contact information, what your customers bought in the past, what invoices they've 

paid, the balance they owe, notes you want to keep about a customer, and more. You can also 

quickly access transactions for all your customers in one place, such as sales receipts, received 

payments, and statement charges.  

 

 The Vendor Centre gives you quick access to all of your vendors, their contact and billing 

information, and vendor transactions. The Vendor Centre displays information about all of your 

vendors and their transactions in a single place. Here you can add a new vendor, add a 

transaction to an existing vendor, or print the vendor list or transaction list. You can also edit a 

vendor's information or edit a note for the vendor.  
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 The Employee Centre gathers information for each of your employees, including contact 

information, social insurance number, and payroll transactions. Here you can add a new 

employee, add a transaction to an existing employee, or print employee and transaction 

information. You can also edit an employee's information or edit a note for the employee. If you 

have a QuickBooks Payroll subscription, you can perform payroll-related tasks, such as pay 

your employees and payroll tax liabilities. The Employee Centre also contains a separate Payroll 

Centre where you can manage your payroll and tax information.  

 

The Customer, Vendor, and Employee Centres have two tabs (the Employee Centre also contains the 

Payroll Centre in a separate tab if your company has payroll turned on).  

The first tab contains the list of your Customers, Vendors, or Employees. Use this tab to view and edit 

information for a single customer, vendor, or employee.  

The Transactions tab lists the relevant transaction types for that Centre. Use this tab to view 

transactions across all Customers, Vendors, or Employees.  
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You can customize how your information is displayed in the Customer, Vendor, or Employee Centre. 

For example, you might choose to view only open invoices for this fiscal year, or you may want to 

view only the Open Balance column for all of your customers.  

You can also run some common reports from within each Centre. (Lesson 9 describes the Report 

Centre.)  

2.7.5 Making the Home page your starting point  

The QuickBooks Home page provides a big picture of how your essential business tasks fit together. 

Tasks are organized into logical groups (Customers, Vendors, Employees, Company, and Banking) 

with workflow arrows to help you learn how tasks relate to each other and to help you decide what to 

do next.  

The workflow arrows indicate a logical progression of business tasks in QuickBooks. However, these 

arrows do not restrict you from doing tasks in a different order, or an order that works better for your 

business needs.  

As you use QuickBooks, you can always return to the Home page by clicking Home.  

The Home page looks like the following. (The icons that appear on the Home page vary depending on 

how your company was set up during the setup process or which preferences are set in the file.)  

 

2.7.5.1 Using the workflow diagram  

To start a task, click the icon for the task you want to do. For example, to create an invoice, click the 

Create Invoices icon. Each icon includes a ToolTip so you can learn about the QuickBooks task 

associated with that icon. To open a ToolTip, place your mouse pointer over the icon.  

Clicking most of the icons on the Home page takes you directly to the window for that task. Some 

icons also include a drop-down arrow. Clicking an arrow opens a menu with choices for different 

business tasks. Click the task you want to do.  

2.7.5.2 Making the Home page work for you  

In addition to the workflow diagram, the Home page provides other company information and access 
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to other tasks in the right-hand pane. From the right-hand pane, you can:  

 Review the current balances of your bank, credit card, payables and receivables accounts.  

To open the register for an account, double-click anywhere in the row of the account you want to 

view. To hide the list of accounts and balances, click the  button in the top-right corner of 

the Account Balances list.  

Account Balances are shown or hidden automatically based on individual user permissions. 

 Click a link in the “Do More With QuickBooks” section to learn about add-on services. If you 

choose to sign-up for these services, appropriate icons may be added to the workflow on your 

Home page.  

 View reminders and important messages. 

The Reminders & Alerts list provides information about tasks awaiting your action. To hide the 

list, click the  button in the top-right corner of the list.  

2.8 All the accounting you need to know  
QuickBooks doesn’t require users to learn or understand accounting jargon. However, it does use some 

common business terms.  

2.8.1 Your chart of accounts  

When you keep books for a company, you want to track where your income comes from, where you 

put it, what your expenses are for, and what you use to pay them. You track this flow of money 

through a list of accounts called the chart of accounts.  

There are two types of accounts:  

 Balance sheet accounts, such as assets—bank, inventory, equipment—and liabilities—payables, 

loans, etc. 

 Accounts used to group transactions for reporting purposes, such as income and expense 

accounts.  

The chart of accounts is a complete list of your business’ accounts and their balances.  

2.8.1.1 To display the chart of accounts:  

1. From the Lists menu, choose Chart of Accounts.  

 QuickBooks displays the chart of accounts for White Ridge Construction Company. 
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2. Scroll through the White Ridge Construction chart of accounts.  

 Notice that the list displays balance sheet accounts first, followed by income accounts and expense 

accounts. 

3. Close the chart of accounts. 

2.8.2 About assets, liabilities, and equity  

2.8.2.1 Assets  

Assets include both what you have and what other people owe you. The money people owe you is 

called your accounts receivable, or A/R for short. QuickBooks uses an accounts receivable account to 

track the money owed you.  

The rest of your company’s assets may include chequing accounts, savings accounts, petty cash, fixed 

assets (such as equipment or trucks), inventory, and undeposited funds (money you’ve received from 

customers but haven’t yet deposited in the bank).  

When setting up your company file in QuickBooks, note that even though chequing, savings, and petty 

cash are all company assets, you’ll set them up as “bank” type accounts in QuickBooks.  

2.8.2.2 Liabilities  

Liabilities are what your company owes to other people. The money you owe for unpaid bills is your 

accounts payable, or A/P for short. QuickBooks uses an accounts payable account to track the money 

you owe different people for bills.  

A liability can be a formal loan, an unpaid bill, or sales and payroll taxes you owe to the government.  

When setting up your company file in QuickBooks, note that even though unpaid bills are liabilities, 

you’ll set them up as accounts payable type accounts in QuickBooks.  

2.8.2.3 Equity  

Equity is the difference between what you have (your assets) and what you owe (your liabilities):  

Equity = Assets – Liabilities  

If you sold all your assets today, and you paid off your liabilities using the money received from the 

sale of your assets, the leftover money would be your equity.  

Your equity reflects the health of your business, since it is the amount of money left after you satisfy 
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all your debts. Equity comes from three sources:  

 Money invested in the company by its owners  

 Net profit from operating the business during the current accounting period  

 Retained earnings, or net profits from earlier periods that haven’t been distributed to the owners  

Of course, you as the owner can also take money out of the business. Such withdrawals, called owner’s 

draws, reduce the business equity.  

If you have a sole proprietorship (where the existence of the business depends solely on your efforts), 

you can check the value of your owner’s equity by creating a QuickBooks balance sheet.  

2.8.3 Cash versus accrual bookkeeping  

When you begin your business, you should decide which bookkeeping method to use. The 

bookkeeping method determines how you report income and expenses on your tax forms. Check with 

your tax advisor or the Canada Revenue Agency (CRA) before choosing a bookkeeping method for tax 

purposes.  

2.8.3.1 Cash basis  

Many small businesses record income when they receive the money and expenses when they pay the 

bills. This method is known as bookkeeping on a cash basis. If you’ve been recording deposits of your 

customers’ payments but haven’t been including the money customers owe you as part of your income, 

you’ve been using cash basis. Similarly, if you’ve been tracking expenses at the time you pay them, 

rather than at the time you first receive the bills, you’ve been using cash basis.  

2.8.3.2 Accrual basis  

In accrual-basis bookkeeping, you record income at the time of the sale, not at the time you receive the 

payment. Similarly, you enter expenses when you receive the bill, not when you pay it.  

Most accountants feel that the accrual method gives you a truer picture of your business finances, and 

under Canadian Income Tax law, only fishers and farmers can use cash basis accounting.  

2.8.3.3 How your bookkeeping method affects QuickBooks  

Whether you use the cash or accrual method, you enter transactions the same way in QuickBooks.  

QuickBooks is set up to do your reports on an accrual basis. For example, it shows income on a profit 

and loss statement for invoices as soon as you record them, even if you haven’t yet received payment. 

It shows expenses as soon as you record bills, even if they’re unpaid.  

You can see any report (except transaction reports) on a cash basis by changing the reporting 

preference. (From the Edit menu, choose Preferences. In the Preferences window, click Reports & 

Graphs in the left panel, and then click the Company Preferences tab.)  

Important:  When you create reports in QuickBooks, you can switch between cash and 

accrual reports at any time, regardless of which bookkeeping method you have 

chosen for tax purposes. 
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2.8.4 Measuring business profitability  

Two of the most important reports for measuring the profitability of your business are the balance 

sheet and the profit and loss statement (also called an income statement). These are the reports most 

often requested by accountants and financial officers. (For example, banks request both documents 

when you apply for a loan.)  

Note: Any report will reflect the real time calendar date. To see reports from the data file it may be 

necessary to choose a date range that suits your QuickBooks data in the date field. 

2.8.4.1 The balance sheet  

A balance sheet is a financial snapshot of your company on one date. It shows: 

 What you have (assets) 

 What people owe you (accounts receivable) 

 What your business owes to other people (liabilities and accounts payable) 

 The net worth of your business (equity) 

2.8.4.1.1 To see an example of a balance sheet: 

1. From the Reports menu, choose Company & Financial. 

2. From the submenu, choose Balance Sheet Standard.  

3. If necessary, set the date to “Next Fiscal Year.” 

4. Scroll the report window to see all parts of the report. 

2.8.4.1.2 The profit and loss statement  

A profit and loss statement, also called an income statement, shows your income, expenses, and net 

profit or loss (equal to income minus expenses). The QuickBooks profit and loss statement summarizes 

the revenue and expenses of your business by category (first income, then expenses).  

2.8.4.1.3 To see a profit and loss report: 

1. From the Reports menu, click Company & Financial. 

2. Choose Profit & Loss Standard. 

3. Choose the appropriate date from the Dates drop down arrow. 

4. Scroll the report window to see all parts of the report. 

2.8.4.2 The statement of cash flows  

Another report that your accountant may be interested in is the statement of cash flows report. A 

statement of cash flows shows your receipts and payments during a specific accounting period. 

2.8.4.2.1 To see a sample statement of cash flows report: 

1. From the Report Centre open, choose Company & Financial, and  

2. Click Statement of Cash Flows (set the date to “Next Fiscal Year”). 
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3. Close all the reports and close the Report Centre. Say No to the messages that appear. 

2.8.5 Looking at the journal entries for transactions  

In traditional accounting, transactions are entered into a general journal in which the total amount in 

the Debit column equals the total amount in the Credit column, and each amount is assigned to an 

account on the chart of accounts. This accounting method is known as double-entry accounting. For 

day-to-day transaction entries, QuickBooks uses familiar forms (invoices, bills, cheques).  

QuickBooks also has a General Journal Entry window that you can use for special transactions (such as 

selling a depreciated asset) or for all transactions if you prefer the traditional system (not 

recommended).  

To see the general journal entry for a saved transaction:  

1. In any sales form, press Ctrl-Y (or press the Journal Button).  The Journal button only displays in 

the Accountant Edition. 

 

2. If you are not using Accountant Edition, click Modify Report and in the Columns field, select 

Debit and Credit. Then click OK. 

Note:  In Accountant Edition, the Debit and Credit columns are 

selected automatically. 

3. In the transaction journal that appears, check the Debit and Credit columns to see the accounting.  

 

In the Customer and Vendor Centres, you can also view a journal entry for a transaction. Locate the 

customer or vendor transaction. Right-click the transaction and choose View Transaction Journal. 

Note:  When using Accountant Edition, you can click the Reports tab and then 

click Transaction Journal button on a sales form to display the 
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transaction journal. The Debit and Credit columns appear 

automatically. 

2.9 Exiting QuickBooks  
Unlike most other Windows programs, QuickBooks doesn’t require you to save your data before 

exiting. It does an automatic save while you’re working with QuickBooks and every time you leave the 

program.  

2.9.1 To exit QuickBooks:  

 From the File menu, choose Exit.  

If no other applications are open, QuickBooks returns you to the Windows desktop.  

To prevent or minimize data loss, you should make regular backup copies of your QuickBooks company data. In the 

event of a data loss you can restore your data from the backup copy. To make a backup copy, from the File menu, 

choose Create Backup… and follow the instructions.  

2.10 Moving between company files  
If you work with several companies, you’ll be working with multiple QuickBooks company files. You 

can change from one company file to another at any time, but in QuickBooks Pro and QuickBooks: 

Premier you can have only one company file open at a time. (NOTE: In QuickBooks: Premier 

Accountant Edition and QuickBooks Enterprise Solutions 13.0 you can have two company files open 

at the same time.) 

QuickBooks provides an easy way to find and open a company file that you’ve worked 

with before. 

2.10.1  To open a previously opened file: 

1. From the File menu, choose Open Previous Company. 

2. From the submenu, choose the company file you want to open. 

You can increase the number of company files that QuickBooks will display in the submenu. 

2.10.1.1 To increase the number of company files displayed: 

1. From the File menu, choose Open Previous Company. 

2. Choose “Set number of previous companies.” 

3. Enter the number of company files you want QuickBooks to display (up to 20). 

4. Click OK. 
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3 Lesson 2: Setting up Quickbooks 

3.1 Lesson objectives  

 To discuss some of the decisions you need to make before using QuickBooks, such as your 

QuickBooks start date and the number of QuickBooks companies you should create  

 To create a new QuickBooks company using the Detailed Start (EasyStep Interview)  

 To set QuickBooks preferences in the Detailed Start  

 To record the opening balance for a chequing account  

 To practice using the QuickBooks Help tools  

3.2 Supporting materials  

 PowerPoint file: Lesson 2  

3.3 Instructor preparation  

 Review this lesson, including the examples, to make sure you’re familiar with the material.  

 Ensure that all students have a copy of qblesson.qbb on their computer’s hard disk.  

3.4 Creating a QuickBooks company  

A QuickBooks company contains all the financial records for a single business. Before you can use 

QuickBooks, you need to tell QuickBooks about your business so that it can set up your company file. 

Setting up your company file properly is the most important thing you can do to help yourself manage 

your business efficiently and with confidence.  

Explain to students that if they’ve been using an older version of QuickBooks to keep their company’s 

financial records, they don’t need to create a new company; QuickBooks can convert their data for 

them. However, in this lesson, you’ll be showing them how to create a new QuickBooks company. 

3.4.1 How many companies should you set up?  

If you operate a business enterprise, the CRA expects you to clearly show all sources of income and to 

document any business expenses you claim as deductions. For tax purposes, therefore, it’s usually best 

to set up a separate QuickBooks company for each business enterprise you report on your tax forms.  

3.4.2 About the Detailed Start (EasyStep Interview)  

The Detailed Start or EasyStep Interview walks you through the process of setting up your business on 

QuickBooks. The setup process is easy; the Detailed Start should take you only about 30 minutes to 

complete. When you set up your company file, QuickBooks will ask you for a number of details about 

your company.  
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 Most small business owners do better with QuickBooks setup if they 

break the job into manageable chunks. Here’s a suggested schedule 

for completion: 

1  Choose the QuickBooks start date. 

2  Gather the necessary business information and documents. 

3  Set up the company file using the Detailed Start (EasyStep Interview). 

4  Fine tune the chart of accounts. 

5  Enter any historical transactions. 

6  Complete customer and vendor information. 

7  Complete the Item list. 

8  Enter any optional adjustments. 

 

  

3.4.3 Navigating through the Interview  

 Click Next to display the next window in the Interview. 

 Click Prev to display the previous window in the Interview. 

 Click Leave to leave the Interview and return to QuickBooks. The next time you open the 

company file, QuickBooks remembers the information you have already entered and returns you 

to the EasyStep Interview where you left off.  
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Set aside a block of uninterrupted time to work on setting up your QuickBooks file. 

Don’t try to complete the setup while you’re in the middle of a busy workday. If you 

schedule your time before or after work hours, or on the weekend, setup should take a 

few hours. 

Your goal while setting up is to provide as much information as necessary to get going, 

but not to provide all the details at once. For example, you could enter data for only 

your biggest customers and vendors. Later, you can enter customer and vendor data as 

you begin working in QuickBooks. (Or, if you have an especially large customer base, 

you may wish to hire a data entry clerk to complete this task for you.) 
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3.4.4 Starting the Detailed Start (EasyStep Interview)  

3.4.4.1.1 To begin adding a new company: 

1 Start QuickBooks. 

2 Choose New Company from the File menu.  

3 Click Detailed Start 

QuickBooks displays the QuickBooks Setup window. QuickBooks gives you three options. 

Express Start lets you start your QuickBooks company file using basic information. The Detailed 

Start lets you answer questions about your company in an interview format. (The Create a New 

Company files based on existing one will be discussed in a later chapter). 

 

3.5 Entering company info  
When you use the EasyStep Interview to create a new QuickBooks company, QuickBooks asks you 

questions about the type of business you own. It uses your answers to get you started quickly, by 

setting up the appropriate accounts and lists.  

In this lesson, you’ll create a new QuickBooks company for a business named Lockhart Design. 

Margaret Lockhart is the sole proprietor of this interior design firm. Most of her income comes from 

consulting services, but she also sells products such as fabrics and room accessories to clients.  

3.5.1 To create a new QuickBooks company file:  

1. At the first Welcome window for the EasyStep Interview, the “Enter your company 

information” window appears.  

2. In the Company name field, type Lockhart Design and press Tab. When you press Tab, 

QuickBooks automatically enters the same name you typed into the Legal Name field. 

QuickBooks uses the company name on all reports.  
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3. Press Tab and type the following information in the street address, city, province, and postal 

code fields. 

 1239 Bayshore Road 

Kelowna, BC V6E 1E1 

QuickBooks prints this company address on cheques, invoices, and other forms.  

4. Now enter the following information in the Phone number and Fax number fields:  

 Phone: 250-555-1234  

 Fax: 250-555-5678  

5. Next enter the email and Web address for Lockhart Design. 

E-mail: margaret@shaw.ca  

Web site: www.lockhartdesigns.ca 

Your screen should resemble the following. 

 

6. Click Next. 
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3.5.2 Choosing your company industry  

When you create a new QuickBooks company, you can select a company type that most closely 

matches your type of business, and QuickBooks sets up accounts and lists that are appropriate for your 

type of company.  

Your industry selection is used by the interview to ask questions and recommend features that work 

best for your business.  

QuickBooks will recommend features that can best meet your business needs, such as:  

 Enabling sales tax for retail businesses  

 Using estimates in QuickBooks for some service-based businesses  

 Managing inventory in QuickBooks for wholesalers and manufacturers  

 Creating income and expense categories  

Even if you own a type of company that isn’t specifically listed, you should select the one that’s 

closest. Margaret Lockhart does consulting, as well as retail sales, so we’ll select a Retail company 

type. 

3.5.2.1 To choose the company industry:  

1. On the “Select your industry” window, scroll down the list until you find Retail Shop or Online 

Commerce and select it.  

 

Although Lockhart Design receives most of its income from consulting, not from retail sales, the 

Retail company type will give us most of the accounts we need. She’ll need to modify the chart of 

accounts later to include an income account for Consulting Income.  
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2. Click Next. 

The “How is your company organized?” window appears. 

3.5.3 Selecting how your company is organized  

Selecting how your company is organized tells QuickBooks which tax forms to use for your business. 

You also indicate the start of your fiscal year.  

Lockhart Design is a sole proprietorship: an unincorporated business with one owner.  

3.5.3.1 To select your company organization: 

1. Click Sole Proprietorship to select it. 

 

This tells QuickBooks to use the T1 tax form. When you create a new account, you can associate a 

tax line on which you would report the income or expenses tracked by the account. 

An account's tax line associates each income and expense account with the appropriate tax form 

and line on your company income tax return. You'll see tax lines for the tax form you choose and 

for schedules and other forms typically filed with that tax form. This makes preparing income 

taxes easier and quicker, because it enables you to create tax reports to assist your accountant or to 

export and import your tax data into Turbo Tax, Turbo Tax for Incorporated Business, or Profile. 



37 |  P a g e
 

2. Click Next. 

 QuickBooks needs to know the starting month of your fiscal year. 

 

3. Since Lockhart Design’s fiscal year started in January,  leave January selected  

and click Next. 

The “Set up your administrator password” window appears. For this exercise, you don’t need to 

set up a password. 

 

4. Click Next. 

The “Create your company file” window appears. 
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5. Click Next to save the company file.  

6. In the “Filename for New Company” window, make sure that QuickBooks is set to save the file in 

the QBtrain folder you set up in the introduction to this guide.  

7. Click Save to accept the default filename of “Lockhart Design.” QuickBooks creates the company 

file.  

3.6 Customizing QuickBooks for your business  
The customization section of the EasyStep Interview is where you indicate:  

 What you sell  

 How and when your customers pay you  

 How you pay your bills  

Based on your answers, QuickBooks sets preferences for the company file. The preferences enable 

certain features of the QuickBooks program.  
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3.6.1 Indicating what you sell  

You need to indicate what your business sells. In general, businesses either sell products or services, or 

both. Margaret Lockhart provides consulting services as well as selling products, such as fabrics.  

3.6.1.1 To indicate what you sell: 

1. Click Next to move to the “What do you sell?” window. 

2. Click “Both services and products” to select it. 

 

3. Click Next.  

3.6.2 Entering sales information  

For retail companies, you need to indicate how you want to enter sales. QuickBooks uses this 

information to set recommendations for a retail-type business. Margaret Lockhart does not do retail 

sales on a daily basis, so she will record her sales as they occur. 
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3.6.2.1 To indicate how you enter sales:  

1. In the “How will you enter your sales in QuickBooks?” window, click “Record each sale 

individually.” Your screen should look like this:  

 

2. Click Next.  

3. In the “Do you sell products online?” window, make sure the “I don’t sell online and I am not 

interested in doing so” option is selected. Margaret Lockhart has no plans to sell online. 

4. Click Next 

3.6.3 Entering sales tax information  

This part of the EasyStep Interview asks whether you charge sales tax. You should turn the sales tax 

setting off only if you never charge sales tax. Margaret Lockhart typically charges sales tax, so we’ll 

turn on sales tax in her company file.  

3.6.3.1 To set up QuickBooks to track sales tax:  

1. Click Yes for the question, “Do you charge sales tax?”  

QuickBooks sets up two sales tax items you can use on sales forms to track your sales tax: GST, 

and PST. In your own business company file, you would edit these tax items to enter the current 

tax rates if necessary. QuickBooks will setup the taxes for you according to province where your 

business is located. Additional taxes can be added for other provinces if necessary. 
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2. Enter the business/registration number for both tax items as shown:  

 

3. Click Next. QuickBooks automatically creates two current liability accounts, called GST Payable 

and PST (or QST if your company is located in Quebec) Payable, that keep track of the sales tax 

you collect in your business.  

Note:  If the Invalid Business Number window appears, click 

“Continue anyway”. If you were setting up a real company, 

you would have a valid CRA business number issued, which 

you would use in this screen. 

3.6.4 Creating estimates  

If you provide any type of estimate or bid—even a verbal quote—there are many reasons to use 

estimates in QuickBooks.  

 You can use the QuickBooks estimate form to prepare professional-looking itemized estimates, 

bids, quotes, or proposals for your customers. You can customize a QuickBooks estimate to 

look and say exactly what you want it to.  

 When it's time to bill your customer, you can easily create an invoice from the estimate with just 

one click. QuickBooks then creates an invoice using information from your estimate. You can 

also associate price levels with your customers and use those price levels on estimates.  

 When you need to know how accurate your estimates are, you can create reports that compare 

your estimated costs and revenue against your actual costs and revenue.  
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 Creating estimates in QuickBooks will allow you to easily compare your actual costs against 

what you estimated. This will let you see how accurate your estimates are.  

 You can track which estimates are still active and easily update each estimate as you continue to 

negotiate with your customers.  

For this exercise, Margaret Lockhart creates proposals for her customers for their interior design 

projects, so she needs to enable estimates for her company. 

3.6.4.1 To create estimates for your business: 

1. On the “Do you want to create estimates in QuickBooks?” window, click Yes. 

 

2. Click Next.  

3.6.5 Using Sales Orders (Customer Orders) 

If your customers sometimes place orders for items that you don’t have in stock or are not yet ready 

to invoice for, use a sales order in QuickBooks to track the sale. 

Note:  On the next window, if you are using a QuickBooks: Premier Edition product, 

QuickBooks asks if you want to track sales orders. Click Yes, and then click 

Next. QuickBooks Sales Orders are not available in QuickBooks Pro. 
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3.6.6 Choosing remaining preferences  

The next series of windows ask “yes or no” questions that enable or disable different QuickBooks 

features, based on your company needs. Simply click Yes or No, then click Next to move forward in 

the Interview. For Lockhart Design, complete the preferences by giving the following responses:  

For this item...  Select...  

Billing statements  No  

Progress invoicing  Yes  

Managing Bills  Yes  

Do you print cheques?  I print cheques  

Inventory  No  

Do you Accept Credit Cards? No 

Track time  Yes  

Employees  No  

Track Multiple currencies No 

Answering the series of questions about your business helps customize QuickBooks to meet your 

specific business needs. Next, you’ll set up your accounts.  

Note:  You can always change preference settings later, after the 

EasyStep Interview. From the Edit menu, choose Preferences, and 

then select the preference type in the left panel. 

3.7 Setting up your business accounting 

Next, QuickBooks helps you set up the basic accounting you’ll use to track your business, referred to 

as your chart of accounts. To set up the chart of accounts, you need to:  

 Determine the start date of your business  

 Decide how you want to categorize your income and expenses  

 Enter account balances  

The chart of accounts is the framework used to categorize the information and transactions used to 

create reports. By using a chart of accounts and creating reports, you’ll always know the current state 

of your business.  

The chart of accounts is made up of five types of accounts common to all businesses and you 

categorize transactions into one of these five account types.  
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3.7.1 Choosing a start date  

Before you start entering your company’s financial data, you need to choose a QuickBooks start date. 

This is the starting point you want to use for all your QuickBooks accounts. The start date is the date 

for which you give QuickBooks a financial snapshot of your company assets and liabilities.  

Once you decide on a start date, you enter all your company’s transactions since that date. That’s why 

you should choose a start date that’s not too far back in the past for you to handle. Many business 

owners like to use the last day of a financial period as their start date, such as the end of last fiscal year, 

last quarter, or last month. You need to enter all historical transactions from the day after your start 

date up through today. For example, if you decide on a start date of March 31, you’d enter your 

historical transactions from April 1 up through today.  

Q
u
ic

k
S
ta

rt
 T

ip
 When choosing the start date you want to use for your own QuickBooks 

company file, consider this question: Is having a lot of historical data 

important to you? If it is, you’ll want to choose a start date as close to the 

beginning of your fiscal year as possible. 

If historical data is not very important to you, you can make setup easier by 

choosing a start date as close to today as possible. (You only have to enter 

historical data between your start date and today.)  

  

3.7.1.1 To choose a start date: 

1. On the “Using accounts in QuickBooks” window, click Next. 

 The “Select a date to start tracking your finances” window appears. 

 

2. Select “Use today’s date or the first day of the quarter or month”, and then enter 01/01/2014. 

3. Click Next. 
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3.7.2 Reviewing the chart of accounts  

As you learned in Lesson 1 of this guide, the chart of accounts lists balance sheet accounts, income 

accounts, and expense accounts. When you create a new QuickBooks company, you select a company 

type that most closely matches your type of business, and QuickBooks sets up a chart of accounts for 

you.  

The chart of accounts is the framework used to categorize the information and transactions used to 

create reports. By using a chart of accounts and creating reports, you’ll always know the current state 

of your business.  

The chart of accounts is made up of five types of accounts common to all businesses— the income and 

expense accounts used by the Profit and Loss Statement, and the asset, liability, and equity accounts 

used by the Balance Sheet. Each time you enter a transaction, QuickBooks will prompt you to 

categorize it into one of these five types of accounts.  

Because you chose an industry from the list earlier in the Interview, QuickBooks has already created 

income and expense accounts for your company. Next, you’ll view the preset income and expense 

accounts.  

3.7.2.1 To review the chart of accounts:  

1. In the “Review income and expense accounts” window, scroll through the preset accounts to get 

an idea of what is included. Note that from the list of accounts in this window you can remove or 

add accounts. If you see accounts you do not need, you can clear the checkmark for the account 

and QuickBooks removes it from the chart of accounts. To add an account, click in the checkmark 

column.  

 

2. Click Next to go to the next window.  
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3. Click Go to Setup to complete the EasyStep Interview.  

QuickBooks launches QuickBooks Setup window. From this window you can add the people you 

do business with like customers and Vendors. You can also add the products and services you sell. 

QuickBooks also lets you add your bank accounts from this window.  

3.7.3 Entering bank accounts and opening balances  

The Add your bank accounts section of the QuickBooks Setup is where you enter any bank accounts 

you want to track and enter opening balances.  

The balance sheet accounts in the QuickBooks chart of accounts start with an opening balance of zero. 

Before you begin working in QuickBooks, you need to enter an opening balance for each balance sheet 

account as of your start date.  

The opening balance is important because QuickBooks can’t give you an accurate balance sheet (what 

your company owns and what it owes) without it. An accurate balance sheet gives you a true picture of 

your company’s finances. Also, if you start with an accurate balance as of a specific date, you can 

reconcile your QuickBooks bank accounts with your bank statements, and your QuickBooks chequing 

accounts will show the actual amount of money you have in the bank.  

The easiest way to determine an account’s opening balance is to work from an accurate balance sheet. 

If you have a balance sheet as of your start date, you can take the opening balance from there. During 

the QuickBooks Setup, you can enter opening balances for bank accounts only. You’ll learn later how 

to enter opening balances for accounts after you’ve completed the QuickBooks Setup.  

Let’s assume Margaret Lockhart wants to enter an opening balance for her chequing account. The 

opening balance for a QuickBooks bank account is the dollar amount in the bank on the start date. This 

amount can be determined two ways: using the ending balance on the last bank statement on or 

immediately prior to the start date, or using the bank account balance from a balance sheet prepared by 

an accountant. Margaret has a recent bank statement for this account, so we’ll use that method.  
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3.7.3.1 To add the chequing account and enter the opening balance:  

1. From the Add your bank accounts section, click Add.  

2. Enter the name for the first bank account in Account Name. Type Chequing as the name of 

the account. Just leave the Bank account number blank. 

3. Enter the amount of $8359.00. 

4. Enter the Date 12/31/13. 

 Your screen should look like this:  

 

5. Click Continue. 

6. If you print cheques from QuickBooks you can order cheques or add a reminder to order 

cheques at a later date. Click No Thanks, then click Continue.  

3.8 Completing company file setup  

After you have created your company file using the EasyStep Interview, you can begin using 

QuickBooks to run your business. However, there are some additional tasks you might need do to 

make sure the company file is properly set up and that the data is complete.  

QuickBooks is based on four key concepts: Customers, Vendors, Accounts, and Items. If you take two 

minutes now to understand these basic concepts, you'll be able to get started quickly and correctly with 

your company information.  

 Customer: A customer is anyone who pays you. This can mean patients, donors, members, 

legal or consulting clients, or your typical retail customer.  

 Vendor: A vendor is anyone you pay, except for employees. This can mean subcontractors, 

utility companies, your landlord, tax agencies, or suppliers.  

 Account: There are two types of accounts—real world accounts, such as chequing accounts, 



48 |  P a g e
 

and income and expense accounts that you use to group transactions for reporting purposes. For 

example you may want to create expense accounts to track office supply purchases separately 

from advertising costs. All accounts are listed on your chart of accounts. If you choose a tax 

form, you can associate accounts with tax lines, which would make preparing for tax time 

easier.  

 Item: An item is anything you want to put on an invoice. This includes products, services, 

labour, discounts, taxes and others.  

This section covers how to set up customers, vendors, and items, and how to add an income account.  

3.8.1 Adding customers  

In order to invoice customers with QuickBooks, you need to add your customers.  

By entering details about the people and companies you do business with, you can personalize 

invoices, send invoices easily and quickly and view the status of their accounts. You can add new 

customers at any time.  

Note:  QuickBooks lets you add multiple customers at one time. 

You can import from MS Outlook, Yahoo, Gmail or copy 

and paste from Excel.  

3.8.1.1 To add customers from Excel during the QuickBooks Setup:  

1. In the section labelled “Add the people you do business with”, click Add.  

2. Select Paste from Excel or enter manually, then click Continue.  
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3. Select the type of name you would like to add to QuickBooks.  

4. You can enter the names manually completing each of the appropriate fields for the name 

including name, company name, email, phone and other fields. 

5. Type the name Smith, Lee in the Name field, then click tab to move to the next field.  

6. In the First Name field type Lee. 

7. Press tab and in the Last Name field, type Smith. 

8. Press Tab to go to the Email field, and then enter Lee_Smith@gmail.com 

9. In the Address field type 43 Hampshire Blvd,. and press tab.  

10. In the City, Province, Postal Code field type, New Westminster, BC V3R 6Y9 

Your screen should resemble the following graphic. 

 

11. Click Continue to add this customer. The Customer Centre appears, with the Customers & 

Jobs list along the left side.  

12. QuickBooks confirms the number of names to be added to your company file.  

13. Click Continue. 
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3.8.2 Adding vendors  

In order to pay your bills with QuickBooks, you need to add your vendors. Nearly everyone you pay, 

other than employees, is a vendor. 

You can add new vendors at any time. QuickBooks uses the Vendors list to hold information about the 

people and companies you do business with; for example, this list could include the phone company, 

your office supplies vendor, and your tax agency. 

3.8.2.1 To add a vendor: 

1. In the “Add the people you do business with” section, click Add More. 

2. Select Paste from Excel or enter manually, then click Continue. 

3. Select Vendor, then type Fay, Maureen Lynn, CGA, in the Name field.  Press Tab to move to 

the next field.  

4. In the First Name field type Maureen. 

5. In the Last Name field, type Fay. 

6. In the Address field, type, 200 Royal Rd. 

7. In the City, Province, Postal Code field, type Fort Langley, BC V6R 9G2 

8. Click Continue. 

9. Click Continue to confirm the new vendor. 

 

  

3.8.3 Adding items (Products and Services you sell) 

In QuickBooks, an item is anything that your company buys, sells, or resells in the course of business, 
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such as products, services, shipping and handling charges, discounts, and sales tax (if applicable). You 

can think of an item as something that shows up as a line on an invoice or other sales or purchase form.  

Items help you fill out the line item area of a sales or purchase form quickly. When you choose an item 

from your Item list, QuickBooks fills in a description of the line item and calculates its amount for you.  

While they provide a quick means of data entry, a much more important role for items is to handle the 

behind-the-scenes accounting. When you create an item, you link it to an account; when the item is 

used on a form, it posts an entry to that account and another entry to the appropriate accounts 

receivable, accounts payable, chequing, fixed asset, or other account.  

When creating items, consider how much detail you want on your invoices or statements and set up 

items with that level of detail in mind. For example, if you are a seamstress who creates and sells home 

accessories, you can set up a single item and charge a flat rate for a certain size of couch pillow, or you 

can break that pillow down further into labour and materials.  

QuickBooks provides several different types of items. Some—such as the service item or the inventory 

part item—help you record the services and products your business sells. Others—such as the subtotal 

item or discount item—are used to perform calculations on the amounts in a sale.  

For Lockhart Design, you’ll set up a service item for billing the time used for initial consultation for a 

design project.  

3.8.3.1 To add an item:  

1. In the QuickBooks Setup window, in the “Add the products and services you sell” section, 

click Add.  

2. Select the type of item you would like to add. This will vary depending on your selection in 

the Easy Step Interview. Lockhart Design does not maintain inventory so you cannot add 

inventory in this part of the setup. 

3. Select Service, then click Continue. 

4. Name field, type Initial Design Consultation. 

5. In the Description field, type Initial design consulting. 

6. Click in the Price field, type 40. You can add more details about items on the item list in 

QuickBooks.  

7. Click Continue. Review the items that are ready to be added and then click Continue. 
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8. After you have added customers, vendors, items and bank accounts, click Start Working to 

continue in QuickBooks.  

3.8.4 Setting up additional accounts  

During the EasyStep Interview, you added one chequing account for Lockhart Design. There are two 

basic types of accounts: balance sheet accounts, such as savings or chequing, and accounts used to 

group transactions for reporting purposes, such as income and expense accounts. Income and expense 

accounts track the sources of your income and the purpose of each expense. When you record 

transactions, you usually assign the amount of the transaction to one or more income or expense 

accounts.  

In the EasyStep Interview, you also selected “Retail Shop or Online Commerce” as the industry for 

Lockhart Design. QuickBooks created a chart of accounts based on the retail industry. However, 

Margaret Lockhart also receives income from design consulting. She needs to modify the chart of 

accounts to add an income account for consulting.  

3.8.5 Adding a new account  

You may need to add one or more of the following accounts:  

 Income accounts to track new sources of income  

 Expense accounts to track new types of expenses  

 Bank accounts when you open new chequing, savings, or money market accounts at your bank  

 Credit card accounts when you acquire new credit cards  

 Other kinds of balance sheet accounts to track specific assets, liabilities, or equity  

For example, you may need to add a fixed asset account to track the depreciation of a new 

equipment purchase, a long term liability account to track a business loan, or an equity account to 

track the investment from a new business partner.  
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A complete list of your business’ accounts and their balances appear in the chart of accounts. You use 

a chart of accounts to track how much money your company has, how much money it owes, how much 

money is coming in, and how much is going out. 

For Lockhart Design, you’ll add an income account for her consulting income. 

3.8.5.1 To add an income account: 

1. From the Lists menu, choose Chart of Accounts. 

2. Click the Account menu button and choose New. 

3. In the Add New Account window, choose Income, and then click Continue. 

4. Click in the Account Name field, and type Consulting. 

5. From the Tax-Line Mapping drop-down list, choose “T1 General – Other Income 

Your screen should resemble the following graphic. 

 

6. Click Save & Close, and then close the Chart of Accounts.  

3.8.6 Entering historical transactions  

If your QuickBooks start date is before today’s date, you also need to enter past transactions so that 

you have complete financial records from the start date forward. It is important to enter historical 

transactions in this order:  

1. All sales (sales receipts, invoices, or statement charges) 

2. Customer payments received for outstanding invoices after the start date 
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3. Bills received since the start date 

4. Bills paid since the start date 

5. Deposits made to any of the accounts since the start date 

6. Any other cheques written (other than bills) since the start date 

3.8.7 Learning more about the company setup process  

When you are setting up your own company in QuickBooks, you may want to view the tutorials 

available in the Learning Centre to help you finish setting up your own company file. The information 

provided in the videos gives you an overview of the program and more detailed information about 

using specific parts of the product.  

3.8.7.1 To open the Learning Centre:  

 From the Help menu, choose Learning Centre.  

For more information, choose Support from the Help menu.  

3.9 Getting help while using QuickBooks  

QuickBooks provides extensive help in various formats. When you have questions, QuickBooks 

provides:  

 Onscreen Help to provide conceptual information and step-by-step instructions. 

 Live community. Instant access to frequently asked questions and experts who can answer your 

own questions. 

 Tutorials on key tasks. These are available by choosing Learning Centre Tutorials from the Help 

menu. 

3.9.1 Using onscreen Help: 

The onscreen Help provides several different types of information: 

 Conceptual explanations of how to apply QuickBooks to your particular business situation. 

 Step-by-step instructions. 

 A search engine that provides you with a list of topics related to the word or  

phrase you enter. 

 Information relevant to the task you are currently performing. 

3.9.1.1 To view onscreen Help: 

When you launch QuickBooks Help, it displays information about the task you are currently 

performing along with a list of topics relevant to what you are doing. There are several ways to 

access QuickBooks Help: 

 Press the F1 key on your keyboard. 
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 Click the Help icon in the icon bar of the screen. 

 From the Help menu, choose QuickBooks Help. 

3.9.2 Finding a topic in the onscreen Help Index  

Suppose you want to find out how to change the information about a customer. You can type what 

you’re looking for in the Help Search field, and QuickBooks displays a list of topics.  

3.9.2.1 To find a topic in onscreen Help: 

1. From the Help menu, choose QuickBooks Help. 

The Relevant Topics tab displays a list of topics related to the QuickBooks screen you are using. 

2. Click the Search tab. 

3. Type “customers, and click the arrow button. 

 QuickBooks displays a list of topics related to customers. 

4. Click “Edit or change customer information.” 

 

QuickBooks displays the topic in the lower portion of the help window. 

5. Close the Help window. 
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3.9.3 Closing the company file  

As you enter information in your company file, QuickBooks saves what you enter. When you are 

finished working on a file, you can close the file.  

3.9.3.1 To close the company file you just created: 

From the File menu, choose Close Company.  
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4 Lesson 3: Working with Lists 

4.1 Lesson objectives  
 To edit the company chart of accounts  

 To add a new customer to the Customers & Jobs list  

 To add a new vendor to the Vendor list  

 To learn about custom fields, and to practice adding custom fields  

 To see how to manage lists in QuickBooks  

4.2 Supporting materials  
 Handout 1: Balance sheet accounts  

 Handout 2: Accounts created automatically  

 PowerPoint file: Lesson 3  

4.3 Instructor preparation  
 Review this lesson, including the examples, to make sure you’re familiar with the material.  

 Ensure that all students have a copy of qblesson.qbb on their computer’s hard disk.  

 Have Handouts 1 and 2 ready for distribution.  

4.4 To start this lesson  
Before you perform the following steps, make sure you have installed the exercise file (qblesson.qbb) 

on your hard disk. See “Installing the exercise file” in the Introduction to this guide if you haven’t 

installed it. 

The following steps restore the exercise file to its original state so that the data in the file matches what 

you see on the screen as you proceed through each lesson. 

4.4.1 To restore the exercise file (qblesson.qbb): 

1. From the File menu in QuickBooks, choose Open or Restore Company. 

2. QuickBooks displays the Open or Restore Company window. 

3. Select Restore a backup copy and click Next.  

4. Select Local backup and click Next.  

5. In the Open Backup Copy window, navigate to your C:\QBtrain directory.  

6. Select the qblesson.qbb file, and then click Open. 

7. In the Open or Restore Company window, click Next. 

8. Navigate to your C:\QBtrain directory. 

9. In the File name field of the Save Company File as window, type lesson 3 and then click 

Save. 

10. Click OK when you see the message that the file has been successfully restored. 
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4.5 Using QuickBooks lists  
QuickBooks lists organize a wide variety of information, including data on customers, vendors, 

inventory items, and more. Lists save you time by helping you enter information consistently and 

correctly. When you store information on a list, you enter it once and never need to retype it. Think 

about how much information you use more than once in your business:  

 Names, addresses, and other information about customers who purchase from you on a regular 

basis  

 Contact information for vendors from whom you purchase your supplies  

 Descriptions and prices for products or services you sell again and again  

Simply enter repetitive information into a list once, and then use it over and over on cheques, on 

invoice forms, and other daily transactions. You don’t have to enter all the information for your 

company lists before you begin working with QuickBooks. You can add information to lists as you go 

along.  

4.6 Editing the chart of accounts  
The chart of accounts is your most important list because it shows how much your business has, how 

much it owes, how much money you have coming in, and how much you’re spending. When you set 

up your own company in QuickBooks, the EasyStep Interview lets you choose a chart of accounts 

designed especially for your type of business. However, not every business has the same needs; you’ll 

want to make a few changes to the list. 

4.6.1 To display the chart of accounts:  

1. From the Lists menu, choose Chart of Accounts.  

QuickBooks displays the chart of accounts for White Ridge Construction.  

 

2. Scroll through the list. The chart of accounts displays balance sheet accounts first, followed by 

income and expense accounts.  
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 Before you modify the preset chart of accounts, we recommend that 

you have your accountant or QuickBooks Professional Advisor 

review the chart of accounts that QuickBooks has set up for you. 

You may need to add income and expense accounts, add 

subaccounts, delete accounts, or move accounts. It is important to 

decide on an account structure before you begin entering 

transactions.  
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Refer to Handout 1, “Balance sheet accounts” as you explain each account type and the kinds of 

transactions you use each type for.  

4.6.2 Editing an account  

If any of the accounts don’t suit your needs, you can edit or delete them. In the next exercise, you’ll 

edit White Ridge Construction’s Chequing account to provide the account number.  

4.6.2.1 To edit an account:  

1. In the chart of accounts select Chequing. 

2. Click the Account menu button (at the bottom of the window), and then select Edit Account. 

QuickBooks displays the Edit Account window. 

3. In the Description field, type The Provincial Bank. 

4. In the Bank Acct. No. field, type 555-333-2222. 

Your window should look like this.  

 

5. Click Save & Close.  

4.6.3 Adding subaccounts  

The Dues and Subscriptions expense account has one subaccount called Union Dues. White Ridge 

Construction wants to add a second subaccount for trade publications.  

4.6.3.1 To add a subaccount:  

1. In the chart of accounts, click the Account menu button and then choose New.  

QuickBooks displays the Add New Account: Choose Account Type window.  
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2. Select Expense and click Continue.  

3. In the Account Name field, type Trade Pubs.  

4. Select the “Subaccount of” checkbox, and then select Dues and Subscriptions in the drop-

down list.  

5. In the Description field, type Trade Publications. 

6. In the Sales Tax Code field, choose “S” from the drop-down list. 
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7. Click Save & Close. 

 QuickBooks displays the new subaccount in the chart of accounts list. 

 

8. Close the chart of accounts.  

Explain to students that in addition to the accounts that QuickBooks sets up by default based on 

the industry they select during the EasyStep Interview, QuickBooks also creates certain accounts 

as needed based on the features used in the program. For a list of these accounts, refer to Handout 

2, “Accounts created automatically.”  

4.7 Working with the Customers & Jobs list  
The Customer Centre stores names, addresses, and other information about your customers. It also 

holds information about the jobs or projects you may want to track for each customer.  

4.7.1 Adding new customers  

In this exercise, you’ll add a new customer to the Customers & Jobs list.  

4.7.1.1 To add a new customer:  

1. Click Customer Centre in the icon bar.  

QuickBooks displays the Customer Centre, which includes the Customers & Jobs list.  

 

To show details of customer transactions, it may be necessary to select “Next Fiscal Year” in the 

date field. 

The Customer Centre lets you add, edit, and get reports on your customers. Each customer in the 

list can have multiple jobs (you may call them projects or accounts). Notice that this Customers & 

Jobs list already has quite a few entries.  
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2. Click the New Customer & Job menu button (at the top of the Customer Centre), and select 

New Customer.  

QuickBooks displays the New Customer window.  

 

The New Customer window is where you enter all the information about a new customer, 

including invoicing and shipping addresses, contacts, credit limit, and payment terms. QuickBooks 

uses the information you enter to complete invoices, and other transactions. When you’re setting 

up your company file, you use this window to record customers’ opening balances.  

3. In the Company Name field on the Address Info tab, type Godwin Manufacturing, and then 

press Tab. 

 Notice that QuickBooks fills in the Customer Name field and the first line of the Invoice To field 

with the information you typed in the Company Name field. 

QuickBooks displays the name listed in the Customer Name field in the Customers & Jobs list. By 

default, QuickBooks sorts the list alphabetically. 

Q
u
ic

k
S
ta

rt
 T

ip
 If you are entering individual names, you may want to use last 

name, first name in the Customer Name field so that your Customers 

& Jobs list displays the names with the last name first. This is useful 

for alphabetical sorting of lists and reports. 

  

4. Leave the Opening Balance field blank, and in the as of field, type 12/31/2010. 

5. In the Invoice To field, click at the end of the company name line and press Enter.  

6. Type 376 Pine Street, and then press Enter.  

Notice that you press Tab to move between fields, but you press Enter to move from one line to 

the next within a field.  

7. On the next line of the Invoice To field, type Vancouver, BC V6H 0R7.  
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8. Click Copy to have QuickBooks copy the Invoice/Bill To address to the Ship To field.  

Each of your customers can have multiple shipping addresses. You can also set which address to 

use as the default address. The default address for each customer is used on sales forms, letters, 

labels, and in Shipping Manager.  

QuickBooks displays the Add Ship To Address Information window. 

 

9. Click OK to use this address as the Godwin Manufacturing ship to address.  

10. QuickBooks lets you add the type of contact information you use most commonly in your 

business, like phone, fax, email and even contact information including LinkedIn, Twitter and 

other modern forms of contact. Continue filling out the customer information by providing the 

following information:  

First and Last Name: John Godwin  

Main Phone: 604 555-9841  

FAX: 604 555-0012 

 

Note:  If you plan to e-mail invoices or statements to customers 

using the Send Forms feature, use this window to enter your 

customers’ e-mail addresses. 
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4.7.2 Providing additional customer information  

You’ve just completed the Address Info tab for a new customer. The Additional Info tab is where you 

can provide other important information, such as customer type (if you want to categorize your 

customers in some way), payment terms, and sales tax information.  

4.7.2.1 To add additional information to a customer record:  

1. Click the Additional Info tab.  

QuickBooks displays the Additional Info tab of the New Customer window.  

 

2. In the Type field, type Industrial.  

The Type field lets you track customers in any way that is meaningful for your business. For 

example, if you run ads on television, radio, and in print, and you want to know which advertising 

method brings you the most customers, you can assign customers a “type” (TV, Radio, or Print) 

and run reports that tell you which referral source is most effective. White Ridge Construction 

uses the Type field to categorize customers by the type of service provided.  

3. Press Tab.  

QuickBooks tells you that Industrial is not currently on the Customer Type list and asks if you 

wish to add it.  

4. Click the Quick Add button to add the customer type to the list.  

Quick Add lets you set up the item with a minimum amount of data. If you click Set Up, you can 

enter more detailed information, but that interrupts the process of creating a new customer.  
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4.7.3 Providing customer payment information  

The Payment Settings tab is where you enter customer account numbers and credit limits. QuickBooks 

remembers each customer’s credit limit and warns you when a customer is about to exceed it. You can 

also record information about each customer’s preferred payment method. For customers who pay by 

credit card, you can enter credit card numbers and expiration dates. 

4.7.3.1 To add payment and credit information to a customer record: 

1. Click Payment Settings. 

2. In the Payment Terms drop-down list, choose the appropriate terms for the customer terms.  

3. In the Credit Limit field, type 2000. 

4. In the Preferred Payment Method drop-down list, choose Cheque. 

When you finish, your window should look like this.  

 

5. Click OK to add the customer and close the New Customer window.  
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QuickBooks displays the Customers & Jobs list with Godwin Manufacturing added  

to the list.  

6. Close the Customer Centre.  
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QuickBooks has several preset reports related to customers. Some 

reports you may find useful are the sales by customer summary and the 

sales by customer detail reports (under the Sales submenu in the Reports 

menu). 

You may also find the A/R aging summary, A/R aging detail, customer 

balance summary, customer balance detail, and open invoices reports 

useful. You’ll find them under the Customers & Receivables submenu in 

the Reports menu. 

  

4.8 Working with the Employee Centre  

The Employee Centre stores information about your employees such as name, address, and social 

insurance number. It also stores information QuickBooks needs to calculate your employee 

paycheques (if you are using QuickBooks for payroll). You’ll learn how to enter employee payroll 

information later in this course. For now, enter only the basic employee information.  

QuickBooks uses the information you enter in the Employees list to track sales and fill in information 

on cheques and other forms.  

4.8.1 Adding new employees  

Suppose that White Ridge Construction has hired a new employee and you want to add her information 

to the Employees list.  

4.8.1.1 To add a new employee:  

1. Click Employee Centre in the icon bar.  

 QuickBooks displays the Employee Centre, which includes the Employees list.  

 

The Employee Centre is where you add a new employee, edit information for an existing 
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employee, or delete an employee name (as long as you have not used the employee name in any 

transactions).  

2. Click New Employee at the top of the Employee Centre.  

QuickBooks displays the New Employee window.  

 

The Personal tab is where you enter basic information about the employee, such as name, Social 

Insurance Number, and date of birth.  

3. In the First Name field, type Marlene.  

4. In the Last Name field, type Duncalf, and then press Tab.  

Notice that QuickBooks fills in the “Print as” field with the information you entered in the name 

fields. You can enter a different name if you wish.  

5. In the SIN No. field, type 111 111 118.  

6. In the Gender field, select Female from the drop-down list.  

7. In the Date of Birth field, type 07/18/82.  

The Personal tab should look like this. 
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8. Click the Address and Contact tab. 

9. In the Address field, type 195 Spruce Avenue, #202. 

10. For the City, Province, and Postal Code fields, type Vancouver, BC T2P 5L3. 

11. In the Phone field, type 604 555-1111.  

 When you finish, the window should look like this. 

 

12. Next, select Employment Info. 

13. In the Hire Date, type 11/26/2014.  

14. Click OK.  

15. If QuickBooks asks if you want to set up this employee’s payroll information, click “Leave As Is”. 

You learn how to set up payroll in Lesson 12.  

QuickBooks updates and displays the Employee list with the new employee’s name added.  

 

16. Close the Employee Centre.  
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4.9 Working with the Vendor Centre  
The Vendor Centre is where you record information about the companies or people from whom you 

buy goods or services. QuickBooks uses the data in the Vendor Centre to fill in purchase orders, 

receipts, bills, and cheques as you receive and pay for goods and services.  

4.9.1 Adding new vendors  

In this exercise, you’ll add a new vendor to the Vendor Centre. Suppose White Ridge Construction is 

working with a new subcontractor, and it needs to add information about the new vendor to its 

QuickBooks Vendors list.  

4.9.1.1 To add a new vendor:  

1. Click Vendor Centre in the icon bar. QuickBooks displays the Vendor Centre.  

 

2. Click New Vendor at the top of the Vendor Centre.  

 QuickBooks displays the New Vendor window.  

 The New Vendor window is where you enter all of the information regarding a new vendor, such 

as name, phone, contact, address, and opening balance. Just as when you add a new customer, you 

start by providing basic information on the Address Info tab.  

3. In the Vendor Name field, type Hughes Electric.  

 This is the name QuickBooks displays for this vendor in the Vendors list. If the vendor is an 

individual, you may wish to enter the last name first, then the first name.  

4. In the Company Name field, type Hughes Electric, and then press Tab.  

Notice that QuickBooks displays the company name on the first line of the Address 

field.  

5. Click in the Name and Address field after the company name displayed on the first line, and press 

Enter. 

6. On the second line of the Address field, type P.O. Box 2316.  
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7. Press Enter to move to the next line.  

8. Type Nanaimo, BC V6C 2R3. 

9. In the Main Phone field, type 250 555-6666.  

10. In the FAX field, type 250 555-6667. 

11. In the Main Email field, type info@hugheselectric.ca 

 When you finish, your window should look like this. 

 

4.9.2 Providing additional vendor information  

The additional tabs in the New Vendor window is where you can enter a vendor type (if you want to 

categorize your vendors), payment terms, your credit limit, the vendor’s tax identification number, 

whether this vendor is eligible for a T4A form, and your opening balance. You can also setup default 

account information and other information for the vendor. You’ll add this information now for Hughes 

Electric.  

4.9.2.1 To add information to a vendor record: 

1. Click the Payment Settings tab tab. 

QuickBooks displays the Payment Settings tab of the New Vendor window.  
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2. In the Account No. field, type 123-445.  

3. In the Terms field, choose “2% 10 Net 30” from the drop-down list.  

4. In the Credit Limit field, type 2000 and press Tab.  

5. Click the Additional Info tab. 

6. In the Type field, choose Subcontractors from the drop-down list. 

Your New Vendor Additional Info window should resemble the figure below.  

 

7. Click OK. 

 QuickBooks adds the vendor and displays the updated Vendors list. 
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 Notice that Hughes Electric has been added to the list.  

8. Close the Vendor Centre.  
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QuickBooks has several preset reports related to vendors. Some reports 

you may find useful are the purchases by vendor summary and detail 

reports (under the Purchases submenu in the Reports menu). 

You may also find the A/P aging summary, A/P aging detail, unpaid bills 

detail, and the vendor balance summary reports useful. You’ll find them 

under the Vendors & Payables submenu in the Reports menu. 

  

 

4.10 Adding custom fields  

QuickBooks lets you add custom fields to the Customers & Jobs, Vendors, Employees, and Item lists. 

Custom fields give you a way to track additional information specific to your business. For example, 

you can add a field for pager numbers to your Vendors and Employees lists, a field for customers’ 

birthdays to your Customers & Jobs list, and fields for units of measurement, colour, and size to your 

Item list.  

When you add the custom fields to your sales forms or purchase orders, the fields are prefilled with the 

information for that specific customer, employee, vendor, or item (if you specified a value for the 

custom field when you added the customer, for example). You don’t have to add the custom fields to 

your forms, however; you can also use custom fields as a way to record information just for your use, 

such as a credit rating for each customer. QuickBooks remembers the information you entered in the 

custom fields when you import and export data and when you memorize transactions.  

You can add up to seven custom fields for each of the names lists (customers, vendors, and 

employees). Overlapping fields count as one field on each list. For example, if you add a custom 

“Birthday” field for customers and vendors, you can still add six additional fields to each list. You can 

add up to five custom fields for the Item list. (Custom fields for the Item list are tracked separately 

from custom fields for the customers, vendors, and employee lists.)  



73 |  P a g e
 

After you add custom fields, you can use them on invoices, credit memos, sales receipts, purchase 

orders, estimates, and sales orders (QuickBooks: Premier and higher only).  

4.10.1 Adding custom fields for customers, vendors, and employees  

You can enter information in the custom fields only through the New or Edit windows (for example, 

the New Customer or Edit Customer windows). You can display information from the custom fields on 

forms as well as add custom fields to reports.  

First, look at the custom fields that White Ridge Construction has already added to its Customers & 

Jobs, Vendors, and Employees lists. Then, you’ll add two new custom fields.  

4.10.1.1 To add custom fields: 

1. Click Customer Centre in the icon bar. 

 QuickBooks displays the Customer Centre.  

2. In the Customers & Jobs list, select Greene, Jeremy.  

3. Click the Edit   Customer button.  

 QuickBooks displays the Edit Customer window.  
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4. Click the Additional Info tab. 

 QuickBooks displays the Additional Info tab in the Edit Customer 

 

5. Click Define Fields. 

 QuickBooks displays the Define Fields window. 

 

Notice that White Ridge Construction has already set up custom fields in the Customers & Jobs list for 

spouse’s name, customer since, contact’s birthday, and website. In the Vendor list, they have set up a 

custom field for vendor since, contact’s birthday and website. In the Employee list, they have set up 
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custom fields for spouse’s name.  

Now, you’ll add a custom field for pager numbers to the Customers & Jobs and Vendors lists. You’ll 

also add a custom field to the Employees list that tracks the date of each employee’s last review.  

6. In the first blank Label field, type Pager Number.  

7. Click the Customers:Jobs checkbox to select it.  

8. Click the Vendors checkbox to select it.  

9. In the next blank Label field, type Date of Last Review.  

10. Click the Employees checkbox to select it. Your Define Fields window should now look like 

this.  

 

11. Click OK. 
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12. If you see an informational message about using the custom fields in transactions by turning 

them on in your custom templates, click OK.  

QuickBooks has added the Pager Number field to the Edit Customer window.  

 

13. In the Pager Number field, type 604 555-9876.   

If you customize your sales forms to display the Pager Number field, this number displays whenever 

you create a form for this customer. It also displays on reports modified to display the Pager 

Number column.  

14. Click OK to close the Edit Customer window.  

15. Close the Customer Centre.  

4.10.2 Adding custom fields for items  

Now suppose that White Ridge Construction wants to add a custom field to its Item list. The company 

purchases several types of plumbing fixtures. The Item list has no custom fields, but now White Ridge 

wants to add fields to track Colour & Style.  
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4.10.2.1 To add custom fields for items: 

1. From the Lists menu, choose Item List. 

QuickBooks displays the Item List, as shown below.  

 

2. In the Item List, select Plumbing Fixtures (a sub item of Direct Materials).  

3. Double Click the item.  

 QuickBooks displays the Edit Item window.  

 

Note:  Notice the Manufacturer’s Part Number field. This part number is 

a unique number or code assigned by the manufacturer to each of 

their items. Since purchase orders are usually sent to the 

manufacturer, using the manufacturer’s part number will ensure 

that your vendor knows exactly what is being ordered.  

4. Click Custom Fields.  
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 QuickBooks displays the information window stating there are no custom fields designed for 

items. Click OK.  

5. In the next window, click Define Fields.  

 QuickBooks displays the Define Custom Fields for Items window.  

6. Then type Colour in the Label field. In the “Use” column, click the first blank checkbox to 

select it.  

7. Type Style in the label field. In the “Use” column, click the next blank checkbox to select it. 

 

8. Click OK to close the window. 

If you see an informational message about using the custom fields in transactions by turning them 

on in your custom templates, click OK.  

9. In the “Custom Fields for Plumbing Fixtures” window, type Pewter in the Colour field, and 

Modern in the Style field.  

 

10. Click OK to close the Custom Fields for Plumbing Fixtures window, and then click OK to 

close the Edit Item window.  

11. Close the Item List.  
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You can add custom fields you’ve set up for customers or items to any 

sales form. Similarly, you can add custom fields you’ve set up for 

vendors or items to the purchase order form. If you want to filter a report 

based on text in custom fields, you must add the fields to the form used 

to generate the report. For example, if you want to filter the open 

purchase orders report by style, you need to add the Style field to the 

purchase order template you use. 
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4.11 Managing lists  

Lists are easy to manage in QuickBooks. You can sort lists, combine (merge) list items, rename list 

items, delete list items, make list items inactive, and print lists.  

4.11.1 Sorting lists  

You can sort many QuickBooks lists manually or alphabetically. To sort a list manually, simply use the 

mouse to drag a list item to its new location. Lists that you can sort this way are the Chart of Accounts, 

Customers & Jobs, Class, Customer Type, Vendor Type, Job Type, and Memorized Transaction lists.  

If you have changed the order of a list by dragging items and then decide you’d rather have an 

alphabetically sorted list, QuickBooks has a Re-sort List command. In the chart of accounts, the Re-

sort List command sorts alphabetically within account type; in the Item list, the Re-sort List command 

sorts alphabetically within item type.  

4.11.2 Sorting lists manually  

In this exercise, you’ll sort a list manually, and then re-sort it to put it back in alphabetical order.  

4.11.2.1 To sort a list manually:  

1. From the Lists menu, choose Chart of Accounts.  

QuickBooks displays the chart of accounts for White Ridge Construction.  

 

2. Click the diamond to the left of Undeposited Funds. The mouse pointer becomes a four-directional 

arrow.  

3. Click and hold the mouse button, and drag the pointer upward until you see a dotted line directly 

below Accounts Receivable.  

4. Release the left mouse button to drop the account in the new position. The Undeposited Funds 

account is now directly under the Accounts Receivable account.  
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Now you can use the Re-sort List command to return the list to alphabetical order.  

5. To re-sort the list alphabetically, click the Account menu button, and select Re-sort List. 

QuickBooks asks you to confirm that you want to return the list to its original order.  

6. Click OK. QuickBooks re-sorts the chart of accounts alphabetically by account type.  

7. Close the chart of accounts.  

4.11.3 Merging list items  

In most lists, you can combine two list items into one. For example, you may find that you’ve been 

using two customers (because of different spellings) when you really need only one on your Customers 

& Jobs list. You can merge list items in the Chart of Accounts, Item, Customers & Jobs, Vendors, 

Employees, and Other Names lists.  

Note:  After you merge list items, you cannot separate them. When 

working in your own company file, we recommend that you back 

up your data before merging list items.  

In this exercise, suppose you want to merge Hughes Electric (the vendor you added earlier in the 

lesson) with C.U. Electric. To merge them, you edit the incorrect name to match the spelling of the 

correct name.  

4.11.3.1 To merge items on a list:  

1. From the Vendors menu, choose Vendor Centre. 

 QuickBooks displays the Vendor Centre. 

2. Double-click the entry for Hughes Electric.  

 QuickBooks displays the Edit Vendor window.  
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3. In the Vendor Name field, type C.U. Electric. (This is the vendor name you want to merge with.)  

4. Click OK.  

QuickBooks asks if you would like to merge the names.  

5. Click Yes.  

QuickBooks merges the two names, and you now have only C.U. Electric in the  

Vendors list.  

6. Close the Vendor Centre.  

Note:  You cannot merge items on the Fixed Asset Item list. In addition, 

if you use assembly items in QuickBooks: Premier Edition 

products, you cannot merge them with other assembly items or 

with any other type of item.  

4.11.4 Renaming list items  

You can rename any list item. When you make the change, QuickBooks automatically modifies all 

existing transactions containing the item.  
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If you don’t want to change existing transactions, add a new name or 

item instead. 

  

4.11.4.1 To rename a list item in the chart of accounts:  

1. From the Lists menu, choose Chart of Accounts to display the chart of accounts for White 

Ridge Construction.  

2. In the chart of accounts, select Chequing.  
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3. Click the Account menu button, and choose Edit Account.  

QuickBooks displays the Edit Account window.  

 

4. In the Account Name field, type Master Chequing Account.  

5. Click Save & Close.  

QuickBooks changes the account name in the chart of accounts.  

 

6. Close the chart of accounts.  

4.11.5 Deleting items and making list items inactive  

You can delete list items only if you have not used them in any transactions. If you try to delete a list 

item that is used in a transaction, QuickBooks displays a warning that the item can’t be deleted. If you 

don’t want to use a list item but you can’t delete it, you can make it inactive.  



83 |  P a g e
 

4.11.5.1 To make a list item inactive:  

1. On the Home page, click the Customers button (along the left side of the Home page). 

QuickBooks displays the Customers Centre, which includes the Customers & Jobs list.  

2. Select Bentley, Karen in the list. (Select her name, not the job.)  

3. Right-click the name and choose Make Customer:Job Inactive. (You can also click Edit 

Customer and then select the “Customer is inactive” checkbox.)  

Notice that Karen Bentley (and the job for her room addition) no longer appears on the Customers 

& Jobs list. (The customer and job item is only removed from the list—transactions associated 

with this customer and job will still show in reports.)  

 

4. To see inactive list items, choose “All Customers” from the View drop-down list.  
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QuickBooks displays all the list items again, but the X’s signify that this customer is still 

inactive. Make Karen Bentley active again by right-clicking the name and choosing Make 

Customer:Job Active. Say Yes in the message asking to activate subs as well. 

5. From the View drop-down list, select “Active customers.” 

6. Leave the Customer Centre open; you’ll print a Customers & Jobs list in the next exercise.  

4.11.6 Printing a list  

You can print a QuickBooks list for reference, or you may print a list to a file to use in your word 

processor or spreadsheet. QuickBooks prints the Customers & Jobs list as it appears on the screen, for 

example, if the Customers & Jobs list is expanded and sorted by balance total, QuickBooks prints the 

expanded list sorted by balance total; if the list is collapsed, QuickBooks prints just the customer name, 

the balance total, and active status.  

4.11.6.1 To print the Customers & Jobs list:  

1. In the Customer Centre, click the Print menu button. 

QuickBooks displays a message telling you that you can also print list information from the 

Reports menu.  

2. Click OK to bypass the List Reports message.  

QuickBooks displays the Print Reports window, which displays the name of your printer and 

printer port. You can select to print to a printer or to a file. 

3. Click Print.  

Note:  This is a fairly long list, so if you don’t want to print it now, click 

Cancel. 

4.11.6.1.1 To print contact information for selected customers:  

1. From the Reports menu, choose List, and then choose Customer Contact List from the 

submenu.  

2. Click Customize Report.  

3. Click the Filters tab.  

4. Select Customer in the Filter list.  

5. In the Customer field, choose Multiple customers/jobs.  

6. Make sure Manual is selected and then click to put a checkmark next to those customers for 

which you want to print contact information.  

7. Click OK to close the Select Customer:Job window.  

8. Click OK to close the Customize Report window.  

9. Print the report.  
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10. Close the report, and select No when QuickBooks asks if you wish to save the modified 

report. 
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 QuickBooks has preset reports that let you report on the information in 

your QuickBooks lists. For example, you can create a phone list and a 

contract list for you customers, employees, and vendors. You can also 

create a price list for the items stored on your QuickBooks Item list. 

To create a list report, from the Reports menu, choose List, and then 

choose the list report you want to generate. 

  

Let students know that if they want to print the list to a file (so they can use it in their word processing, 

spreadsheet, or database program), they can select File and choose the appropriate file format from the 

drop-down list. 
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5 Lesson 4: Working with Bank Accounts 

5.1 Lesson objectives  

 To learn how to work with the registers for QuickBooks bank accounts  

 To demonstrate how to open a register  

 To learn the features common to all registers  

 To learn when and how to make entries directly in the register  

 To demonstrate how to reconcile a QuickBooks bank account  

5.2 Supporting materials  

 Handout 3: Registers associated with QuickBooks windows  

 PowerPoint file: Lesson 4  

5.3 Instructor preparation  

 Review this lesson, including the examples, to make sure you’re familiar with the material.  

 Ensure that all students have a copy of qblesson.qbb on their computer’s hard disk.  

 Have Handout 3 ready for distribution.  

5.4 To start this lesson  

Before you perform the following steps, make sure you have installed the exercise file (qblesson.qbb) 

on your hard disk. See “Installing the exercise file” in the Introduction to this guide if you haven’t 

installed it. 

The following steps restore the exercise file to its original state so that the data in the file matches what 

you see on the screen as you proceed through each lesson. 

5.4.1 To restore the exercise file (qblesson.qbb): 

1. From the File menu in QuickBooks, choose Open or Restore Company. 

 QuickBooks displays the Open or Restore Company window.  

2. Select Restore a backup copy and click Next.  

3. Select Local backup and click Next.  

4. In the Open Backup Copy window, navigate to your C:\QBtrain directory.  

5. Select the qblesson.qbb file, and then click Open.  

6. In the Open or Restore Company window, click Next.  

7. Navigate to your C:\QBtrain directory.  

8. In the File name field of the Save Company File as window, type lesson 4 and then click 

Save.  

9. Click OK when you see the message that the file has been successfully restored.  
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5.5 Writing a QuickBooks cheque  

You can enter cheques directly into the cheque register by using the QuickBooks Write Cheques 

window. When you enter a cheque at the Write Cheques window, you can see the address information 

and easily allocate the cheque between multiple accounts.  

Suppose that you need to write a cheque to pay White Ridge Construction’s telephone bill.  

5.5.1 To write a cheque:  

1. In the Banking area of the Home page, click Write Cheques. 

QuickBooks displays the Write Cheques window. 

 

The Bank Account field shows the account from which you are writing this cheque. QuickBooks 

displays the current date in the Date field. You can change either of these values if you wish, but 

they are fine for our example.  

2. If necessary, select the “Print Later” checkbox.  

 QuickBooks displays a checkmark in the checkbox.  

3. In the Pay to the Order of field, select The Phone Co. from the drop-down menu. 

4. Press Tab to move to the Amount field. If the following window displays, click Continue Writing 

Cheque.  
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QuickBooks has an AutoRecall feature that pre-fills new transactions based on previous 

transactions. You can have QuickBooks pre-fill the expense account for a vendor transaction 

based on previous transactions for that vendor. You can change this preference to have 

QuickBooks fill in the amount as well as other information from the last transaction with a payee. 

This is convenient when you have recurring payments of the same amount. To change this 

preference, choose Preferences from the Edit menu. Click General, and then select “Automatically 

recall last transaction for this name” on the My Preferences tab.  

5. Type 156.90 (the amount of the telephone bill), and then press Tab. Notice that QuickBooks spells 

out the amount of the cheque for you on the line below the payee. 

6. Click in the Account column on the Expenses tab, and then, if necessary, choose Utilities:Phone 

from the drop-down list. 

7. In the Tax field choose S from the drop-down list, and then press Tab. 

 Your screen should resemble the following figure.  
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Note:  QuickBooks has automatically adjusted the net amount to be 

assigned to the phone account to allow for the sales taxes 

(GST/PST) to be assigned to their respective accounts. 

The Expenses tab is where you assign the amount of the cheque to one of the expense accounts on 

your company’s chart of accounts. In this case, White Ridge Construction assigns the cheque to its 

Utilities account and the Phone subaccount. You use the Items tab only when purchasing items 

you plan to stock in inventory.  

If you select the “Pre-fill accounts for vendor based on past transactions” preference, QuickBooks 

remembers all your recent transactions for a vendor, not just the most recent one. If you 

consistently use the same account for a vendor, QuickBooks will automatically pre-fill that 

information any time you select the vendor in a bill, cheque, or credit card transaction.  

8. Click Save & Close. 

9. If the Job Costing – Expense without a customer job window appears, click Yes. 

10. From the Banking menu, choose Use Register.  

White Ridge Construction has more than one type of bank account, so QuickBooks displays the 

Use Register window and asks you to specify the account you want.  

 

11. Select Chequing as the account whose register you want to see and click OK. 

QuickBooks opens the Chequing register.  

 

12. Close the Chequing account register.  
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Do NOT use the Write Cheques window if you are paying sales tax, 

paying payroll taxes and liabilities, or paying bills that you have entered 

previously (that is, you are using A/P to track them). Instead, use the Pay 

Sales Tax window for a sales tax payment, the Pay Liabilities window 

for payroll taxes, and the Enter Bills and Pay Bills windows for paying 

A/P bills.  

  

Refer to Handout 3, “Registers associated with QuickBooks windows”  

5.6 Using bank account registers  
When you work in QuickBooks, you often use forms—such as a cheque or an invoice—to enter 

information. But behind the scenes, QuickBooks records your entries in the appropriate account 

register. Each balance sheet account listed on the chart of accounts has a register associated with it 

(except the Retained Earnings account).  

5.6.1 Opening a register  

When you have a QuickBooks form displayed on your screen, you can view its account register by 

choosing Use Register from the Banking menu, or by double-clicking the account name in the chart of 

accounts.  

5.6.1.1 To open a register (when no form is open):  

1. From the Lists menu, choose Chart of Accounts. 

 QuickBooks displays the Chart of Accounts window. 

 

2. In the chart of accounts, double-click the Accounts Receivable account. 

 QuickBooks opens the register for White Ridge Construction’s Accounts Receivable account. 



91 |  P a g e
 

 

5.6.2 Common features of QuickBooks registers  

All QuickBooks registers work the same way, regardless of the accounts with which they are 

associated. Here are some common features of all QuickBooks registers:  

 The register shows every transaction that affects an account’s balance and lists them in 

chronological order (though you can change the order by choosing a different option from the 

Sort by drop-down list). For example, in a chequing account, the register shows cheques you’ve 

written (either with QuickBooks or by hand), deposits to the account, and withdrawals from the 

account.  

 The columns in the register give specific information about the transaction. The first column is 

the date. The second column shows a reference number (a cheque number or a vendor’s P.O. 

number) and a type (to tell you whether the transaction represents a cheque or a bill payment, 

for example). The next column lists the payee, the account to which you’ve assigned the 

transaction, and any descriptive memo you choose to type. The final columns for a bank account 

show the transaction amount (either in the Payment or Deposit column) and whether the 

transaction has cleared the bank (indicated by a checkmark in the column).  

 On every transaction line, QuickBooks shows the account’s running balance. The bottom of the 

register window shows the account’s ending balance—the balance takes into account all the 

transactions entered in the register, including cheques you haven’t yet printed.  

5.6.2.1 To complete the exercise: 

1. Close the Accounts Receivable register window. 

2. Close the chart of accounts.  

5.7 Transferring money between accounts  
You can easily transfer money to different accounts using the “QuickBooks Transfer Funds Between 

Accounts” window. White Ridge Construction wants to record a transfer of $5,000.00 from chequing 

to savings made earlier in the day.  

5.7.1 To transfer money:  

1. From the Banking menu, choose Transfer Funds.  
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QuickBooks displays the “Transfer Funds Between Accounts” window.  

 

Notice that QuickBooks displays the current balance for the Term Loan account.  

2. In the Transfer Funds From field, choose Chequing from the drop-down list.  

3. In the Transfer Funds To field, choose Savings from the drop-down list.  

4. In the Transfer Amount field, type 5000 and press Tab.  

 Your screen should resemble the following figure.  

 

5. Click Save & Close. 

6. If a message appears, click OK because the money has already been transferred in person. 

QuickBooks decreases the balance in the chequing account by $5,000 and increases the balance in the 

savings account by $5,000. 

When you record the transaction, QuickBooks creates a journal entry. The following table shows the 

journal entry for the funds transfer. 

Account Title  Debit Credit 

Chequing   $5,000.00  

 Savings  $5,000.00   
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5.8 Reconciling chequing accounts  
Reconciling is the process of making sure that your chequing account record matches the bank’s 

record.  

5.8.1 An overview of reconciliation  

When you keep your records with QuickBooks, you don’t have to worry about addition or subtraction 

errors like you do when you’re using a paper cheque register. Even so, it is important to get in the habit 

of reconciling your QuickBooks bank accounts on a monthly basis. This helps you avoid overdraft 

charges for bad cheques, gives you a chance to spot possible bank errors, and helps you keep more 

accurate financial records.  

Your bank sends you a statement for each of your accounts each month. The statement shows all the 

activity in your account since the previous statement:  

 The opening balance for your bank account (amount in your account as of the previous 

statement)  

 The ending balance for your bank account (amount in your account as of the closing date for the 

statement)  

 The amount of interest, if any, you’ve received for this statement period  

 Any service charges assessed by the bank for this statement period  

 Cheques that have cleared the bank  

 Deposits you’ve made to the account  

 Any other transactions that affect the balance of your account (for example, automatic payments 

or deposits or ATM withdrawals or deposits)  

When you receive a statement from your bank or from a credit card company, you need to reconcile 

the statement with your QuickBooks records. You can reconcile any QuickBooks bank account, 

including accounts for savings and money market funds. The goal of reconciling is to make sure that 

your QuickBooks records and the bank’s statement agree about your account balance.  

5.8.2 Marking cleared transactions  

To begin reconciling an account, you need to tell QuickBooks which account you want to reconcile. 

Then you can provide information from the top part of your bank statement.  

5.8.2.1 To reconcile your account:  

1. From the Banking menu, choose Reconcile. 

 QuickBooks displays the Begin Reconciliation window. 

2. In the Account field, make sure Chequing is selected.  

3. If necessary, in the Statement Date field, type 11/30/2014.  

4. In the Ending Balance field, type -94284.67 

5. In the Service Charge field, type 14.00.  
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6. In the Service Charge Date field and Interest Earned Date field, type 11/30/2014. 

7. In the Service Charge Account field select Interest & Bank Charges:Bank Charges. 

 Your screen should resemble the following.  

 

8. Click Continue.  

 QuickBooks displays the Reconcile – Chequing window.  

 You can select which columns you want to display by clicking Columns to Display. When 

completing an actual Bank Reconciliation, you would compare the items on the displayed screen 

with those itemized on the printed Bank Statement. As you match items from the screen to the 

statement you would place a check mark beside that item. For this exercise we are assuming that 

the items with November dates match those of the Bank Statement.  

 

9. Select all items dated in November in the “Cheques and Payments” section by clicking in the 

left column.  

 If you need to make a correction to a transaction before you reconcile the account, highlight the 

transaction, and click Go To. QuickBooks takes you to the transaction and allows you to return to 

the reconciliation without losing your work. 

10. In the Cheques and Payments section, scroll down to ensure all items with dates up to and 
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including 11/30/2014 have a check mark beside them. 

11. In the Deposits and Other Credits section # check to make sure that the checkmarks for all items 

with dates later than 11/30/2014 have been cleared. Your screen should resemble the following figure.  

   

12. A review of the figures in the lower right corner of the window shows a Difference  

of $0.00 which means the account is reconciled. Click Reconcile Now. 

 Click OK if a message about online banking is displayed. 

 QuickBooks displays the Select Reconciliation Report window. 

 

Note:  If you see the Reconcile Adjustment window 

instead, click Return to Reconcile and make sure 

that you have cleared all the checkmarks for all 

items with dates later than 11/30/2014. Use the 

scroll bars to see all the items.  

13. In the Select Reconciliation Report window, make sure “Both” is selected, and then click Display.  

14. Click OK at the message that QuickBooks displays.  

QuickBooks displays both the reconciliation summary and reconciliation detail reports. It’s a good 

idea to save each reconciliation report, but for the purposes of this lesson viewing the reports is 

sufficient.  
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15. Examine the reports to learn what they show and the close the report windows.  

If you are using QuickBooks: Pro you may want to print a copy of the report, print the report to a file, 

or save the report in PDF format in case you need to reference it again. QuickBooks: Pro overwrites 

the previous reconciliation report with data from the latest reconciliation. (To save a report in PDF 

format, with the report displayed, choose Save as PDF from the File menu.)  

Note:  If you’re using QuickBooks: Premier, you can print the 

reconciliation reports for all previous reconciliations.  

In addition to the summary and detail reports (which you can view as PDF files), there is an additional 

report option: the Reconcile Discrepancy report. The Reconcile Discrepancy report shows changes and 

deletions made to previously reconciled transactions, making it easier to find discrepancies. This report 

is useful when the beginning balance that QuickBooks shows is different than the ending balance from 

the bank statement for the previous period. (To generate the report, choose Reconcile from the 

Banking menu, click Locate Discrepancies, and then click Discrepancy Report.)  

If the last reconciliation was in error, by clicking Undo Last Reconciliation in the Locate Discrepancies 

window, you can undo it without having to identify and manually clear each affected transaction.  

5.8.3 Viewing cleared cheques in the register  

Now you know that the balance in your QuickBooks cheque register is accurate as of the latest bank 

statement. The next time you look at the cheque register, you’ll see a checkmark in the Cleared column 

next to each reconciled transaction.  

Open the Chequing account register to see the cleared cheques.  

5.8.3.1 To viewed cleared cheques in the register:  

1. From the Banking menu, choose Use Register. 

 QuickBooks displays the Use Register window. 

2. Select Chequing and click OK. 

3. Scroll through the register to view the cleared items. 

 Your register should resemble the figure below. 

 

Notice that QuickBooks displays a checkmark next to all cleared items. 
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4. Close the Chequing account register.  

5.8.4 Locating specific transactions  

You can use the QuickBooks Find command to search for specific cheques you’ve written. For 

example, suppose you want to find all cheques greater than $500.00 that you’ve written during the 

current year.  

5.8.4.1 To use the Search feature:  

1. From the Edit menu, choose Search. 

2. Select the arrow next to Transactions. 

3. Select Cheques. 

4. In the amount drop down arrow, select Greater than. 

5. In the amount field, type 500.00 

6. Enter a date range if necessary. 

Your screen should resemble the figure below. 

 

7. Click Go. QuickBooks will display the search results. 

8. Close the Search window.  
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6 Lesson 5: Using other accounts in QuickBooks 

6.1 Lesson objectives  

 To introduce the other account types available in QuickBooks  

 To learn how to track credit card transactions in QuickBooks  

 To reconcile a credit card account  

 To see how to make a credit card payment  

 To discuss the different types of asset and liability accounts you can create and see how to track 

assets and liabilities in QuickBooks  

 To introduce the subject of equity and QuickBooks equity accounts  

6.2 Supporting materials  

 PowerPoint file: Lesson 5  

6.3 Instructor preparation  

 Review this lesson, including the examples, to make sure you’re familiar with the material.  

 Ensure that all students have a copy of qblesson.qbb on their computer’s hard disk.  

6.4 To start this lesson 

Before you perform the following steps, make sure you have installed the exercise file (qblesson.qbb) 

on your hard disk. See “Installing the exercise file” in the Introduction to this guide if you haven’t 

installed it.  

The following steps restore the exercise file to its original state so that the data in the file matches what 

you see on the screen as you proceed through each lesson.  

6.4.1 To restore the exercise file (qblesson.qbb):  

1. From the File menu in QuickBooks, choose Open or Restore Company. QuickBooks displays 

the Open or Restore Company window.  

2. Select Restore a backup copy and click Next.  

3. Select Local backup and click Next.  

4. In the Open Backup Copy window, navigate to your c:\QBtrain directory.  

5. Select the qblesson.qbb file, and then click Open.  

6. In the Open or Restore Company window, click Next. 

7. Navigate to your c:\QBtrain directory. 

8. In the File name field of the Save Company File as window, type lesson 5 and then  

click Save.  
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9. Click OK when you see the message that the file has been successfully restored.  

6.5 Other account types in QuickBooks  

In this lesson, you’ll learn about these types of QuickBooks accounts: 

 Credit card accounts—Used to track transactions you pay for with a credit card. 

 Asset accounts—Used to track both current assets (those assets you’re likely to convert to cash 

or use up within one year, such as inventory on hand) and fixed assets (such as long-term notes 

receivable and depreciable assets your business owns that aren’t liquid, such as equipment, 

furniture, or a building).  

 Liability accounts—Used to track both current liabilities (those liabilities scheduled to be paid 

within one year, such as sales tax, payroll taxes, and short-term loans) and long-term liabilities 

(such as loans or mortgages scheduled to be paid over terms longer than one year).  

 Equity accounts—Used to track owner’s equity, including capital investment, draws, and 

retained earnings.  

6.6 Tracking credit card transactions  

Many businesses pay for expenses with a credit card rather than a cheque. For travel expenses 

especially, a credit card is invaluable because it gives a detailed listing of each charge. You can track 

credit card transactions in QuickBooks just as easily as you track expenses you pay for by cheque.  

You should set up a QuickBooks credit card account for each credit card you use in your business. 

Like any QuickBooks account, a credit card account has its own register. The register lists all the 

charges and credits you've recorded, as well as payments you've made.  

The way you open and scroll through a credit card register is the same way you open and scroll 

through any QuickBooks account register.  

6.6.1 Entering credit card charges  

QuickBooks lets you choose when you enter your credit card charges. You can enter credit card 

charges when you charge an item or when you receive the bill. Your choice depends on whether you 

like to enter information into QuickBooks incrementally or all at once. The advantage to entering 

charges when you charge an item is that you can keep close track of how much you owe. In addition, if 

the charge is for a particular job, you can keep track of how much you’re spending on that job.  

Suppose you have a repair charge for $89.95 you want to enter into QuickBooks. The form you use is 

the Enter Credit Card Charges form.  

6.6.1.1 To enter a credit card charge:  

1. From the Banking menu, choose Enter Credit Card Charges.  

 QuickBooks displays the Enter Credit Card Charges window.  
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This is the window where you enter your charges.  

2. In the Credit Card field, select Credit Card:Visa from the drop-down list (if it’s not already selected). 

3. In the Purchased From field, select Dan’s Auto Emporium from the drop-down list. 

Notice the Ref No. field. Most credit card receipts have some sort of transaction number near the 

top, which exists for identification and tracking purposes. Entering this number from a credit card 

receipt gives you additional information for the credit card charge, but you don't have to use it. 

You don’t need to enter one for this example.  

4. Click in the Amount field, and then double-click to select the entire amount.  

5. Type 89.95 and then press Tab.  

6. Click the Expenses tab if not already selected. 

7. In the detail area, click in the Account column and assign the charge to the Vehicles: Maintenance and 

Repair account, as shown in the figure below. (Vehicles is the account; Maintenance and Repair is the 

subaccount.) 

8. In the Tax Field type “S”, if necessary.  
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9. Make sure that the date is 12/31/2010 in the date field and then click Save & Close to record the 

transaction and close the window.  

After you record this credit card charge, QuickBooks adds a $89.95 transaction to the credit card 

account register (increasing the liability by $89.95. It also adds $85.93 to the Vehicles: Maintenance 

and Repair expense account [$80.31 + $5.62 PST]. (You will see the increase when you create reports 

on their expense accounts.) It also adds $4.02 to the GST Paid account. 

When you record the transaction, QuickBooks creates a journal entry. The following table shows the 

journal entry for the credit card charge.  

Account Title  Debit Credit 

Visa Card   $89.95  

 Repair & Maintenance  $85.93  

 GST Paid $4.02  
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If you used your credit card to purchase expense (you want to pass along 

the expense to a particular customer), you need to indicate this in the 

Enter Credit Card Charges window. 

For each expense or item you enter on the bottom part of the form, select 

the appropriate customer in the Customer:Job column. To indicate that 

this expense should be passed along to the customer, make sure the 

Billable column has a checkmark in it. This allows the expense to be 

passed along when you invoice the customer. 
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6.6.2 Reconciling a credit card statement  

Just as we reconciled a bank account in the previous lesson, you should compare your credit card 

receipts with your statement and reconcile your credit card statement. Reconciling a credit card 

account is almost identical to reconciling a bank account.  

6.6.2.1 To reconcile a credit card statement: 

1. On Home page in the Banking area, click on Reconcile.  

2. Choose Visa from the Account drop down arrow.   

 QuickBooks displays the Begin Reconciliation window.  

 

 In the Beginning Balance field, QuickBooks displays the balance of all cleared transactions in the 

credit card register. To reconcile a credit card statement, all you have to do is enter the ending 

balance and check off each transaction listed on your statement.  

3. In the Statement Date field, enter 11/30/2014, if necessary. 

4. In the Ending Balance field, type 3419.98.  

N
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When the ending balance is different from the previous month’s 

ending balance, check for cleared transactions that are now 

showing as uncleared. 

5. In the date field after the Finance charge field, enter 11/30/2014, if necessary. 

6. Click Continue. 

 QuickBooks displays the Reconcile Credit Card window. 
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 The Reconcile Credit Card window shows all the transactions for the credit card account that have 

not yet cleared. You’ll use this window to check off the transactions listed on your statement.  

6.6.3 Marking cleared transactions  

6.6.3.1 To mark the transactions as cleared:  

1. In the “Charges and Cash Advances” section of the window, click Mark All. 

 Your Reconcile Credit Card window should resemble the following figure.  

 

2. Since the difference shows, 0.00, you can click Reconcile Now.  

 QuickBooks displays the Make Payment window.  

 When you’ve finished reconciling a credit card account, QuickBooks gives you a chance to pay 

part or all of the balance due on your credit card.  
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3. For this exercise, you want to write a cheque for payment now, so leave that option 

selected and click OK. 

QuickBooks displays the Select Reconciliation Report window. 

 

4. In the Select Reconciliation Report window, select both and then click Display.  

 You don’t need to do so in this exercise, but to keep a record of the reconciliation report; you 

could choose Save as PDF from the File menu and save the report as a PDF file.  

 You could also click Print to print a hard copy of the report. You don’t need to print the report for 

this lesson.  

5. Click OK at the message that QuickBooks displays.  

6. Review the reports and then close them.  

6.6.4 Paying a credit card bill  

6.6.4.1 To write a cheque for the bill now:  

1. In the Write Cheques window, make sure Chequing is listed as the bank account and the “Print 

Later” box is selected.  

Notice that QuickBooks has already filled in the amount of the payment for you, and has assigned 

the expense to the MasterCard account. (If you change your mind and decide you only want to 

make a partial payment, you can change the amount here.)  
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2. Click in the Pay to the Order of field and type MasterCard. When the “Name not found” window 

appears, click “Quick Add”. 

 

3. Select Vendor and click OK. 

4. Your screen should resemble the following: 

 

5. Click Save & Close to record the transaction. QuickBooks subtracts $3,419.98 from your 

chequing account and also subtracts that amount from your credit card account.  
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6. Leave the Chart of Accounts window open, you will need it for the next exercise. 

When you record the transaction, QuickBooks creates a journal entry. The following table shows the 

journal entry for the cheque to MasterCard. 

Account Title  Debit Credit 

Chequing   $3,419.98  

 MasterCard  $3,419.98   

6.7 Working with asset accounts  
QuickBooks has two account types for tracking the value of your short- and long-term assets:  

 An Other Current Asset account tracks assets that are likely to be converted to cash or used up 

within one year. If you buy and sell inventory, the value of your entire inventory on hand is 

usually shown in an Other Current Asset account called something like “Inventory Asset.” Other 

current assets might include treasury bills, certificates of deposit, prepaid expenses (amounts 

already paid for services your business has yet to receive), prepaid deposits (which will be 

returned to you at a later date), reimbursable expenses, and notes receivable (if due within one 

year).  

 A Fixed Asset account tracks assets your business owns that are not likely to be converted into 

cash within a year. A fixed asset is usually something necessary for the operation of your 

business, like a truck, cash register, computer, or photocopier.  
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Some additional examples of other current assets are accounts 

receivable, bank accounts, and cash. QuickBooks provides three types 

of current asset accounts for you to use as you create asset accounts for 

your company:bank account (to track each bank account as well as 

petty cash), accounts receivable (to track money owed to your 

business), and other current asset.  

  

Discuss with students that some additional examples of other current assets are accounts receivable, 

bank accounts, and cash. QuickBooks provides three types of current asset accounts for you to use as 

your create asset accounts for your company:bank accounts (to track each bank accounts as well as 

petty cash), accounts receivable (to track money owed to your business, and other current asset. 

6.7.1 Setting up asset accounts to track amortization  

There is more than one way to keep track of amortization; this is just one suggested method. If you 

have students who are keeping track of asset amortization in other ways, assure them that they can 

continue using their own method.  

Fixed assets are equipment or property your business owns that are not for sale. Since they last a long 

time, you don’t completely charge their cost to the year in which you buy them. Instead, you spread 

their cost over several years. But because fixed assets wear out or become obsolete, their value 

declines constantly from the day you purchase them. The amount of this decline in value is called 

amortization.  
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To determine the estimated value of a fixed asset at any point in time, you need to subtract its 

accumulated amortization (total amount of amortization since the asset’s purchase) from its original 

cost.  

Usually, you’ll want your balance sheet to show the original cost of an asset (plus any subsequent 

improvements) on one line, with the accumulated amortization subtracted from the original cost on a 

second line, and the current value (net) on a third line. The method you’ll learn in this lesson lets you 

see each asset’s cost and its accumulated amortization separately on your balance sheet. You set up a 

separate fixed asset account for each asset, and two subaccounts under each fixed asset account: one 

for cost and one for accumulated amortization.  

6.7.1.1 To set up asset accounts to track amortization on a new trailer purchased by White 
Ridge Construction: 

1. In the chart of accounts window, click the Account menu button, and then choose New.  

QuickBooks displays the Add New Account: Choose Account Type window.  

2. Select Fixed Asset and click Continue.  

3. In the Account Name field, type Trailer.  

 Do not enter an opening balance.  

4. Click Save & Close.  

QuickBooks displays the new fixed asset account in the chart of accounts.  

 

Now you need to add two subaccounts: one for the asset’s cost, and the other for amortization.  

6.7.1.1.1 To add subaccounts:  

1. In the chart of accounts window, click the Account menu button, and then choose New.  

2. Select Fixed Asset and click Continue.  

3. In the Account Name field, type Cost.  

4. Select the “Subaccount of” checkbox, and then select Trailer as the parent account.  

5. Leave the opening balance blank.  

 The opening balance is the original cost of the asset, if you purchased the asset before your 

QuickBooks start date. If you’re buying the asset now, as the owner of White Ridge Construction 
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is, you leave the opening balance for the Cost account blank. When you enter information about 

the loan White Ridge Construction takes out to pay for the truck (later in this lesson), you’ll 

update the Cost account with the truck’s original cost.  

Your screen should resemble the following figure.  

 

6. Click Save & New. 

7. Repeat steps 3, 4, and 5 to add a second subaccount to the Trailer fixed asset account. Call the 

subaccount “Accumulated Amortization,” and do not enter an opening balance. The Add New Account 

window should look like this.  

 

8. Click Save & Close to save the Accumulated Amortization subaccount. 
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 When you complete these steps, your chart of accounts should look like this. 

 

Note:   The amount you enter as the opening balance depends on 

whether you acquired the asset after or before your 

QuickBooks start date. If you acquired the asset after your 

QuickBooks start date, you don’t enter an opening balance. If 

you acquired the asset before your QuickBooks start date, 

you enter the accumulated amortization of the asset as of the 

start date—entered as a negative number.  

6.7.2 Entering amortization transactions  

When it's time to enter amortization for an asset, you can use the register for the asset's accumulated 

amortization account. 

Determining the amount of amortization to deduct can be a complex process and the CRA rules on the 

subject change often. Students should ask a competent advisor for help in figuring actual amortization 

amounts for tax purposes.  

6.7.2.1 To enter a transaction for amortization:  

1. In the chart of accounts, select the Accumulated Amortization subaccount for the Trailer.  

2. Click the Activities menu button, and then choose Use Register.  

QuickBooks displays the register for the Trailer:Accumulated Amortization asset account.  

3. In the Decrease column, type 1300 and press Tab. This is the amortization amount.  

4. In the Account field, select Amortization Expense from the drop-down list.  

Your register should resemble the following figure.  

 



110 |  P a g e
 

5. Click Record.  

6. Close the register window.  

When you record the transaction, QuickBooks does the following:  

 Subtracts the amortization amount from the current value of the asset in the asset's fixed asset 

account.  

 Enters the amortization amount as an increase to your company's amortization expense in the 

expense account that tracks amortization.  
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 When you purchase an asset and pay for it with a company cheque or 

credit card, you should enter the purchase in the Write Cheques or Enter 

Credit Card Charges window. Then, in the Account field, choose the 

account for the asset. 

6.8 Working with liability accounts  
QuickBooks has two account types for tracking the value of your short- and long-term liabilities:  

 An Other Current Liability account tracks liabilities that your company expects to pay within a 

year. Other current liabilities might include short-term loans or a line of credit.  

 A Long-term Liability account tracks debts that your business is not likely to pay off within a 

year. The most common long-term liabilities are loans that you expect to pay off in more than 

one year.  
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 Some additional examples of other current liabilities are accounts 

payable, credit card accounts, accrued sales tax, and accrued payroll. 

QuickBooks provides three types of current liability accounts for you to 

use as you create liability accounts for your company: credit card (to 

track credit card charges and payments), accounts payable (to track 

money owed by your business), and other current liability. 

  

6.8.1 Tracking a loan with a long-term liability account  

You’ve already added an asset account to track the value of the new trailer. Because the trailer loan is 

not going to be paid off in a year or less, you need to add a long-term liability account.  

6.8.1.1 To add a long-term liability account:  

1. In the chart of accounts, click the Account menu button, and then choose New.  

2. In the Add New Account window, select Other Account Types, and then choose Long Term 

Liability from the drop-down list.  

3. Click Continue.  

4. In the Account Name field, type Trailer Loan.  
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5. Do not enter an opening balance. 

 Your screen should resemble the figure below. 

 

6. Click Save & Close.  

QuickBooks displays the new liability account in the chart of accounts.  

 

 Because this is a new loan, you are either receiving money to deposit in your bank account 

 or receiving a new asset. In this example, you received an asset (the new trailer), so you need 

 to show an increase in the asset’s Cost account.  

6.8.1.1.1  To record an increase in the asset’s Cost account:  

1. In the chart of accounts, double-click the Trailer:Cost subaccount.  

QuickBooks displays the Trailer:Cost register.  
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2. In the Increase field, type 30,000.  

3. In the Account field, select the Trailer Loan liability account from the drop-down list. 

Make sure that you select the Trailer Loan long term liability account, not the Trailer fixed asset 

account.  

4. Click Record. 

Your screen should resemble the following. 

 

5. Close the register window. 

6. Close the chart of accounts. 

When you complete these steps, QuickBooks increases the value of your Cost asset account to 30,000. 

(This effectively sets the opening balance.) It also enters a liability of 30,000 in the liability account 

you use to track the loan. (Again, this sets the opening balance.)  
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6.8.2 Tracking fixed assets  

You can enter the Trailer on the Fixed Asset Item list. Tracking fixed assets using the Fixed Asset Item 

list enables you to record such information about an asset as purchase date and price, whether the asset 

was new or used when purchased, and the asset's sale price if you decide to sell it. You can also 

generate customizable reports listing all your fixed assets.  

The information you enter in the Fixed Asset Item list does not transfer to the chart of accounts.  

6.8.2.1 To create a fixed asset item:  

1. From the Lists menu, choose Fixed Asset Item List.  

QuickBooks displays the Fixed Asset Item list.  

 

2. Click the Item menu button, and select New.  

QuickBooks displays the New Item window.  

 

 The item type is preset as Fixed Asset.  

3. In the Asset Name/Number field, type Trailer.  
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4. Enter the following information to complete the Purchase Information section:  

Item is: new  

Purchase Description: Trailer  

Date: 12/31/2014 

Cost: 30,000  

Vendor/Payee: East Vancouver Auto Mall  

 The New Item window should look like the following graphic.  

 

5. Enter the following information to complete the Asset Information section:  

Asset Description: White trailer with company logo  

Serial Number: 123456789  

Warranty Expires: 12/31/2017  

6. From the Asset Account drop-down list, choose Trailer:Cost.  

The New Item window should look like the following graphic.  
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7. Click OK. 

8. Close the Fixed Asset Item list. 

If you work with an accountant, he or she can determine the amortization of your assets and update 

your company file with that information.  

6.8.3 Recording a payment on a loan  

When it's time to make a payment on a loan, use the Write Cheques window to record a cheque to your 

lender. You’ll want to assign part of the payment to a loan interest expense and the remainder to loan 

principal.  

6.8.3.1 To record a payment on a loan:  

1. From the Banking menu, choose Write Cheques. 

QuickBooks displays the Write Cheques window. 

2. In the Pay to the Order of field, type The Provincial Bank and press Tab. If the “Name not found” 

message appears, click “Quick Add”. In the next window accept Vendor and click OK. 

3. For the dollar amount of the cheque, type 500.00. 

4. Click the Expenses tab, and then click in the Account column and choose the Interest & Bank 

Charges: Loan Interest expense account from the drop-down list.  

5. In the Amount column highlight the amount that QuickBooks prefilled and then type 225.00. 

6. Assign the remainder of the expense (275.00) to the Trailer Loan liability account.  

 

7. Click Save & Close to record the payment.  
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8. If the Job costing window displays, click the box to not display the window again, and then click 

Yes. 

When you record the transaction, QuickBooks automatically updates the accounts affected by this 

transaction:  

 In your chequing account, QuickBooks subtracts the amount of the cheque from your balance.  

 In the expense account that tracks interest, QuickBooks enters the interest amount as an increase 

to your company's interest expense.  

 In the Trailer Loan liability account, QuickBooks subtracts the principal amount from the 

current value of the liability (reducing the amount of your debt).  

When you record the transaction, QuickBooks creates a journal entry. The following table shows the 

journal entry for the trailer loan payment.  

Account Title  Debit Credit 

Chequing   $500.00  

 Loan Interest  $225.00   

 Trailer Loan  $275.00   

6.9 Understanding equity accounts  

Many students will see the equity accounts QuickBooks automatically adds for them, and wonder what 

equity is all about. Equity can be a complicated subject, especially for newer business owners, and a 

complete discussion of it is not the focus of this lesson. This section introduces the subject of equity, 

and helps students understand why QuickBooks creates the two default equity accounts.  

Equity is the difference between what you have (your assets) and what you owe (your liabilities). If 

you sold all your assets today and paid off your liabilities using the money received from the sale of 

your assets, the money you’d have left would be your equity.  

A balance sheet shows your company assets, liabilities, and equity on a particular date. Because equity 

is the difference between total assets and total liabilities, it’s also true that total assets equal the sum of 

total liabilities and equity.  

As you enter the opening balances of your assets and liabilities, QuickBooks calculates the amount of 

equity and records it in an equity account called Opening Bal Equity (Bal stands for Balance).  

In addition to the Opening Bal Equity account, QuickBooks sets up another type of equity account for 

you called Retained Earnings. This account tracks your company's net income from previous fiscal 

years. QuickBooks automatically transfers your profit (or loss) to Retained Earnings at the end of each 

fiscal year.  

If your company is a sole proprietorship (an unincorporated company with only one owner), you don’t 

have to add any more equity accounts to your chart of accounts. All the equity belongs to the 

company’s sole owner.  
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You can get as involved in tracking equity as you wish. Some people like to track owner investments, 

owner’s draws, and retained earnings prior to their QuickBooks start date by putting them in separate 

equity accounts. If your business is a partnership, you’ll probably want to set up separate equity 

accounts for each partner.  

To learn more about equity and to learn how to set up equity accounts for your business, search the 

onscreen Help index for equity.  
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 A common use of an equity account is to record an owner’s draw (a payment 

you make to yourself). To record an owner’s draw, use the Write Cheques 

window to make out a cheque to yourself. In the detail area of the cheque, 

assign the amount of the cheque to the equity account you use to record 

owner draws. 
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7 Lesson 6: Entering Sales Information 

7.1 Lesson objectives 

 To learn about the different formats available for sales forms  

 To save sales and purchase forms in Portable Document Format (PDF)  

  To practice creating a new invoice  

 To learn the purpose and use of the QuickBooks Item List  

  To see how QuickBooks records the information you enter on sales forms 

 To memorize an invoice transaction for reuse  

 To add a new item to the Item List 

  To add a new price level to the Price Level list  

 To associate a price level with a customer  

 To generate reminder statements 

  To create sales orders (QuickBooks: Premier and higher) 

 To track backorders (QuickBooks Industry-specific editions)  

7.2 Supporting materials  

 Handout 4: QuickBooks item types  

 PowerPoint file: Lesson 6  

7.3 Instructor preparation  

 Review this lesson, including the examples, to make sure you’re familiar with the material.  

 Ensure that all students have a copy of qblesson.qbb on their computer’s hard disk. 

  Have Handout 4 ready for distribution.  

7.4 To start this lesson  

Before you perform the following steps, make sure you have installed the exercise file (qblesson.qbb) 

on your hard disk. See “Installing the exercise file” in the Introduction to this guide if you haven’t 

installed it.  

The following steps restore the exercise file to its original state so that the data in the file matches what 

you see on the screen as you proceed through each lesson.  

7.4.1 To restore the exercise file (qblesson.qbb):  

1. From the File menu in QuickBooks, choose Open or Restore Company. QuickBooks displays 

the Open or Restore Company window.  

2. Select Restore a backup copy and click Next.  

3. Select Local backup and click Next.  
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4. In the Open Backup Copy window, navigate to your C:\QBtrain directory.  

5. Select the qblesson.qbb file, and then click Open.  

6. In the Open or Restore Company window, click Next.  

7. Navigate to your C:\QBtrain directory.  

8. In the File name field of the Save Company File as window, type lesson 6 and then click 

Save.  

9. Click OK when you see the message that the file has been successfully restored.  

7.5 Using sales forms in QuickBooks  

Any time you make a sale in your business, you record it in QuickBooks on a sales form. A sales form 

can be an invoice (when you expect payment to come later), a sales receipt (when you expect payment 

at the time you make the sale), or a credit memo.  

You use a credit memo when a customer returns merchandise for which you’ve already entered a 

payment or a cash sale. This lesson shows students how to use invoices and sales receipts.  

7.5.1 When to use different types of sales forms  

The type of sales form you use depends on whether you expect payment in the future or at the time of 

the sale.  

7.5.1.1 For payment in the future  

If you expect to receive payment at some future date, you enter an invoice. The invoice lists the 

customer’s name and address, along with an itemized list of how much that customer owes.  

7.5.1.1.1 To display a completed invoice form in QuickBooks:  

1. From the Customers menu, choose Create Invoices.  

QuickBooks displays the Create Invoices window.  

2. Click Previous to display the previously created invoice.  
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If you own a business that sells products, like White Ridge Construction, your invoice lists the 

products purchased by the customer, the amount charged for each item, and any sales tax you need 

to apply.  

A business that sells mainly services, such as a consulting firm, might use a different type of sales 

form than the one shown above. QuickBooks lets you choose from eight different preset formats 

for your sales forms, or you can create your own customized forms.  

3. Close the Create Invoices window.  

7.5.1.2 For payment at the time of sale  

If you receive full payment at the time you make a sale—either by cash, cheque, or credit card—you 

fill out a sales receipt instead of an invoice. Like the invoice, the QuickBooks sales receipt includes 

information about the items or services purchased, but it also includes information about how payment 

was made.  

7.5.1.2.1 To display a completed sales receipt in QuickBooks:  

1. From the Customers menu, choose Enter Sales Receipts. 

2. QuickBooks displays the Enter Sales Receipts window.  

3. Click the Previous button to view the previously entered sale.  

 

The sales receipt is similar to the invoice—both forms display customer information and describe 

the items and services purchased. However, because payment is made at the time of sale, the sales 

receipt has deposit information at the bottom of the window.  

4. Close the Enter Sales Receipts window.  
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7.5.2 Choosing a template for sales forms  

QuickBooks has several different templates for invoices. The invoices available depend on which 

version of QuickBooks you are using, and the type of company you set up. For more information, 

search the onscreen help for invoice template.  

Examples of  templates include: 

 Intuit Professional Invoices – Use these templates if you sell services and need a lot of room for 

descriptions of your services. There are three types of Professional Invoices: Attorney’s, Fixed 

Fee and Professional. 

 Intuit Product Invoice – Use this template if you sell parts or products and need fields relevant 

to shipping.  

 Intuit Service Invoice – Use this template if you primarily sell services but occasionally sell 

goods.  

 Invoice from Proposal – Use this form to create an invoice from an Estimate. 

 Time and Expense Invoice – Use this invoice to bill time and expenses to a customer. 

 Intuit Packing Slip – Use this invoice when shipping goods to a customer. 

Each template has an onscreen version and a printed version. This lets you record all the sales detail 

you need, but print only what you want customers to see. For example, if you use the Professional 

Invoice template, the onscreen version shows the number of hours you’re billing the client as well as 

your hourly rate; the printed version shows only the Description and the Amount fields.  

You can save all QuickBooks sales and purchase forms as portable document format (PDF) files. To 

save a form as a PDF file, display the form and then choose Save as PDF from the File menu.  

You’ll learn how to customize forms in Lesson 15, “Customizing forms and writing QuickBooks 

Letters.”  

7.6 Filling in a sales form  
Suppose White Ridge Construction wants to bill a customer for a portion of a kitchen remodeling job. 

Because they expect payment to be made in the future—rather than cash on the spot—they need to 

create an invoice.  

7.6.1 Filling in the customer information  

Filling in an invoice is just like filling in a paper form; you enter the customer information first, 

followed by a description of the charges.  

7.6.1.1 To enter customer information on an invoice:  

1. On the Home page in the Customers area, click Create Invoices.  

Ensure that the new invoice has the current date (12/31/2014 ) entered in the Date field, and the 

next invoice number assigned in the Invoice # field is 16. If not, click in the Invoice # field, and 

click the +  or - sign until the number is 16, click Tab. QuickBooks will then pick up the new 

number format for the next invoices.  

2. In the Template field, select Intuit Service Invoice from the drop-down list.  
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3. In the Customer:Job field, click the arrow next to the drop-down list.  

 QuickBooks shows you a list of White Ridge Construction’s existing customers and jobs.  

4. Choose Greene, Jeremy:Kitchen Renovation for the customer and job. 

Because this name has already been entered on the Customer:Job list, QuickBooks knows the billing 

name, the address, and the payment terms. It provides this information for you on the top half of the 

form.  

If the “Customer:Job has an Estimate and Available Sales Orders screen appears, click Cancel. 

If the Billable Time/Costs window appears, close it. 

 

7.6.2 Filling in the line item area  

On the bottom half of the invoice, you list each service or product you’re selling on its own line, along 

with the amount the customer owes for that item. Because information about individual items is on 

separate lines, the lines are called line items.  

In QuickBooks, you enter line items using the Item List, so you don’t have to type and retype lines for 

services or products you sell frequently. For example, an architect would have one item for design and 

another for construction supervision.  

But items are not just products you sell or services you provide to clients. Line items can be anything 

you might want to put in the detail area of an invoice, like a discount, a subtotal line, or a markup.  

White Ridge Construction has already entered the items for which it bills customers on its Item List.  

7.6.2.1 To complete the line item area of an invoice:  

1. In the Item field, type the letters dir (for Direct Labour).  

QuickFill is an alternative to choosing from a list. Whenever you’re in a field where you’ll use a 

list item, you can start typing the first letter or two of the list item you want, and QuickBooks fills 

in the field with the item that matches the letters you’re typing.  

2. Choose Direct Labour:Design Services from the drop-down list that appears. 

 When you accept a QuickFill entry, QuickBooks fills in other information about the item, like its 

description and rate. In this case, QuickBooks displays “Design Services” in the Description 

column and a rate of $50 per hour. All you have to do is enter the number of hours. 

If the Sales Tax Codes message appears, click OK. 
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3. Type 20 in the Quantity column.  

4. Type G in the Tax column. 

5. Press Tab to have QuickBooks update the invoice total.  

 

7.6.3 Completing the sales form  

If you want to check the form before you print it, you can use the print preview feature in the Create 

Invoices window. 

7.6.3.1 To complete and record the invoice:  

1. Click the Print Preview button at the top right corner of the screen. 

QuickBooks displays the invoice page as it will look when printed.  

 

2. Click Zoom In and use the scroll bars to see the invoice items at greater magnification.  

3. Click Close.  

4. In the Create Invoices window, record the sale by clicking Save & Close.  
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 QuickBooks records the invoice in your accounts receivable register. If this were a sales receipt, 

QuickBooks would record the sale in your Undeposited Funds account until you deposit the 

money at the bank, or record a deposit in the bank account you specified in the Enter Sales 

Receipts window.  

N

o

t

e

:

  

The option to select an account into which you want to deposit 

the payment is only available when the Sales & Customers 

preference “Use Undeposited Funds as a default deposit to 

account” is turned off. 

 The accounts receivable register keeps track of how much money your customers owe you.  

7.6.3.1.1 To see the Accounts Receivable register:  

1. From the Company menu, choose Chart of Accounts.  

QuickBooks displays the chart of accounts.  

2. In the chart of accounts, double-click the Accounts Receivable account.  

QuickBooks displays the accounts receivable register.  

 

3. Select the sale we just recorded in the register (for Jeremy Greene). 

4. Double-click the entry. 

 When you double-click an entry in a register, QuickBooks displays the original form (in this case, 

the invoice). 

Keep the invoice window open; you’ll use it in the next exercise. 
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When you’ve been using QuickBooks for a while and need to find a particular 

invoice, you can use the QuickBooks Find command. Suppose you want to search for 

the invoices you wrote to three particular customers. 

Here’s how you’d find those using the Find command: 

1 With the Create Invoices window open, choose Find Invoices from the Edit 

menu and then click the Advanced button in the Find Invoices window. 

2 In the Find window, select Transaction Type from the list of filters, and then 

select Invoice from the list of transaction types. 

3 Select Name from the list of filters, and then choose Multiple names from the 

Name drop-down list. 

4 In the window that appears, ensure that Manual is selected and then click the 

names and jobs of the three customers. Click OK, and then click Find. 

QuickBooks finds all the invoices written to those particular customers. 

You can also find a particular customer invoice by scrolling through the customer 

register for that customer. (Right-click that customer’s name in the Customers & Jobs 

List and choose Use Register.) If you know the invoice number, you can sort the 

customer register by number rather than date to find an invoice more quickly. (You 

can change the sort order by selecting a different order in the Sort By field in the 

register window.) 

Another way to find an invoice for a particular customer is to click Find in the Create 

Invoices window. You can then enter a customer:job name, a date range, an invoice 

number, or an amount that QuickBooks can use to locate an invoice or invoices. (This 

functionality is available for eight common QuickBooks forms.) 

  

  

Make sure students keep this invoice displayed on screen. You’ll show them how to memorize it in the 

next lesson.  

7.7 Memorizing a sale 

Many of the sales you make in your business are ones you repeat again and again. For example, you 

may have a standing monthly order from a customer, or you may perform essentially the same services 

for more than one client. QuickBooks lets you memorize sales forms so that you don’t have to retype 

the information. 

7.7.1 To memorize the invoice: 

1. Make sure you have the invoice you want to memorize displayed on your screen. For this 

exercise, use the design services invoice you just created. 

2. From the transaction ribbon, click Memorize.. 

QuickBooks displays the Memorize Transaction window.  
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3. Type a description that helps you recognize the memorized invoice, or keep the default 

description QuickBooks has provided. For this exercise change the name to Greene - Kitchen 

Renovation. 

You can enter any description you like. Notice that you can also have QuickBooks remind you 

when to use the memorized transaction (for an invoice you always send at the end of the month, 

for example). For this exercise leave the How Often field on “Never” 

4. Click OK.  

5. Close the Create Invoices, Accounts Receivable, and the Chart of Accounts windows.  

When you memorize an invoice, QuickBooks adds it to the Memorized Transaction list.  

7.7.1.1 To recall a memorized sale:  

1. From the Lists menu, choose Memorized Transaction List.  

QuickBooks displays the Memorized Transaction List window.  

  

2. Double-click the transaction you just added.  

QuickBooks displays the Create Invoices window, with the information you memorized displayed 

on the form. It gives you a new invoice number and displays the current date. You can modify the 

information as you wish, but for this exercise change the date to 12/31/2014. 

3. Click Save & Close to record the invoice.  

4. If a warning message regarding the customer’s credit limit is displayed, click Yes. 

5. Press the Esc key to close the Memorized Transaction list.  
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7.8 Entering a new service item 

When you begin using your own QuickBooks company file, you’ll need to create your own line items 

to include on your invoices. In the next exercise, you’ll see how to add information to the Item List.  

White Ridge Construction already has a service item called Repairs that it uses when it wants to charge 

for general repair work. Suppose White Ridge wants to add a subitem for plumbing repairs to the Item 

List. (The company charges a higher rate for plumbing repairs, so it wants a separate item for it on its 

Item List.)  

Have students refer to Handout 4 for a review of the types of items they can add to the Item List.  

7.8.1 To create a new service item:  

1. From the Customers menu, choose Item List.  

QuickBooks displays the Item List for White Ridge Construction.  

 

2. Click the Item menu button, and then choose New.  

QuickBooks displays the New Item window.  
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Note:  The options available in the Type list depend on the version 

of QuickBooks you are using. You must be using a 

QuickBooks: Premier or higher edition product to see 

Inventory Assembly listed as an item type.  

3. In the Type field, select Service from the drop-down list.  

4. In the Item Name/Number field, type Plumbing.  

5. Click the “Subitem of” checkbox to select it.  

6. In the drop-down list below the “Subitem of” field, select Direct Labour: Plumbing Labour. 

7. In the Description field, type Plumbing repairs and maintenance and press Tab.  

8. In the Rate field, type 55.  

9. In the Tax Code drop-down list, select S.  

Now you need to assign this line item to one of White Ridge Construction’s income accounts.  

10. In the Account field, select Construction Income from the drop-down list.  

Your screen should look like the following figure.  

 

11. Click OK to add the new item to White Ridge Construction’s Item List.  
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12. Close the Item List.  

Now that the new item is on the Item List, White Ridge Construction can invoice for plumbing repairs 

separate from its general repair work. It can also create sales reports that show sales for general repairs 

separate from sales for plumbing repairs.  
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 To offer a discount on an invoice (or other sales form) at the time of sale 

(for example, for a senior discount), create a “discount” type item and 

enter it as a line on the form. 

 

If the discount is to apply to more than one item, first use a “subtotal” 

type item to calculate the total of the items. Then, enter the discount item 

beneath the subtotal. 

7.9 Using multiple price levels  

In the last exercise, you set up a new service item for White Ridge Construction and assigned a price to 

that item. Sometimes businesses want to vary an item’s price based on who they are selling to. For 

example, White Ridge Construction charges different prices depending on whether it is selling to a 

residential or a commercial customer.  

You can associate price levels with specific customers so that each time you create an invoice (or 

estimate, sales receipt, credit memo, or sales order) for that customer, QuickBooks uses the appropriate 

price level when calculating rates and amounts on the form. Price levels make it easy to use different 

rates on sales forms without having to calculate percentage amounts manually. Price levels affect 

amounts for service, inventory, non-inventory part, and inventory assembly items only. (Inventory 

assembly items are available in QuickBooks: Premier and higher.)  

In this section, you’ll create a new price level, associate it with one of White Ridge’s customers, and 

then create an invoice for that customer.  

7.9.1 Creating new price levels  

White Ridge Construction charges its residential customers the base sales price it set up on its Item 

List. The company charges its commercial customers 10 percent less than the base sales price. In this 
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exercise, you’ll create a new price level for White Ridge Construction to use to reduce the sales 

amount for its commercial customers.  

For each price level you create, you assign a name and percentage increase or decrease to the item’s 

base sales price. You can create up to 100 price levels to use on invoices, sales receipts, estimates, and 

credit memos.  

As described later in the lesson, QuickBooks: Premier editions also allow you to set up Per Item price 

levels.  

7.9.1.1 To create a new price level: 

1. From the Lists menu, choose Price Level List. 

 

2. From the Price Level menu button, choose New.  

3. In the Price Level Name field type Commercial.  

Note:  The Price Level Type field is selectable only with 

QuickBooks: Premier or higher. If you’re using 

QuickBooks: Premier or higher, select “Fixed %” from 

the Price Level Type drop-down list.  

4. Leave “decrease” selected in the “This price level will” field, and then type 10 in the “item prices 

by” field. Always enter the percentage as a positive number.  

5. From the “Round up to nearest” drop-down list, choose “1.00 minus .01.”  

This option rounds all the prices to the nearest dollar amount minus one cent, for example, $10.00 

rounds to $9.99. With QuickBooks, you can round your prices to the nearest whole cent, or you 

can precisely determine the amount by creating a user defined option.  

 Your window should look like the following.  
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6. Click OK. 

Your screen should now resemble the following. 

 

7. Close the Price Level List.  

7.9.2 Associating price levels with customers/or customer:job  

When you assign price levels to customers, QuickBooks calculates rates and amounts on sales forms 

based on the price level associated with that customer/or customer:job.  

7.9.2.1 To associate a price level with a customer:job  

1. Click Customer Centre on the icon bar.  

2. In the Customers & Jobs list, select Rajyaguru Kamlesh:Tea and Crumpets Room 

3. Double click the Job name, and then click the Payment Settings tab.  

4. From the Price Level drop-down list, choose Commercial. 

 Your screen should look like this. 
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5. Click OK to close the Edit Job window and save your changes.  

Leave the Customer Centre open for the next exercise.  

7.9.3 Using price levels on sales forms  

In this section, you’ll create an invoice for the customer job with which you just associated the 

Commercial price level to see how the price level affects amounts on the form.  

7.9.3.1 To use a price level associated with a customer or customer:job:  

1. Make sure Rajyaguru Kamlesh:Tea and Crumpets Room is selected in the Customers & Jobs list. 

2. Click the New Transactions menu button and choose Invoices from the drop-down list. 

3. Press Tab.  

If the Available Estimates window appears, click Cancel. 

If the Billable/Time costs window appears, close it. 

 Notice that QuickBooks displays the name of the price level associated with this Customer:Job in 

brackets above the Customer:Job drop-down list. (This information will not be printed on the 

form.) 

 

4. Choose Intuit Service Invoice from the Template drop down list. 

5. Click in the Item column, type dir for Direct Labour, and choose Clean Up Labour from the drop-

down list. If you don’t see the Item column, make sure you are using the Service Invoice template.  

6. In the Quantity field, type 10 , and in the Tax field, choose G. 

7. Click below Clean Up Labour in the Item field and choose Direct Labout:Design Services from 

the drop-down list.  

8. In the Quantity field, type 5, in the Tax field, choose G and then press Tab.  
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Your screen should look like this.  

 

9. Keep the invoice open and choose Item List from the Lists menu. 

10. In the Item List, go to Direct Labour:Clean Up Labour. Note that the price for this labour is 

$40.00, but the rate on the invoice is $35.99—10 percent less than the base sales price rounded to the 

nearest dollar minus one cent. QuickBooks has automatically reduced the rate on the invoice by 10 

percent and rounded the amount according to your price level setting.  

Note:  You can set up QuickBooks to round rates up to the 

nearest cent. You can set the rounding option for a 

rate from the Price Level List. See “Creating new 

price levels” on page 158.  

11. In the Item List, scroll to the Design Services item and note that the base sales price is $50—10 

percent greater than the rate listed on the invoice using the Commercial price level. It appears on 

the invoice as $44.99, including the discount and rounding settings.  

12. Close the Item List. 

13. Record the invoice by clicking Save & Close.  

14. Close the customer centre. 

7.9.3.2 Assigning price levels to individual line items  

In addition to associating price levels with customers/or customer:jobs, you can also use price levels on 

an individual basis on sales forms. The following are some examples of when you might want to do 

this.  
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 You’ve associated a price level with a customer, but want to charge the base sales price for an 

item on a sale to that customer.  

 You want to use a price level for one or more items, but you don’t want to assign a price level to 

the customer for whom you’re recording the sale.  

7.9.3.2.1 To apply a price to a single line item:  

1. In a sales form with line items (for example, the invoice you just created), click in the Rate 

column and select the price level you want to use from the drop-down list that displays. 

2. When you move out of that field on the form, QuickBooks recalculates the amount and 

balance due. 

Note:  If you use QuickBooks: Premier, you can refine your 

price levels even further by setting price levels for 

select items. For example, you could give a 

particular customer or group of customers an extra 

discount for a specific item or group of items as 

shown in the following graphic.  

 

To display the following window, Choose Price 

Level List from the Lists menu, select Kitchen 

Upgrade Special, click the Price Level button, and 

then select Edit Price Level. 
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7.10 Reminding customers of overdue payments  

In this section, you’ll learn about two types of documents you can create to remind customers about 

overdue payments.  

The first method involves creating a letter to a specific customer directly from that customer’s overdue 

invoice. Using this method, you can create a cover letter that summarizes information about the 

original invoice and lists the outstanding balance. You can also have QuickBooks list all of the line-

item information. An additional option is to have QuickBooks format the letters to work with window 

envelopes.  

The second method involves generating reminder statements, which allow you to generate documents 

that list recent invoices, credit memos, and payments received.  

7.10.1 Generating reminder statements  

Reminder statements summarize a customer's account with a company by listing recent invoices, credit 

memos, and payments received. You can use reminder statements when you bill through invoices but 

want to remind your customers about delinquent payments.  

Reminder statements are different than other “forms” in QuickBooks such as invoices, sales receipts, 

or cheques. Because QuickBooks already has all the information you need to create reminder 

statements, you don't have to fill them out. Instead, you review the information that will appear on each 

statement, decide whether to add finance charges, and print them.  

White Ridge uses invoices to bill its customers, but it sends reminder statements to customers with 

overdue invoices. In this exercise, you generate statements to send to customers with outstanding 

balances.  

White Ridge wants to send reminder statements to all customers who have balances more than 30 days 

past due.  

7.10.1.1 To generate reminder statements: 

1. Click Home to display the Home page if necessary, and in the Customer Area click Statements.  

QuickBooks displays the Create Statements window.  

 



136 |  P a g e
 

2. In the Select Statement Options section of the window, ensure the Statement date is 12/31/2014, 

and select the “All open transactions as of Statement Date” option. 

3. Click to select the “Include only transactions over” checkbox. 

4. In the number of days past due field type 30. 

5. In the Select Customers section, select “All Customers.” 

6. In the Select Additional Options section click to select the “Show invoice item details on 

statements” checkbox. 

7. Unselect the “Print due date on transactions” option if it is selected. 

Your screen should look like the following graphic.  

 

8. Click Preview to view the statements.  

9. Close the Create Statements window.  

7.11  Processing sales orders  

Note:  Sales orders are available in QuickBooks: Premier and higher 

editions only. To proceed through this exercise, you must be using 

QuickBooks: Premier or a higher edition. 

The sales order feature lets you track orders from customers and “set items aside.” You can also use 

sales orders to track back orders when a customer orders something and you are out of stock. Using 

this feature, you can track the orders you need to fill without affecting accounts receivable. Sales 

orders affect only inventory quantities—not values—until you actually sell the items.  

When inventory items come in, you can create an invoice directly from the sales order. If only some of 

the items have come in, you can invoice for those items, and use the sales order to create invoices for 

the remaining items later. Once all items have been received and invoiced for, QuickBooks: Premier 

closes the sales order.  
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7.11.1 Invoicing against sales orders  

In this exercise, you’ll create an invoice from a sales order. You display a report to see if there are any 

open sales orders. The report shows that there is an open sales order for Drywall Labour for Hilda 

Allin. White Ridge has now completed the drywall work for the customer’s order, so you can close the 

sales order and invoice the customer.  

If you’re using QuickBooks: Premier, you can also generate purchase orders directly from sales orders 

by clicking the down arrow on the Create Invoices button in the Create Sales Order window, and then 

selecting Purchase Order. You don’t need to create the purchase order in this exercise.  

7.11.1.1 To create an invoice from a sales order:  

1. From the Reports menu, choose Sales and then choose Open Sales Orders by Item. 

 QuickBooks displays the Open Sales Orders by Item report.  

 

2. Double-click Sales Order #1 for Hilda Allin in the report window. 

QuickBooks opens the sales order. 
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3. In the Create Sales Orders window, click the Create Invoice menu button on the toolbar and 

choose Invoice. 

Creating the invoice from the sales order links the sales order and invoice, which means that when 

you invoice the customer for items on the sales order, those items are marked as closed. 

QuickBooks displays the Create Invoice Based On Sales Order(s) window. 

 

4. Leave the “Create invoice for all of the sales order(s)” option selected, and click OK. 

QuickBooks creates an invoice for the customer. 

 In this case, since the work that the customer ordered has been done, you can close the sales 

order. If only some of the labour had been done, you could invoice for that portion and keep the 

sales order open until the balance of the job had been completed. QuickBooks tracks which items 

are still open.  

5. In the Create Invoices window, click Save & Close.  

6. Close the report window, if a warning displays regarding refreshing the report, click NO.  Close 

the Report Centre. 

7.12  Tracking backorders 

Using certain industry-specific QuickBooks Editions, you can use sales orders to track items that 

customers have ordered, but that are out of stock. Tracking backorders on sales orders, invoices, and 

other sales forms shows exactly what still needs to be shipped out. Tracking backorders on purchase 

orders shows what is still expected to be received from a vendor.  

In this exercise, you’ll first create a sales order and create an invoice from that sales order. (The 

customer has ordered items, but you don’t have sufficient quantities to fill the entire order.) Then, 

you’ll receive items into inventory and track the remaining items on backorder.  

Note:  You must be using QuickBooks: Premier Accountant Edition, 

Retail Edition, Manufacturing and Wholesale Edition, or 

Enterprise Solutions Editions to track back orders and perform 

this exercise.  

7.12.1 To create a sales order:  

1. On the Home page, in the Customer area click Sales Orders.  

QuickBooks displays the Create Sales Orders window.  
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2. In the Customer:Job drop-down list, select Rajyaguru Kamlesh:Tea and Crumpets Room.  

3. Click in the Item column and select Lighting Retail:Table Lamp from the drop-down list.  

Note:  If using QuickBooks Premier skip step 4 and proceed to 

entering the quantity in the Ordered column as shown in step 

5. 

4. In the Ordered column, click the Availability icon.  

 

In the Current Availability window, you can get information about what is available in inventory, 

what is listed on other sales orders, what’s reserved for assemblies, and what’s on order.  

Notice you have five table lamps available. However, you need eight table lamps to complete the 

order. So you’ll need to put the remaining three on backorder.  

5. Click Close, and then type 8 in the Ordered column on the Sales Order. 

6. Press Tab, and then click OK at the two messages that appear. (These will not appear if using 

QuickBooks Premier.) 

7. In the Tax column select “S”. 
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8. Press Tab again to have QuickBooks update the total. 

The sales order should look like the following graphic.  

 

You can fill part of the order now because you have five table lamps in stock, so you’ll create an 

invoice from the sales order.  

9. In the Create Sales Orders window, click the Create Invoice menu button on the toolbar and 

choose Invoice.  

This links the sales order and invoice, which means that when you invoice the customer for items 

on the sales order, those items are marked as closed. 

 QuickBooks displays the Create Invoice Based On Sales Order(s) window.  

10. Click “Create invoice for selected items” and click OK.  

QuickBooks displays the Specify Invoice Quantities for Items on Sales Order(s) window. When 

you create the invoice for selected items only, you indicate how many of each item from the sales 

order you want to include on the invoice.  
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Note:  You can click the “Show quantity available instead of 

quantity on hand” checkbox to display the number of items in 

inventory plus the number of items on purchase orders with 

vendors, minus the number listed on all other sales orders and 

quantity on pending builds.  

11. Make sure 5 appears in the To Invoice column and click OK to invoice for the five table lamps 

you have in inventory. 

 QuickBooks displays the invoice. On the invoice, QuickBooks lists how many of each item has 

been invoiced previously and how many are included in the current invoice. 

12. Click Save & Close.  

QuickBooks creates an invoice for the five table lamps in stock and puts the other three on 

backorder.  

The Open Sales Orders by Item report can help you track which items are on backorder by 

showing the quantity ordered and the quantity invoiced. To run the report, choose Sales from the 

Reports menu, and then choose Open Sales Orders by Item.  

 

13. Close the report. 

7.12.2 Receiving items  

White Ridge Construction has just received 10 table lamps from Fisher Supplies. Before you can 

invoice Rajyaguru Kamlesh for the table lamps on backorder, you need to receive the items into 

inventory.  

7.12.2.1 To receive items into inventory:  

1. From the Vendors menu, choose Receive Items.  

2. In the Create Item Receipts window, choose Fisher Supplies from the Vendor drop-down list.  
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3. In the Item column, select Lighting Retail:Table Lamp.  

4. Press Tab twice to go to the Quantity column and type 10.  

5. Press Tab and QuickBooks updates the amounts.  

 Your screen should resemble the following graphic.  

 

6. Click Save & Close.  

 Once you’ve entered the items into inventory, you have sufficient quantity on hand to 

finish filling Rajyaguru’s order. 

7.12.2.1.1 To fill Rajyaguru’s order: 

1. From the Customers menu, choose Create Sales Orders. 

2. Click the Previous button to display Rajyaguru’s sales order.  
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 Certain industry-specific QuickBooks editions help you track backordered items by adding a 

Backordered column to sales orders. (Backordering always starts from sales orders.) In addition, 

you’ll see Invoiced and Clsd columns. Once the sales order is either fully invoiced or closed, the 

Backorder column no longer displays. The Invoiced and Clsd columns always appear.  

3. In the Create Sales Orders window, click the Create Invoice menu button on the toolbar.  

       QuickBooks displays the Create Invoice Based On Sales Order(s) window.  

4. Click “Create invoice for selected items” and click OK. 

 QuickBooks displays the Specify Invoice Quantities for Items on Sales Order(s) window.  

When you create the invoice for selected items only, you indicate how many of each item from the 

sales order you want to include on the invoice. 

 

5. Make sure 3 appears in the To Invoice column and click OK to invoice for the three table 

lamps for Rajyaguru’s order.  

QuickBooks displays the invoice. On the invoice, QuickBooks lists how many of each item are 

included in the current invoice.  
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6. Click Save & Close to save the invoice and close the Create Invoices window.  

7. On the Home page, click Sales Orders.  

8. Click the Previous button to display Rajyaguru’s sales order.  

Notice the sales order now indicates that it has been invoiced in full. 

 

9. Close the Create Sales Orders window.  

7.12.3 Tracking backorders on purchase orders  

A backorder is the inventory on a purchase order that has not yet been received. In QuickBooks this 

occurs when a purchase order has been sent, a partial shipment has been received, but you have not 

received the final shipment. The items on the purchase order that have not yet been received are 

considered to be on backorder.  

Backordered and Rcv'd columns automatically appear after a purchase order has been partially 

received.  

Note:  Customize your purchase order template if you want the 

Backordered column to be printed on the purchase order.  
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8 Lesson 7: Receiving Payments and Making Deposits 

8.1 Lesson objectives 

 To learn how to record customer payments in QuickBooks  

 To learn how to handle customer discounts, partial payments, overpayments, or down payments  

 To see how to record a deposit in QuickBooks, and learn how QuickBooks treats the deposit 

behind the scenes  

 To learn how to enter cash back from a deposit in QuickBooks  

 To learn how to process credit card payments 

8.2 Supporting materials  

 PowerPoint file: Lesson 7  

8.3 Instructor preparation  

 Review this lesson, including the examples, to make sure you’re familiar with the material.  

 Ensure that all students have a copy of qblesson.qbb on their computer’s hard disk.  

8.4 To start this lesson  

Before you perform the following steps, make sure you have installed the exercise file (qblesson.qbb) 

on your hard disk. See “Installing the exercise file” in the Introduction to this guide if you haven’t 

installed it.  

The following steps restore the exercise file to its original state so that the data in the file matches what 

you see on the screen as you proceed through each lesson.  

8.4.1 To restore the exercise file (qblesson.qbb):  

1. From the File menu in QuickBooks, choose Open or Restore Company. QuickBooks displays 

the Open or Restore Company window.  

2. Select Restore a backup copy and click Next.  

3. Select Local backup and click Next.  

4. In the Open Backup Copy window, navigate to your C:\QBtrain directory.  

5. Select the qblesson.qbb file, and then click Open.  

6. In the Open or Restore Company window, click Next.  

7. Navigate to your C:\QBtrain directory.  

8. In the File name field of the Save Company File as window, type lesson 7 and then click 

Save.  

9. Click OK when you see the message that the file has been successfully restored.  
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8.5 Recording customer payments  
If you’re receiving payment at the time of a sale, and you fill out a sales receipt, QuickBooks records a 

customer payment. When you invoice a customer, and you receive payment later, you enter the 

payment in the QuickBooks Receive Payments window.  

The Receive Payments window lets you match up payments you receive with invoices you’ve written. 

You’ll be working with the Receive Payments window in this lesson.  

8.5.1 Recording a payment in full for a single job  

The simplest case is when a customer has one outstanding invoice for one job and sends you a payment 

for the full amount. Suppose that White Ridge Construction receives a cheque for $10,104.00 from 

Kamlesh Rajyaguru for his Tea & Crumpet Room. Here’s how you’d enter the payment.  

8.5.1.1 To record a payment in full:  

1. From the Customers menu, choose Receive Payments. 

 QuickBooks displays the Receive Payments window. 

 

The first step is to enter the name of the customer from whom you’ve received a payment.  

2. In the Received From field, select Rajyaguru, Kamlesh:Tea and Crumpets Room from the drop-

down list.  

QuickBooks displays the details of the outstanding invoice for Kamlesh Rajyaguru in the Receive 

Payments window. 

3. Press Tab to move to the Amount field.  

4. In the Amount field, type 10,104.00 and press Tab.  
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QuickBooks updates the amount in the Payment field to 10,104.00, and applies the payment to the 

one outstanding invoice.  

5. In the Pmt. Method field, select Cheque from the drop-down list and then press Tab. 

 When you enter a preferred payment method in a customer’s record, QuickBooks pre-fills that 

information when you select the customer’s name in this window. 

6. In the Cheque # field, type 6745.  

7.  In the Deposit to field, select “Undeposited Funds” from the drop-down list. 

 

8. Click Save & New. 

 This records the payment and clears the window so you can enter another one. 

When you record the transaction, QuickBooks creates a journal entry. The following table shows the 

journal entry for the payment.  

Account Title  Debit Credit 

Undeposited Funds  $10,104.00  

 Accounts Receivable   $10,104.00 

 

8.5.2 Entering a partial payment  

White Ridge Construction has also received a cheque for $2,000 from Greene, Jeremy. This customer 
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has two outstanding invoices and owes more than $8,000.  

8.5.2.1 To enter a partial payment:  

1. In the Received From field, select Greene, Jeremy: Kitchen Renovation from the drop-down list.  

In the middle of the window, QuickBooks shows you the invoices still outstanding for the job. In 

this case, there are two.  

2. Press Tab to move to the Amount field, and then type 2000. Then press Tab again. 

 QuickBooks automatically applies the payment you’ve entered to Jeremy Greene’s oldest invoice.  

 

 To choose which invoice a payment applies to, rather than having QuickBooks apply it to the 

oldest one, you can un-apply the payments and apply them as you wish. If you always want to 

select the invoice yourself, turn off the Payments preference “Automatically apply payments.”  

3. Click the invoice that you want to pay.   

4. In the Pmt. Method field, leave Cheque selected. 

5. In the Cheque # field, type 5678. 

6. In the Deposit to field leave Undeposited Funds selected. 

7. Leave the “Leave this as an underpayment” option selected.  
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8. Click Save & New to record the partial payment and clear the window. 

When you record the transaction, QuickBooks creates a journal entry. The following table shows the 

journal entry for the partial payment.  

Account Title  Debit Credit 

Accounts Receivable   $2,000.00  

 Undeposited Funds  $2,000.00   

   

8.5.3 Applying one payment to multiple jobs  

White Ridge Construction is working on several jobs for a customer, Roy Uchman. Roy has payments 

outstanding for three invoices. He wants to write one cheque to cover all outstanding payments.  

In this exercise, you’ll apply this single payment to invoices for multiple jobs.  

8.5.3.1 To apply one payment to multiple jobs:  

1. In the Receive Payments window, select Uchman, Roy from the Received From drop-down list.  

QuickBooks lists the open invoices for all of the jobs associated with Roy Uchman 
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2. Press Tab to move to the Amount field. 

3. In the Amount field, type 3396.93 and then press Tab. 

 Notice that QuickBooks applies the payment to all outstanding invoices. 

4. In the Pmt. Method drop-down list, confirm that Cheque is selected. 

5. In the Cheque # field, type 375.  

 Your window should look like this.  
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6. Click Save & New.  

8.5.4 Handling down payments or prepayments  

If a customer makes a payment before you’ve invoiced him for services (for example, he may be 

making a down payment or paying a retainer fee), you can still record the payment at the Receive 

Payments window. However, because you don’t have any invoices to which to apply the payment, 

QuickBooks records the payment as an unused payment (just like an overpayment).  

QuickBooks holds the unapplied amount with the customer’s name. The next time you enter that 

customer in the Receive Payments window, QuickBooks displays the credit amount in the Unused 

Credits area. The customer’s balance also reflects the credit amount.  
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To apply a discount for early payment for any customer whose payment 

terms include a discount for payment before the due date, use the Set 

Discount button in the Receive Payments window. 

Even if the customer has already sent you a payment for the full amount 

of the invoice, you can apply a discount. QuickBooks hold any credit 

amount in accounts receivable until you apply it to an invoice or issue a 

refund cheque. 

  

Suppose Karen Bentley wants White Ridge Construction to do a kitchen remodeling job for her. She’s 

sent White Ridge Construction a cheque for $1,000 as an initial payment, but the company hasn’t 

invoiced her yet. 

Since this is a new job for Karen, we need to add the job to the Customers:Jobs list. 

8.5.4.1 To add a new job to the Customers:Jobs list:  

1. Click Customer Centre on the icon bar. 

2. Select Karen Bentley from the list of customers, and then click on the New Customer & Job 

menu button. 

3.  From the drop-down menu, select Add Job.  

The new job window appears.  

4. In the Job Name field type Kitchen. 

5. In the Payment Settings tab, if necessary, enter a credit limit of 10,000. 

6. Click OK, to return to the Customer Centre window. 
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Your screen should look like this: 

 

7. Close the Customer Centre window. 

8.5.4.1.1 To enter the down payment you’ve received:  

1. From the Customers menu, select Receive Payments. 

2. In the Received From field, select Bentley, Karen:Kitchen from the drop-down list and then 

press Tab.  

3. Type 1000 in the Amount field and then press Tab.  

QuickBooks displays the payment as an overpayment.  

 

4. Leave the “Leave the credit to be used later” option selected. 

5. In the Pmt. Method field, make sure Cheque is selected. 

6. In the Cheque # field, type 4321. Make sure Undeposited Funds has been chosen.  
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7. Make sure that the date in the Date field is current (12/31/2014).  

8. Click Save & Close. 

9. Click OK in the message that displays. 

Later, White Ridge Construction is ready to prepare its invoices and needs to invoice Karen for the 

labour the workers have already completed on the job. 

8.5.4.1.2 To create an invoice for a customer who made a down payment:  

1. From the Customers menu, choose Create Invoices.  

QuickBooks displays the Create Invoices window.  

2. In the Customer:Job field, select Bentley, Karen:Kitchen from the drop-down list.  

3. From the Template drop-down list, ensure Intuit Service Invoice is selected. 

4. Click in the Item column, select Direct Labour:Demolition Labour from the Item drop-down list, 

and then press Tab.  

5. In the Quantity column, type 40, Tab to the tax field and select G.  

 

6. Click Apply Credits to apply the down payment amount made earlier towards this invoice.  

7. Click Yes at the message(s) that display. 

 QuickBooks opens the Apply Credits window displaying the credit you entered earlier. 
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8. This is the credit that you want to apply to the invoice, so click Done.  

QuickBooks updates the invoice and displays the remaining balance due ($470) on the invoice.  

 

QuickBooks applies the existing credit to the new invoice.  

9. Click Save & Close to record the transaction.  
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To see all the transactions related to customers, grouped by customer 

and job, create a customer balance detail report. (From the Reports 

menu, choose Customers & Receivables, and then choose Customer 

Balance Detail.) 



155 |  P a g e
 

  

8.6 Making deposits  
When you use the Enter Sales Receipt window (for a sales receipt where you receive payment on the 

spot), the Receive Payments window (for payments on invoices), or a payment item on an invoice, 

QuickBooks keeps track of the money you’ve received until you deposit it in the bank. When you 

receive payments from customers, you can either deposit each payment directly into a QuickBooks 

bank account or you can group payments together to be moved to that account at a later time. 

QuickBooks allows you to choose the method you prefer for depositing payments. 

If you set the Payments preference to always use the Undeposited Funds account as the default deposit 

to account, you do not see the “Deposit to” option in the Receive Payments or Enter Sales Receipts 

windows.  

It’s easier to reconcile your QuickBooks accounts with your bank statements when the accounts 

display deposits the same way that your statements do. Use the following to help you decide how to set 

the preference in your own business.  

 If your bank statement shows a lump sum for a deposit, group payments with other funds for 

later deposit using the Undeposited Funds account.  

 If your bank statement shows each individual payment that was deposited, deposit directly to an 

account.  

8.6.1 Selecting payments to deposit  

At your office, you might hold payments in a locked cash drawer or a cash register until you can get to 

the bank; QuickBooks holds the amount in an asset account called Undeposited Funds. When you’re 

ready to take your payments to the bank, you can record the deposit in QuickBooks, print a deposit slip 

to bring with you, and enter cash back amounts.  

8.6.1.1.1 To select payments to deposit:  

1. From the Banking menu, choose Make Deposits.  

QuickBooks displays the Payments to Deposit window, which lists the payments you have not yet 

deposited.  

 

2. Click to select the payments you want to bring to the bank. 
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 For this exercise, select the all the payments except for that of Card, Brad. 

 

3. Click OK. 

 QuickBooks displays the Make Deposits window, which shows the payments you just selected. 

 

4. In the Deposit To field, make sure that Chequing is selected.  
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Note:  If you have money to deposit that is not the result of a 

payment you received for a sale, you can enter it in the detail 

area of the window. For example, if you received a premium 

refund from your insurance vendor, you would enter it here.  

QuickBooks updates the deposit total at the bottom of the window automatically. If you wanted to 

print a deposit slip to take to the bank, you would click Print. The Printable Deposit Slips that you 

can order to work with QuickBooks work only with deposits of cash and cheques.  

5. Click Save & Close to record the deposit.  

8.6.2 How QuickBooks handles the deposit  

QuickBooks updates the Undeposited Funds account to show that you’ve made a deposit. It also adds 

the deposit to your chequing account register. 

8.6.2.1.1 To view the Undeposited Funds account: 

1. From the Lists menu, choose Chart of Accounts. 

2. In the chart of accounts, double-click the Undeposited Funds account. 

 

 QuickBooks displays your deposits and reduces the balance in the account by the amount of the 

deposits.  

3. Close the account register window.  

Now you can look at the deposit transaction in the chequing account.  

4. In the chart of accounts, double-click the Chequing account.  



158 |  P a g e
 

 

QuickBooks has entered the deposit as a transaction in the chequing account register and has 

updated the balance of your chequing account.  

5. Close the chequing account register and the chart of accounts.  
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You can create a report that shows you a list of all deposits and the 

payments included in each deposit. From the Reports menu, choose 

Banking, and then choose Deposit Detail.  

  

8.6.3 Getting cash back from a deposit  

In the Make Deposits window, you can enter information about any cash you took out of the deposit 

when you are recording the deposit.  

8.6.3.1.1 To record getting cash back from a deposit:  

1. On the Home page, in the Banking section, click Record Deposits.  

QuickBooks displays the Payments to Deposit window. Notice that the deposits you made in the 

last exercise are no longer listed.  

2. In the Payments to Deposit window, select the payment from Card, Brad.  

 

3. Click OK. 

4. In the Make Deposits window select Petty Cash in the “Cash back goes to” field and press Tab 

twice. 
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5. In the Cash Back amount field, type 2000 and press Tab. 

QuickBooks displays the deposit subtotal amount ($4500.00) and the total less the cash back 

amount ($2500.00).  

 

6. Click Save & Close.  

QuickBooks records the Deposit Total amount in your chequing account and the cash back 

amount in your Petty Cash account.  

7. To see the effect on these accounts, choose Chart of Accounts in the Company section on the 

Home page. Note that the Petty Cash account now shows a balance of $2,000.00.  

 

8. Close the chart of accounts.  
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9 Lesson 8: Entering and Paying Bills 

9.1 Lesson objectives  

 To discuss the different ways you can handle bills in QuickBooks  

 To learn how to enter a bill in QuickBooks  

 To use the Pay Bills window to pay a bill in QuickBooks  

 To learn how to enter a discount on a bill from a vendor  

9.2 Supporting materials  

 PowerPoint file: Lesson 8 

9.3 Instructor preparation  

 Review this lesson, including the examples, to make sure you’re familiar with the material.  

 Ensure that all students have a copy of qblesson.qbb on their computer’s hard disk.  

9.4 To start this lesson  

Before you perform the following steps, make sure you have installed the exercise file (qblesson.qbb) 

on your hard disk. See “Installing the exercise file” in the Introduction to this guide if you haven’t 

installed it. 

The following steps restore the exercise file to its original state so that the data in the file matches what 

you see on the screen as you proceed through each lesson. 

9.4.1 To restore the exercise file (qblesson.qbb): 

1. From the File menu in QuickBooks, choose Open or Restore Company. 

 QuickBooks displays the Open or Restore Company window.  

2. Select Restore a backup copy and click Next.  

3. Select Local backup and click Next.  

4. In the Open Backup Copy window, navigate to your C:\QBtrain directory.  

5. Select the qblesson.qbb file, and then click Open.  

6. In the Open or Restore Company window, click Next.  

7. Navigate to your C:\QBtrain directory.  

8. In the File name field of the Save Company File as window, type lesson 8 and then click Save.  

9. Click OK when you see the message that the file has been successfully restored.  
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9.5 Handling bills in QuickBooks  

When you have a business expense, you can handle it in one of the following ways:  

 You can write a cheque manually and enter the information into a QuickBooks cheque register 

later. This doesn’t take advantage of features in QuickBooks, but sometimes it’s necessary. For 

example, if you purchase supplies at a retail store, they expect payment on the spot, and you 

may not know the amount in advance.  

 You can use QuickBooks to write and print a cheque. When you receive a bill that you want to 

pay immediately, you can write a QuickBooks cheque more quickly and accurately than you can 

by hand. An additional advantage is that QuickBooks makes the entry in the chequing account 

register for you.  

 You can use the QuickBooks accounts payable feature to track the amounts you owe  

to vendors, track your cash flow needs, and handle bills you want to pay later. 

 You can pay by credit card and enter the credit card receipt into QuickBooks later. 

Lesson 4, “Working with bank accounts,” showed you how to enter a handwritten cheque and a 

QuickBooks cheque. In Lesson 5, “Using other accounts in QuickBooks,” you learned about credit 

card accounts. This lesson shows you how to use QuickBooks for accounts payable.  

9.6 Using QuickBooks for accounts payable  

Some business owners, especially if they own smaller, home-based businesses, pay their bills when 

they receive them. Most business owners, however, find it more convenient to pay bills less often. 

(They also like keeping the cash in the company for as long as possible.) If you don’t plan on paying 

your bills right away, QuickBooks can help you keep track of what you owe and when you owe it.  

The money you owe for unpaid bills is called accounts payable. QuickBooks uses the Accounts 

Payable account to track all the money you owe. Like any QuickBooks balance sheet account, the 

Accounts Payable account has a register where you can view all your bills at once.  

9.6.1 To see the Accounts Payable register:  

1. From the Lists menu, choose Chart of Accounts. 

 QuickBooks displays the chart of accounts. 

2. Double-click Accounts Payable in the list to open the register.  

QuickBooks displays the Accounts Payable register.  
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The register keeps track of each bill you have entered, shows you the due date, and keeps a 

running balance of all the bills you owe. As a business owner, this helps you forecast your cash 

flow, and the QuickBooks reminder system helps you pay your bills on time.  

3. Press Esc twice to close the open windows.  

 Using accounts payable to pay your bills involves two steps: entering the bill and paying the bill. 

You’ll practice both steps in this lesson.  

9.7 Entering bills  

When you receive a bill from a vendor, you should enter it into QuickBooks as soon as you can. This 

keeps your cash flow forecast reports up to date and doesn’t give you the chance to set aside a bill and 

forget about it.  

White Ridge Construction received a bill from the company that created its new brochures. The bill 

includes a charge for courier delivery. White Ridge Construction doesn’t plan to pay the bill until close 

to its due date, but the company wants to keep an eye on the accounts payable total, so enter the bill 

now.  

9.7.1 To enter a bill: 

1. From the Vendors menu, choose Enter Bills. 

QuickBooks displays the Enter Bills window.  
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The top half of the window is where you enter the bill. The bottom half is the detail area where 

you can assign the bill amount to different expense accounts, customers, or jobs.  

Notice that the Bill Received checkbox has a checkmark. The only time the Bill Received 

checkbox should be cleared is if you’re using QuickBooks for inventory and you want to record 

items you’ve received that you haven’t actually been billed for yet.  

2. In the Vendor field, type Willis Advertising, and then press Tab. 

3. When QuickBooks displays a message telling you that Willis Advertising is not in the Vendor list, click 

Quick Add. 

4. In the Date field, enter 12/31/2014 as the current date, if necessary. 

5. In the Amount Due field, type 1676.50.  

6. Click in the Bill Due field.  

 Notice that QuickBooks supplies a date for you in the Bill Due field. The date displayed is ten 

days from the date in the Date field. You can change the date if you wish. If your Vendor list had 

payment terms entered for this vendor, QuickBooks would have used those terms to calculate the 

bill’s due date. 

7. Click in the Account column on the Expenses tab and type Printing.  

QuickFill completes the entry for you, and displays Printing & Reproduction as the account. 

QuickBooks lets you assign transactions to more than one account, so you can keep close track of 

where your company spends its money. White Ridge Construction wants to assign the majority of 

this bill to a printing and reproduction expense account, and the rest to a freight delivery expense 

account.  



164 |  P a g e
 

Note:  You can set a preference so that QuickBooks pre-fills the 

account for a vendor transaction based on previous 

transactions for that vendor. QuickBooks remembers all your 

recent transactions for a vendor, not just the most recent one. 

If you consistently use the same account for a vendor, 

QuickBooks will automatically pre-fill that information any 

time you select the vendor in a bill, cheque, or credit card 

transaction.  

8. Press Tab to accept Printing & Reproduction as the account.  

9. In the Tax field, select S and then press Tab. 

10. Type 1450 to record the actual cost for this item.  

11. Click in the Account column below Printing & Reproduction. 

12. From the drop-down list, choose Freight/Shipping, and then press Tab. In the Tax field select G. Press Tab, 

confirm the amount field shows 50. 

Your screen should resemble the figure below.  

  

13. Click Save & Close to record the bill.  

When you record the transaction, QuickBooks creates a journal entry.  
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The following table shows the journal entry for the bill.  

 

 

 

 

 

9.8 Paying bills  
When you start QuickBooks or open a QuickBooks company file, you can have a Reminders window 

appear that tells you whether you have transactions to complete, such as bills to pay or money to 

deposit.  

Tip:  If you don’t see the Reminders window when you start 

QuickBooks, you can turn it on by choosing Preferences from the 

Edit menu. Click Reminders, click the My Preferences tab, and 

select “Show Reminders List when opening a Company file.”  

When QuickBooks tells you that you have bills due, you can display the Pay Bills window and select 

the bills you want to pay.  

To pay a bill:  

1. From the Vendors menu, choose Pay Bills. 

 QuickBooks displays the Pay Bills window. 

Account Title  Debit  Credit  

Accounts Payable   $1,676.50  

Printing & Reproduction  

Freight/Shipping 

GST Paid on Purchases 

$1,551.50 

$50.00  

$75.00 
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You can enter bills and vendor credits directly in your accounts payable 

(A/P) register instead of using the Enter Bills window to create the 

transactions. One benefit to using the register is speed: You can work 

more quickly in a register than you can if you fill out a separate bill for 

each transaction. And, since the register shows you all the transactions in 

the account to date (not just one transaction at a time), you have a better 

record of the entire account. 
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 The Pay Bills window shows your unpaid bills as of any date you enter. You can pay by cheque, 

credit card, or with an online payment (if you are set up to make online payments).  

For this exercise, you’ll pay a bill using a QuickBooks cheque (rather than a  

handwritten one). 

2. Select the “To be printed” option. By selecting this option, you are telling QuickBooks that you 

will print this cheque later.  

3. Select the Willis Advertising bill by clicking in the column to the left of the bill.  

 QuickBooks displays a checkmark next to the bill and changes the amount in the Ending Balance 

to reflect a payment of $1,676.50. If you want to make a partial payment, you can enter the 

amount you want to pay in the Amt. To Pay column.  

 Your screen should resemble the figure below. Make sure that your dates match the previous 

screen shot. 



167 |  P a g e
 

 

4. Click Pay Selected Bills.  

QuickBooks displays a summary of your bill payments.  

 

5. You could print the cheque at this point, but for this exercise, click Done.  

9.8.1 How QuickBooks records your bill payment  

When you pay a bill through the Pay Bills window, QuickBooks makes an entry in the accounts 

payable register, showing a decrease of $1,676.50 in the total payables. It also creates a cheque from 

your chequing account to pay the bill.  
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9.8.1.1 To see the entry in the accounts payable register:  

1. From the Company menu, choose Chart of Accounts. 

QuickBooks displays the chart of accounts. 

2. In the chart of accounts, double-click the Accounts Payable account.  

QuickBooks displays the accounts payable register.  

 

The register now shows the bill payment to Willis Advertising.  

3. Close the Accounts Payable register.  

At the same time QuickBooks recorded the entry in your accounts payable register, it made an entry in 

your Chequing account.  

9.8.1.1.1 To see the entry: 

1. In the chart of accounts, double-click Chequing.  

QuickBooks displays the Chequing account register.  

 

 Notice that the last entry in the register is the cheque for the payment to Willis Advertising.  
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2. Select the Willis Advertising transaction.  

3. On the toolbar, click Edit Transaction. 

 QuickBooks displays the Bill Payments (Cheque) window. 

 

 This cheque is called a “Bill Payment Cheque” and differs from the cheque form that you use to 

enter cheques directly into the chequing account. (That form shows expenses directly on the 

cheque voucher portion, while the bill payment form shows the bills paid by the cheque.)  

4. From the Window menu, choose Close All to close all the open QuickBooks windows.  

5. Click Home in the icon bar to open the Home page.  
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The Unpaid Bills Detail report lists the unpaid bills in accounts payable 

grouped by vendor. If a bill is overdue, the Aging column shows the 

number of days past due. (To create this report, from the Reports menu, 

choose Vendors & Payables, and then choose Unpaid Bills Detail. If 

necessary change dates to “Next Fiscal Year.”) 

The A/P Aging Summary report summarizes the status of unpaid bills in 

accounts payable. For each vendor to whom your company owes money, 

the report shows (1) what your company owes for the current billing 

period, and (2) what your company still owes from the previous billing 

periods. The 1-30, 31-60, 61-90, and >90 columns show overdue 

balances from previous billing periods. For example, an amount in the 

31-60 column is between 31 and 60 days overdue. (To create this report, 

choose Vendors & Payables from the Reports menu, and then choose 

A/P Aging Summary.) 

 

  

9.8.2 Applying vendor discounts to bill payments  

If you take advantage of discounts for early payment offered by some vendors, you can record the 

discounts directly in the Pay Bills window. You can set up QuickBooks to track the discount amounts.  
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In this section, you’ll apply a discount for early payment to one of White Ridge Construction’s 

vendors.  

9.8.2.1 To apply a discount for early payment:  

1. On the Home page, in the Vendors section, click Pay Bills. 

QuickBooks displays the Pay Bills window. 

2. In the Show bills area, select “Show all bills”, if not already selected, and press Tab.  

QuickBooks displays all of White Ridge Construction’s bills due.  

3. From the Sort By drop-down list, choose Discount Date, if not already selected. 

Since we are paying a bill early to take advantage of the discount, select 12/14/2010 as the 

payment date. 

4. Click to put a checkmark next to the bill for Blitz Marketing with a due date of 01/04/2015.  

QuickBooks displays the discount and credit information for Blitz Marketing.  

5. Click Set Discount.  

QuickBooks displays the Credits window prefilled with information about White Ridge’s terms 

with Blitz Marketing, and the amount of the discount based on those terms (in this case, two 

percent of $850.00 (the pretax amount), or $17.00).  

 

6. From the Discount Account drop-down list, choose Vendor Discounts (to track the discount 

amount).  
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7. Click Done.  

Note:  You can set up QuickBooks to always use discounts 

and credits from vendors. If you always track 

discounts from vendors in the same account, you can 

set up a default account. From the Edit menu, choose 

Preferences. Click Bills, and then click the Company 

Preferences tab. Select the “Automatically use 

discounts and credits” checkbox and choose the 

account in which you want QuickBooks to track the 

discounts you receive from vendors. 

8. Click Pay Selected Bills. 

 

9. In the Payment Summary window click Done. 
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10 Lesson 9: Analyzing Financial Data 

10.1 Lesson objectives  
 To discuss some of the tools QuickBooks gives you for analyzing financial data: QuickReports, 

preset reports, and graphs  

 To create a QuickReport  

 To add a column to a report  

 To learn how to move a column in a report  

 To learn about the types of preset reports QuickBooks offers  

 To practice creating reports and viewing them onscreen  

 To customize a report by changing how it looks and the data it covers (filtering)  

 To learn how to process reports in batches  

 To save reports as Portable Document Format (PDF) files  

 To learn how to export a report to Microsoft Excel  

 To practice filtering reports in Microsoft Excel  

 To learn about the types of graphs QuickBooks offers  

 To create and customize several graphs  

10.2 Supporting materials  

 PowerPoint file: Lesson 9  

10.3 Instructor preparation  

 Review this lesson, including the examples, to make sure you’re familiar with the material.  

 Ensure that all students have a copy of qblesson.qbb on their computer’s hard disk.  

10.4 To start this lesson  

Before you perform the following steps, make sure you have installed the exercise file (qblesson.qbb) 

on your hard disk. See “Installing the exercise file” in the Introduction to this guide if you haven’t 

installed it.  

The following steps restore the exercise file to its original state so that the data in the file matches what 

you see on the screen as you proceed through each lesson.  
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10.4.1 To restore the exercise file (qblesson.qbb):  

1. From the File menu in QuickBooks, choose Open or Restore Company. QuickBooks displays 

the Open or Restore Company window.  

2. Select Restore a backup copy and click Next.  

3. Select Local backup and click Next.  

4. In the Open Backup Copy window, navigate to your C:\QBtrain directory.  

5. Select the qblesson.qbb file, and then click Open.  

6. In the Open or Restore Company window, click Next.  

7. Navigate to your C:\QBtrain directory.  

8. In the File name field of the Save Company File as window, type lesson 9 and then click 

Save.  

9. Click OK when you see the message that the file has been successfully restored.  

10.5 Reports and graphs help you understand your business  

So far, you’ve been learning ways to track your data in QuickBooks. In this lesson, you’ll work with 

two of the most valuable tools in QuickBooks: reports and graphs. Reports and graphs give you insight 

into your finances; they’re two of the most important benefits of tracking your data in QuickBooks.  

Often, people’s perceptions of their business profitability don’t match the facts. If you enter your data 

in QuickBooks, but don’t take the time to analyze the data, your business decisions are based on 

incomplete knowledge. Reports let you summarize your financial data so you make decisions based on 

analysis of the numbers.  

Reports give you the bottom line—you can see exactly how profitable your business is. If it’s not 

doing as well as you’d hoped, you can create reports that show you which areas need improvement. 

QuickBooks has dozens of preset reports, but if you have specific reporting needs, you can customize 

any QuickBooks report to show exactly the data you want. And if you’re interested in getting quick 

information, you can use a QuickReport that lets you summarize information from your lists, forms, or 

registers with one click of a button.  

Some people find it easier to see a visual picture of their financial data. If you’re interested in learning 

more about trends or patterns in your business data (for example, what proportion of your income 

comes from consulting services as compared to product sales), QuickBooks offers six types of 

QuickInsight graphs.  

 

Note:  Some versions of QuickBooks include additional reports that 

are not available in all other versions. 
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10.6 Creating QuickReports  

One of the fastest ways to see a report on your QuickBooks data is to create a QuickReport. 

QuickReports are predesigned reports that give you information about the items you’re currently 

viewing on screen. Whenever you have a list, a register, or a form displayed, you can click a button to 

have QuickBooks create a QuickReport.  

10.6.1 When to use a QuickReport  

Suppose you’re viewing the Vendors list, and you want to see a history of all transactions for a certain 

vendor. Select the vendor’s name, click the Report menu button, and then select QuickReport. You’ll 

see a report listing information about each bill for that vendor.  

Suppose that White Ridge Construction wants to see what it owes to Barata’s Building Supplies.  

10.6.1.1 To see what you owe a vendor:  

1. Click Vendor Centre on the icon bar. 

 QuickBooks displays the Vendor Centre. If necessary, select the appropriate fiscal to ensure that 

2014 dates are shown. 

 

2. Select Barata’s Building Supplies.  

3. In the Reports for this Vendor section, click the QuickReport link.  

Note: If you want to see only unpaid bills and unapplied credits for the selected 

vendor, click the Open Balance link in the Reports for this Vendor section.  
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4. Choose the dates for your QuickReport. 

 

 A Vendor QuickReport shows all transactions for this date range for the selected vendor, Barata’s 

Building Supplies. The transactions shown can include purchase orders, item receipts, bills, bill 

payments, and credits received from the vendor.  

5. Leave the report open; you will use it in the next exercise. 

10.6.2 Zooming in on a QuickReport  

All QuickReports contain a summary of individual transactions. To help you better understand the 

information presented in reports, QuickBooks lets you trace report data to the individual transaction 

level using QuickZoom.  

When you position the mouse pointer over a number in a report and you see the QuickZoom symbol 

 (a magnifying glass with a Z in it), you can double-click the number to display the original 

transaction in QuickBooks.  

Suppose you want more detail about the item receipt shown in the report. (You use an item receipt in 

QuickBooks when you want to record that you’ve received inventory items, but you haven’t yet 

received a bill.)  

10.6.2.1 To see more detail about an item:  

1. Position the mouse pointer over the partial receipt dated 11/30/2014. The arrow pointer turns 

into a magnifying glass with the letter Z (z for zoom).  

2. Double-click the partial receipt.  

 QuickBooks displays the Enter Bills window for the selected transaction. 
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3. Click Save & Close to close the window.  

 QuickBooks returns you to the QuickReport.  

10.6.3 Customizing QuickReports  

Each QuickReport window has a button bar at the top of the report for customizing report content and 

layout.  

 

In this exercise, you’ll customize the QuickReport you just created to display transaction numbers in 

the report.  

10.6.3.1 To add a column to a report:  

1. In the QuickReport window, click Customize Report.  

QuickBooks displays the Modify Report window.  
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 Use the Display tab of the Modify Report window to select the columns to include in the report 

and the date range of the report.  

2. In the Columns list, select Trans #.  

QuickBooks displays a checkmark next to Trans # to indicate that it’s selected.  

3. Click OK to accept the change. 

 QuickBooks displays the customized Vendor QuickReport. 

 

 Notice that the partial receipt from Barata’s Building Supplies is now listed as Transaction #239.  

Next, you’ll move the Trans # column to a new position in the report.  

10.6.3.1.1 To move a report column:  

1. Position your mouse pointer over the Trans # column that you added to the QuickReport. 

The mouse pointer changes shape to look like a hand.  

2. Hold down the left mouse button and drag the Trans # column to the right until you see an arrow 

appear between the Date Column and the Num column.  
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3. Release the mouse button.  

QuickBooks places the Trans # column between the Date column and the Num column.  

 

Next, you’ll use the QuickReport button bar to customize the report header.  

10.6.3.1.2 To change information in the report heading:  

1. In the QuickReport window, click Modify Report, and then click the Header/Footer tab.  

 

 On the Header/Footer tab, you can change the company name, report title and subtitle. Date and 

time prepared cannot be changed in this window, as they are picked up automatically as of the real 

date on your computer. You can also specify whether to print the header on all pages or on just the 

first page. The Header/Footer tab is the same for all QuickBooks reports.  

 Use this window to change the report title from Vendor QuickReport to Vendor History Report.  

2. In the Report Title field, highlight the text for “Vendor QuickReport,” and type Vendor History 

Report to replace the title.  

3. Click OK to close the Modify Report window. QuickBooks changes the title of the report and 

displays the new report.  
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4. Close the QuickReport window.  

5. Close the Vendor Centre.  

10.7 Creating and customizing preset reports  

In addition to QuickReports, QuickBooks has dozens of preset report formats. You can create profit 

and loss reports, balance sheet reports, accounts receivable reports, sales reports, accounts payable 

reports, inventory reports, and many other types of reports.  

The Reports Centre categorizes the preset reports into 17 major categories:  

Company & Financial reports include the following:  

 Profit and loss reports give you a global view of your company’s income, expenses, and net 

profit or loss over a specific period of time.  

 Income and Expense reports show the details for customers and vendors. 

 Balance sheet reports show the financial position of your business by listing assets, liabilities, 

and equity.  

 Statement of cash flows reports show the net change in your cash during a period of time.  

Sales Tax reports provide information you need to fill in your sales tax returns. 

Customers & Receivables (accounts receivable) reports give you information about the receivables 

side of your business: which invoices are due (or overdue), how much each customer owes your 

company, and so on.  

Sales reports give you information about what you have sold and to whom.  

Jobs, Time & Mileage reports give information about how well your company is doing at estimating 

jobs, how much time is spent on each job, and the mileage expenses for each vehicle or job.  

Vendors & Payables (accounts payable) reports give you information about the payables side of 

your business, including which bills are due, and your current balance with each vendor.  

Purchases reports give you information about your purchases.  

Inventory reports give you information about status (such as the quantities you have on hand or on 

order) and the value of your inventory.  

Employees & Payroll reports summarize the information you need to pay your current payroll 

liabilities and fill out your tax forms. QuickBooks has these payroll reports: summary, employee 

earnings, liabilities, item detail, transaction detail, and transactions by payee.  
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Banking reports include cheque detail, deposit detail, missing cheque reports, and reconciliation 

reports.  

Accountant & Taxes reports summarize information that you need to give to your accountant and 

information to help you monitor activity in the company file. These include income tax summary, 

income tax detail, general ledger, trial balance, journal, transaction journal, and audit trail reports.  

Budgets & Forecasts reports show how your income and expenses compare to the budgets you’ve set 

up.  

List reports let you report on any information stored in a QuickBooks list.  

Industry Specific reports are available in each of the industry-specific editions of QuickBooks. 

Accountant Edition includes the reports from all of the industry-specific editions. 

10.7.1 Using the Report Centre  

A good way to learn about the reports available in QuickBooks—and how to work with them—is the 

Report Centre, which is available by clicking Report Centre on the icon bar. If the Report icon is not 

displayed, the Report Centre can also be opened by selecting it from the Reports menu. 

 

The Report Centre contains a description and example of each QuickBooks report when you click . 

You can also add reports to the Favorites Tab when you click the button.  

10.7.2 Creating a profit & loss by job report  

The profit & loss by job report provides information on each customer job.  

10.7.2.1 To create a profit & loss by job report for White Ridge Construction:  

1. In the Report Centre, choose Company & Financial. Then choose by Job in the Profit & Loss 
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section.  

2. Choose Custom in the Dates field, in the From field type 10/01/2014, and  in the To field type 

12/31/2014. If necessary click Refresh.  

The report on your screen should resemble the following figure.  

 

3. Scroll the report window to see more of the report. Notice that the button bar at the top of the 

report is the same button bar you saw in the QuickReport window with the addition of a Collapse 

button.  

4. Click the Collapse button to see the difference.  

The Collapse button hides subaccounts, jobs, and subclasses. Amounts are summarized under the 

main heading. This button affects both the onscreen and printed report.  

5. Click Expand to return to the original report display.  

6. Keep the report displayed on your screen. You’ll use it in the next exercise.  

10.7.3 Modifying reports  

You can modify preset reports the same way you modify QuickReports. In this exercise you’ll 

customize the profit & loss by job report to display % of income for the period. 

1. Click the Customize Report button to bring up the Modify Report window. Make sure the 

Display tab is selected. 

2. In the “Add subcolumns for” area, click the % of Income button. 
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3. Click OK. 

Your screen should resemble the following. 

 

10.7.4 Filtering reports  

You can customize preset reports the same way you customize QuickReports. In this exercise you’ll 

customize the profit & loss by job report and filter it to include only the transactions you specify.  

Report filters let you set custom criteria for the transactions you want included in a report. When you 

filter a report, QuickBooks includes only those transactions that match the rules you create.  

10.7.4.1 To filter a preset report:  

1. With the profit & loss by job report displayed, click Customize Report on the report button bar, 

and then click the Filters tab.  

 QuickBooks displays the Filters tab of the Modify Report window.  
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Suppose you want to see only the cost-of-sales accounts on the comparison profit & loss. You can 

filter the report by account.  

2. In the Filter scroll box, make sure Account is selected.  

Notice that QuickBooks provides a description of the selected filter below the list of filters. If you 

need more information about how applying a particular filter will affect the report, click Tell me 

more.  

3. In the Account field, choose All cost-of-sales accounts from the drop-down list.  

4. Click OK.  

 QuickBooks displays the customized profit & loss comparison report.  

 

A comparison of the two previous reports shows how the latter displays only the Cost-of-sales 

accounts.  
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Some filters represent more than one thing. This may be a little 

confusing if you’ve never used report filters in QuickBooks before. Here 

are some tips on what to filter for: 

 Use “Item” to filter for any kind of line item that appears on a purchase order or 

sales form. These include goods and services, discounts, and sales tax. 

 Use “Name” to filter for customers, jobs, vendors, employees, or any name on 

your Other Names list. 

 Use “Transaction type” to filter for any type of transaction, including invoices, 

cash sales, statement charges, payments from customers, bank deposits, 

purchase orders, item receipts, bills, bill payments, credit card charges, 

cheques, paycheques, and general journal entries. 
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10.7.5 Saving Reports in PDF Format 

To keep a record of the information in the report as it exists today, you can save the report in Portable 

Document Format (PDF). 

10.7.5.1 To save a report as a PDF file: 

1. With the report open, choose Save as PDF from the File menu. 

2. Navigate to the folder in which you want to store the file, and enter a filename. 

3. Click Save. 

4. Close the report window.  

5. Click No when QuickBooks asks if you want to add this report to the Memorized Report List.  

6. Go to the Window menu and choose Close All. 

7. Click Home in the icon bar. 

10.7.6 Creating and customizing a sales report  

In this exercise, you’ll create a QuickBooks sales report, which you will then customize by changing 

the date range it covers.  

10.7.6.1 To create a sales report:  

1. From the Reports menu, choose Sales, and then choose Sales By Customer Summary from the 

submenu.  

QuickBooks displays the Sales by Customer Summary report.  

 

The Dates field in the report button bar shows that the report covers “This Month-to-date.” 

Depending on just when you are proceeding with this exercise, the report will show the current 

date. Customize the report so you can see sales figures from December 2014.  

10.7.6.1.1 To customize a report:  

1. In the Dates field, select Custom from the drop-down list.  

2. In the From field, enter 12/01/2014.  

3. In the To field, enter 12/31/2014 and press Tab.  

QuickBooks updates the report and displays the new data.  
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10.7.7 Using QuickZoom in a preset report 

As with all QuickBooks reports, you can QuickZoom any item in the report to see more detail.  

10.7.7.1 To QuickZoom on a report item:  

1. Position the mouse pointer over any number. 

 The arrow pointer turns into a magnifying glass with a Z in it.  

2. Double-click a number.  

QuickBooks displays a QuickZoom report showing sales by customer detail.  

 

10.7.7.1.1 To QuickZoom further to display the original invoice for a transaction:  

1. Position the mouse pointer over the first item on the report. 

2. Double-click anywhere in the first line.  

QuickBooks displays the Invoice. 
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3. From the Window menu, choose Close All. 

4. Click No when QuickBooks asks if you want to memorize the report.  

5. Click Home in the icon bar to display the Home page.  

What you see when you QuickZoom in a report depends on the type of report displayed:  

 If the report shows summary figures (like the sales by customer summary report we just 

displayed) and you QuickZoom an amount, QuickBooks displays a transaction report that 

includes the transactions which contribute to that amount.  

 If the report shows transactions and you QuickZoom a transaction, QuickBooks displays the 

invoice, bill, or other form for the requested transaction.  
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 You can widen or narrow columns on any type of QuickBooks report. To 

make a column wider, drag the small diamond at the right of the column 

header toward the right. To make a column narrower, drag the small 

diamond at the right of the column header toward the left. 

  

10.8 Saving report settings  

After you have customized a report to provide the information you need, you can have QuickBooks 

memorize the settings so you can quickly produce the same report in the future. (QuickBooks 

memorizes a report’s settings, not the actual data.)  

Note:  If you use one of the QuickBooks: Premier products, you can export 

the settings for memorized reports as report templates. A report 

template lets you specify all of a report’s settings in advance—for 

example, report date, format, and filters. Report templates can be 

imported into other QuickBooks data files and then accessed from the 

Memorized Report list. 
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10.8.1 Creating memorized report groups  

In addition to saving report settings, you can create memorized report groups that you can use to 

organize your memorized reports in a way that makes sense for your business and to allow you to 

quickly process a group of reports at once.  

QuickBooks comes preset with a number of memorized report groups each containing common reports 

for each area. You can add your own reports to these groups, modify the groups to meet your needs, 

and even create your own groups.  

In this exercise, you’ll create a memorized group called “Year End” to which you will add some 

memorized reports. Later, you learn how you can batch process memorized reports.  

10.8.1.1 To create a memorized report group:  

1. Choose Memorized Reports from the Reports menu, and then choose Memorized Report List.  

QuickBooks opens the Memorized Report list.  

 

Note:  Depending on which industry you have created your data file in, 

default memorized reports may differ from the list shown above. 

2. In the Memorized Report List, click the Memorized Report menu button, and choose New Group.  

3. In the Name field of the New Memorized Report Group window, type Year End.  

Your window should look like this.  

 

4. Click OK. 
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 QuickBooks adds the new group to the Memorized Report list. 

10.8.2 Memorizing preset reports  

Now, you’ll memorize a report and add it to the memorized report group you just created.  

10.8.2.1 To memorize a report: 

1. From the Reports menu, choose Accountant & Taxes, and then choose Income Tax Summary.  

When the report displays, choose Next Tax Year in the date field, press Tab. 

2. On the report button bar, click Memorize.  

QuickBooks displays the Memorize Report window.  

 

3. Leave the name of the report as is. 

4. Click the “Save in Memorized Report Group” checkbox to select it, and then choose Year End 

from the drop-down list.  

Your window should look like this.  

 

5. Click OK to memorize the report and add it to the Year End memorized report group.  

6. Close the Income Tax Summary report.  

 The report now appears in the Memorized Report List under Year End. 

10.8.3 Adding reports to memorized report groups  

Now, you’ll add two previously memorized reports to the Year End group.  

10.8.3.1 To add memorized reports to a memorized report group:  

1. In the Memorized Report List window, under Company, select the report called Profit & Loss Year 

End. 

2. Click the Memorized Report menu button, and then choose Edit Memorized Report. 

 QuickBooks opens the Edit Memorized Report window.  



189 |  P a g e
 

3. Leave the report name as is. 

4. If necessary, click the “Save in Memorized Report Group” checkbox to select it, and then choose 

Year End from the drop-down list. 

5. Click OK.  

QuickBooks moves the Profit & Loss Year End report to the Year End memorized report group.  

 

6. In the Memorized Report List window, under Company, select the Balance Sheet Year End report. 

7. Click the Memorized Report menu button, and then choose Edit Memorized Report.  

8. Leave the report name as is. 

9. If necessary, click the “Save in Memorized Report Group” checkbox to select it, and then choose 

Year End from the drop-down list.  

10. Click OK.  

Once a report is memorized, you can easily display it from the QuickBooks Memorized Report List.  

10.8.3.1.1 To display a memorized report: 

1. In the Memorized Report List, select “Balance Sheet Year End.” 

2. Click Display. 

 QuickBooks displays the report.  

3. Leave the report open.  

10.9 Printing reports  

Any time you have a report displayed in the report window, you can print it by clicking the Print 

button in the report button bar.  
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10.9.1 To print a report:  

1. With the Balance Sheet Year End report displayed, click Print.  

QuickBooks displays the Print Reports window.  

 

 In the Print Reports window you can select the print orientation and tell QuickBooks where you 

would like the pages to break in multi-page reports.  

2. Click Preview to see how the report will look when you print it.  

QuickBooks displays a preview of your report onscreen.  

3. Click Close to close the Print Preview window.  

4. Close the Print Reports window, and then close the report.  

10.9.2 Processing reports in groups  

Organizing your memorized reports in groups makes it fast and easy to process several reports at once. 

Now, you’ll process the reports you added to the Year End report group you created in the previous 

exercise.  

10.9.2.1 To batch process reports:  

1. In the Memorized Report List, select Year End.  

2. Click Display.  

 QuickBooks opens the Process Multiple Reports window. You can use this window to display or 

print the selected reports. You can also change the date range for reports in this window before 

you display or print them by clicking in the From or To columns.  
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3. Leave all three reports selected and click Display.  

 QuickBooks opens the three reports in the Year End group in a cascaded list. Click on the title bar 

of each report to display it for viewing.  

4. From the Window menu, choose Close All. Click Home in the icon bar to display the Home page. 

10.10 Exporting reports to Microsoft Excel  

Occasionally, you may want to change a report’s appearance or contents in ways that aren’t available 

in QuickBooks, filter report data in ways that you can’t in QuickBooks, or run “what-if” scenarios on 

your QuickBooks data.  

You can send reports from QuickBooks to Microsoft Excel. Since the changes you make in Excel 

don’t affect your QuickBooks data, you’re free to customize reports as needed and even change data to 

run what-if scenarios.  

Note:  To proceed with this exercise, you need Microsoft Excel 2003, 

2007, 2010 or higher. 

10.10.1 Sending a report to Microsoft Excel  

When exporting a report to Microsoft Excel, you indicate whether or not you want to preserve the 

formatting from your QuickBooks report. You also have the option of turning on or off several Excel 

features from within QuickBooks.  

By default, QuickBooks preserves the look of your report when exporting to Microsoft Excel, and 

turns on the following Excel features:  

 AutoFit sets column widths in Excel wide enough to display your data without cutting off 

words or numbers.  

 Freeze panes allows you to scroll through data while keeping the row and column headers in 

view.  

 Show Gridlines turns on gridlines in Excel.  

In this exercise, you learn how to select which QuickBooks report formatting options you want to 

preserve in Excel, and how to turn on and off certain Excel features from within QuickBooks.  
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10.10.1.1 To send a report to Microsoft Excel:  

1. From the Reports menu, choose Company & Financial, and then choose Profit & Loss Standard. 

2. In the Dates Field select Custom, in the From field type 10/01/2014, and in the To field type 

12/31/2014.  

3. On the Report button bar click Customize Report. 

 QuickBooks displays the Modify Report window. 

4. In the “Add subcolumns for” area, click the Previous Period checkbox, and then click the $ 

Change and % Change checkboxes.  

 Your screen should resemble the following.  

 

5. Click OK. 

 

6. On the Report button bar, click Excel, then click Create New Worksheet.  
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QuickBooks displays the Export Report window.  

 

7. Select “in new workbook”. 

 If desired, you can also send the report to a new sheet in an existing Excel workbook, or to a 

comma separated value (.csv) file.  You can also send the data to an existing worksheet or replace 

an existing worksheet. 

8. Click the Advanced button.  

9. Under Formatting options, click the Colours checkbox to clear it.  

 The title font will remain blue in QuickBooks, but display in black in Excel.  

10. In the Advanced Excel Options window, select the Auto Filtering checkbox.  

Your screen should now resemble the following.  
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11. Click OK. 

12. Click Export 

 QuickBooks starts Excel (if it’s not running already) and sends the report to a new spreadsheet. 

 

 If you wanted to save the report, you would choose Save from within Excel. 
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11 Lesson 10: Setting up QuickBooks Inventory 

11.1 Lesson objectives  

 To get an overview of inventory in QuickBooks 

 To practice filling out a purchase order for inventory items 

 To track the receipt of the inventory items in QuickBooks 

 To adjust inventory manually, to enter a stock loss or increase 

 To create, build, and edit inventory assemblies (finished goods) (QuickBooks: Premier or 

higher) 

 To set up and use units of measure  

11.2 Supporting materials  

 Handout 5: Inventory workflow 

 Handout 6: Group vs. inventory assembly items 

 PowerPoint file: Lesson 10 

11.3 Instructor preparation  

 Review this lesson, including the examples, to make sure you’re familiar with the material. 

 Ensure that all students have a copy of qblesson.qbb on their computer’s hard disk. 

 Have handouts 5 and 6 ready for distribution.  

11.4 To start this lesson  

Before you perform the following steps, make sure you have installed the exercise file (qblesson.qbb) 

on your hard disk. See “Installing the exercise file” in the Introduction to this guide if you haven’t 

installed it.  

The following steps restore the exercise file to its original state so that the data in the file matches what 

you see on the screen as you proceed through each lesson.  

11.4.1 To restore the exercise file (qblesson.qbb):  

1. From the File menu in QuickBooks, choose Open or Restore Company. QuickBooks displays 

the Open or Restore Company window.  

2. Select Restore a backup copy and click Next. 

3. Select Local backup and click Next.  

4. In the Open Backup Copy window, navigate to your C:\QBtrain directory.  

5. Select the qblesson.qbb file, and then click Open.  

6. In the Open or Restore Company window, click Next.  

7. Navigate to your C:\QBtrain directory.  
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8. In the File name field of the Save Company File as window, type lesson 10 and then click 

Save.  

9. Click OK when you see the message that the file has been successfully restored.  

11.5 Turning on the inventory feature  

The QuickBooks inventory feature is turned on in your exercise file, but you’ll review how to turn on 

this feature so you become familiar with QuickBooks preferences. If you need to track inventory for 

your company, you can turn the feature on while completing the EasyStep Interview. If you want to 

turn on the inventory feature after you’ve completed the EasyStep Interview, follow this procedure.  

11.5.1 To turn on the inventory feature:  

1. From the Edit menu, choose Preferences.  

2. Select Items & Inventory from the left panel.  

3. Click the Company Preferences tab.  

Note:  Only the QuickBooks Administrator can change company 

preferences. 

4. Click the “Inventory and purchase orders are active” checkbox to select it. A checkmark 

shows that the inventory feature is turned on.  

5. Click OK.  

11.6 Entering products into inventory  

QuickBooks uses the average cost method to determine the value of inventory (rather than another 

method such as FIFO or LIFO). The average cost of an inventory item equals the total cost of the items 

currently in stock, divided by the number in stock.  

Many small businesses that stock inventory don’t know the number of units they have on hand or on 

order at any given time, and have no way of getting that information quickly. Using QuickBooks to 

manage your inventory, you’ll be able to track the number of items in stock and the value of your 

inventory after every purchase and sale. As you order inventory items, receive the items, and later sell 

the items from inventory, QuickBooks tracks each inventory-related transaction. You will know the 

status of your inventory and will have a more accurate picture of your business’s assets.  

Refer to the diagram on Handout 5, “Inventory workflow” for the following discussion.  

To track inventory, you must enter each product into the Item list as an inventory part. Once you enter 

a product, QuickBooks tracks it as you sell or reorder the product.  

11.6.1 To enter a product into inventory:  

1. From the Vendors menu, choose Item List.  

QuickBooks displays the Item list.  

2. Click the Item menu button, and then choose New. QuickBooks displays the New Item window. 
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You’ll enter one new item into your inventory. 

3. In the Type field, choose Inventory Part from the drop-down list. 

 QuickBooks changes the New Item window to accept information for an inventory part.  

 

4. In the Item Name/Number field, type Cab 2015 (2015 is the style number).  

5. Select the “Subitem of” checkbox, and then choose Materials Heading:Cabinets from the drop-

down list. 

Note:  You can use the Manufacturer’s Part Number field 

to specify the part number the manufacturer uses. 

This can simplify reordering. 

6. In the “Description on Purchase Transactions” field, type Kitchen Cabinet #2015, and then press 

Tab to move to the Cost field.  

 Notice that QuickBooks fills in the Description on Sales Transactions field with the same 

description you entered for the purchase side. You can leave the sales description the same or 

change it later.  

7. In the Cost field, type 169. 

8. In the Purchase Tax Code field, type G.  

9. In the Preferred Vendor field, choose Barata’s Building Supplies from the drop-down list. Or, type 

the first few letters of your selection and QuickBooks fills in the rest.  

10. In the Sales Price field, type 225.  

11. In the Tax Code field type G. 

12. In the Income Account field, choose Construction Income.  



198 |  P a g e
 

13. Press Tab to move to the Asset Account field.  

 Inventory Asset was filled in when you selected Inventory Part as the type of item. Leave this 

default setting.  

14. In the Reorder Point field, type 15.  

 The Reorder Point is the minimum quantity of a particular inventory item that you want to have in 

stock at any given time. When the quantity reaches the reorder point, it's time to order more of the 

item. By using your Reminders list, you can have QuickBooks remind you when it's time to 

reorder a particular item.  

15. In the On Hand field, type 20, and then press Tab to move to the Total Value field.  

 Notice that QuickBooks has calculated the value of your item by multiplying the number in the On 

Hand field by the number in the Cost field. 

 Your New Item window should resemble the following figure. 

 

16. Click OK to close the New Item window.  

QuickBooks adds the new item to the Item list. 

17. Close the Item list.  

 When you record the transaction, QuickBooks creates a journal entry. The following table shows 

the journal entry for the inventory item.  

Account Title  Debit Credit 

Opening Bal Equity   $3,380.00  

 Inventory Asset  $3,380.00   

  



199 |  P a g e
 

Q
u
ic

k
S
ta

rt
 

T
ip

 

When you want to check on the status of your inventory stock, you can 

create a stock status by item report. For every item in your inventory 

stock, the report gives you the reorder point, the current quantity on 

hand, the average cost to date, the quantity on order (and expected date 

of receipt), and the average sales per week. 

  

11.7 Ordering products  

Once you enter your current products and vendors into the Item and Vendor lists, you’ll need to order 

products to keep your inventory stocked.  

QuickBooks doesn’t require you to use purchase orders, but you may want to recommend their use for 

students who track inventory. Using purchase orders lets you see items you have on order and when 

they’re due to be received. You can also check items you receive against the PO.  

If students don’t order items in advance or don’t want to use purchase orders, they can buy inventory 

directly by entering a bill, writing a cheque or entering a credit card transaction.  

11.7.1 Creating purchase orders  

When you order items from a vendor, you create a purchase order.  

11.7.1.1 To order a product using a purchase order: 

1. From the Vendors menu, choose Create Purchase Orders. 

 QuickBooks displays the Create Purchase Orders window.  

 

 You use the Create Purchase Orders window to enter the products you wish to order, the 

quantities, and the vendor. As you fill in this information, QuickBooks automatically calculates 

purchase order number, item cost, and total cost.  

 Notice that QuickBooks has already entered today’s date and a sequential purchase order number.  
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2. In the Vendor field, choose Barata’s Building Supplies from the drop-down list.  

 Notice that QuickBooks displays all of the information about Barata’s Building Supplies in the 

appropriate places on the purchase order form.  

3. In the Item column, select Exterior Materials Heading:Exterior Frame from the drop-down list.  

4. In the Qty field, type 10.  

5. In the Vendor Message field of the purchase order, type Please rush ship this order.  

Your Purchase Order should resemble the following figure.  

 

6. Click Save & Close to record the purchase order.  

After you have created a purchase order, QuickBooks adds an account to the chart of accounts called 

Purchase Orders. This is a non-posting account and does not affect your balance sheet or income 

statement. The Purchase Orders account is used to produce a QuickReport showing current purchase 

orders so you always know what is on order.  

11.7.2 Getting a report of purchase orders  

11.7.2.1 To get a chronologically ordered report of all the purchase orders you  
have written:  

1. From the Reports menu, choose Purchases.  

2. Click Open Purchase Orders. 

 QuickBooks displays a report of all open purchase orders. Choose the appropriate. 
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Notice the purchase order you have just created is at the bottom of the report.  

3. Close the Open Purchase Order report.  

11.8 Receiving inventory  

When you receive the items you have ordered with your purchase order, you have to enter the items 

into inventory. You can receive items with a bill or without a bill.  

This exercise shows you how to enter into QuickBooks inventory items you’ve received when the bill 

for those items will follow later.  

11.8.1 To receive inventory without a bill attached:  

1. From the Vendors menu, choose Receive Items.  

 QuickBooks displays the Create Item Receipts window.  

 

 The Create Item Receipts window lets you enter information for inventory parts you’ve received.  
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2. In the Vendor field, choose Barata’s Building Supplies from the drop-down list and press Tab. 

 QuickBooks tells you that there are open purchase orders for this vendor and asks if you wish to 

receive against one of these orders. 

3. Click Yes.  

QuickBooks displays the Open Purchase Orders for Barata’s Building Supplies.  

 

4. Click the purchase order (#10, dated 12/31/2014) to select it.  

 QuickBooks places a checkmark in the left-most column for the item selected.  

5. Click OK to move the information to the item receipt. 

 The Create Item Receipts window should resemble the following figure. 

 

6. Click Save & Close to process the receipt. 

 QuickBooks processes the items and adds them to your inventory. If you display the Item list, 

you’ll see that you now have 10 additional door frames on hand. 



203 |  P a g e
 

11.9 Entering a bill for inventory  

If you've entered an item receipt for inventory, but the bill hasn't arrived yet, you can still record the 

bill amount in QuickBooks. Entering the bill as shown in this exercise records the amount in your 

accounts payable account so you can track how much you owe.  

When the bill comes, you pay the bill just like you would pay any other bill in QuickBooks (from the 

Pay Bills window).  

11.9.1 To enter the bill:  

1. From the Vendors menu, choose Enter Bill for Received Items.  

 QuickBooks displays the Select Item Receipt window, where you can select the vendor and the 

item for which you have a bill.  

 

2. In the Vendor field, select Barata’s Building Supplies in the drop-down list and press Tab. 

 QuickBooks fills in the Date and Memo fields with information that corresponds to your bill. 

3. Select “Received items (bill to follow),” dated 12/31/2014.  

 

4. Click OK. 

 QuickBooks displays the Enter Bills window. 
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5. Click Save & Close.  

6. If necessary, click Yes in the Recording Transaction window. 

 QuickBooks changes the item receipt to a bill in the Accounts Payable account and lists the bill in 

the Pay Bills window. If you look at the Accounts Payable, you’ll see that the balance increased 

by $1364.48, based on the bill entered for Barata’s Building Supplies. 

 Because you must have inventory on hand before you can enter a sale for inventory parts, we 

recommend that you enter your item receipts before entering sales.  

When you record the transaction, QuickBooks creates a journal entry. The following table shows the 

journal entry for the bill payment.  

Account Title  Debit Credit 

Accounts Payable   $1364.48  

 Inventory Asset  $1299.50   

 GST Payable $64.98  
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11.10 Manually adjusting inventory  
When you have spoilage or send out samples of your products, you can adjust your inventory 

manually.  

11.10.1 To adjust the inventory manually:  

1. On the Home page, in the Company area click Inventory Activities and then choose Adjust 

Quantity/Value on Hand.  

 QuickBooks displays the Adjust Quantity/Value on Hand window.  

 

 The Adjust Quantity/Value on Hand window lets you enter the adjustment account, and either the 

New Qty or the Qty Difference. 

 Since two wood interior doors were damaged, you’ll adjust the inventory account to remove two 

doors. 

You may want to point out to students that they can also adjust inventory value without affecting 

quantities by selecting the Value Adjustment checkbox.  

2. In the Adjustment Account field, type Inventory Adjustment and press Tab.  

3. In the Qty Difference column for Materials-Heading:Wood Door: Interior Wood Door, type –2 

(the number of damaged doors), and then press Tab. 

 QuickBooks calculates the value adjustment and decreases the inventory by two items. 
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4. Click Save & Close.  

 When you record the transaction, QuickBooks creates a journal entry. The following table shows 

the journal entry for the inventory adjustment.  

Account Title  Debit Credit 

Inventory Asset   $159.90  

 Inventory Adjustment  $159.90   
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The inventory valuation reports in QuickBooks break down the value of your 

inventory and give you several statistical measures of its value. The valuation 

summary report shows the quantity on hand, average cost, asset value, % of total 

asset value, retail value, and % of total retail value for each of your inventory 

items. The valuation detail report lists the opening balance, ending balance, and 

every transaction (purchase or sale) that has affected the inventory value of each 

inventory item during the period of time covered by the report. 

 

  

11.11 Tracking finished goods  

QuickBooks: Premier products let you track the building and sale of finished goods using assembly 

items. When you define assembly items, you tell QuickBooks how many of each inventory item is 

needed to create the finished product.  

Inventory assembly items allow you to create an item that contains assembled material units (finished 

goods) you buy or produce, track as inventory, and resell. You can keep track of how many items 

remain in stock after a sale, how many items you have on order, your cost of goods sold, and the value 

of your inventory. Note that inventory assembly items in QuickBooks are appropriate for indicating 

“light” assembled items on sales forms and in reports. QuickBooks does not track inventory 

throughout a manufacturing process.  
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You must have a QuickBooks: Premier product to create and build inventory assembly items. 

Afterwards, you can use QuickBooks to view, sell, and report on existing assembly items.  

11.11.1 Deciding whether to use group items or create inventory assemblies  

Both group items and inventory assembly items record a group of items as a single entry on purchase 

or sales forms in QuickBooks. (Group items are available in QuickBooks: Pro and higher editions.)  

Refer to Handout 6, “Group vs. inventory assembly items” for more information about choosing 

between group and inventory assembly items.  

11.11.1.1 Using group items  

Group items are useful for quickly entering a group of individual items that you've already set up as 

single items on your list and often sell together.  

Group items let you track the items you sell in greater detail. For example, a construction firm that 

remodels houses could set up a group item that lists the significant components of a remodeling job: 

lumber, carpentry hours, markup, etc. Sales reports for the company would then show income broken 

down by each component instead of a single lump sum for all remodeling jobs.  

If you need to track a lot of detail about your items but you also want to give your customers simple, 

uncluttered invoices, you can use group items to do both. You can set up a group item so that the 

printed version of an invoice reduces a group item to a single line item and one amount. Yet when you 

view the invoice on your screen, you see a separate line entry and amount for each item in the group.  

Group items also give you a way to enter a great amount of line item detail quickly. On a sales or 

purchase form, all you have to do is enter the name of the group item— QuickBooks fills in all the 

details about the items in the group for you.  

11.11.1.2 Using inventory assemblies  

When you build an assembly, an assembled unit is automatically added to quantity on hand and its 

component parts (inventory items or other assembly items) are automatically deducted from quantity 

on hand. By using assembly items, you always know how many assembled and component items you 

actually have in stock.  

You can specify a price for an assembly that's different than the sum of component items.  

You can easily access the date items were assembled, quantity and cost of assembled items, and a 

detailed bill of materials.  

You can set a build point and QuickBooks will automatically remind you to build finished goods when 

stock is running low. At build time, QuickBooks will notify you if you don't have enough component 

items in stock to build the specified number of assembly items.  

Note:  The ability to create inventory assemblies is available only in 

QuickBooks: Premier and higher. To proceed through this 

exercise, you must be using a QuickBooks: Premier or higher 

edition. 
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11.11.2 Setting a default markup  

With QuickBooks, you can add a markup to your basic costs by entering a default markup percentage. 

QuickBooks uses this percentage to calculate the sales price of items that have both a cost and a sales 

price.  

You'll see the effect of the default markup percentage when you create inventory part, non-inventory 

part, service, and other charge items. When you enter the item's cost, QuickBooks calculates the sales 

price and enters it in the Sales Price field. For example, entering a cost of $10.00 when the markup is 

25% causes QuickBooks to fill in the sales price as $12.50. If you don't want to use the default markup 

for an item, you can change the sales price that QuickBooks fills in.  

11.11.2.1 To set the default markup percentage: 

1. From the Edit menu, choose Preferences. 

2. Click Time & Expenses in the left panel. 

3. Click the Company Preferences tab. 

4. In the Default Markup Percentage field, type 20 and press Tab.  

5. In the Default Mark Account, select Mark Up Income. 

 Your screen should look like this:  

 

6. Click OK. 

You’ll see the effects of this markup percentage in the next exercise. 

11.11.3 Adding a labour item to use in assemblies  

Suppose you have plans to sell all the items needed for installing a door as a kit. You’ll also need to 

account for the labour needed to assemble the kit. To do this, you’ll create an “Assembly Labour” 

item.  
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11.11.3.1 To create a labour item to use in assemblies:  

1. From the Lists menu, choose Item List.  

2. Click the Item menu button and select New. 

QuickBooks displays the New Item window. 

3. In the Type field, select Service.  

4. In the Item Name/Number field, type Assembly Labour.  

5. Click the checkbox for “This service is used in assemblies or is performed by a subcontractor or partner.”  

 The New Item window expands so you can enter details that will be used for this item in both 

sales and purchase transactions.  

 

6. In the Description on Purchase Transactions field, type Direct Labour, and then press Tab.  

7. In the Cost field, type 20, and then press Tab.  

QuickBooks automatically enters the Sales Price based on the 20% markup you set in the Company 

preferences.  

8. In the Purchase Tax Code, and the Tax Code fields type G. 

9. From the Expense Account drop-down list, choose Payroll Expenses.  

10. From the Income Account drop-down list, choose Construction Income. 

 Your screen should look like this:  
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11. Click OK.  

11.11.4 Creating inventory assembly items  

Creating assembly items in QuickBooks is a two-part process: first you define an assembly item, and 

then you build the assembly. Assembly item units are not added to inventory and assembly 

components (inventory parts or other assemblies) are not deducted from inventory until you build the 

assembly.  

Inventory assembly items can include inventory part and other assembly items. You can also include 

the costs associated with building the assembly item by adding non-inventory part items, service items, 

and other charge items to the Bill of Materials.  

All items included in an inventory assembly item must be defined in the Item list. You can define them 

before you create the inventory assembly item, or as you create the assembly item.  

In addition to selling individual items, White Ridge sells pre-assembled exterior door kits. In this 

exercise, you define the assembly item for the exterior door kits. All of the component items are 

already defined in the Item list.  

11.11.4.1 To create an inventory assembly item:  

1. In the Item List, click the Item menu button and select New.  

QuickBooks displays the New Item window.  

2. In the Type field, select Inventory Assembly.  

3. In the Item Name/Number field, type Exterior Door Kit.  

4. Type 335.82 in the Cost field, and then press Tab twice.  
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 QuickBooks calculates the Sales price based on the cost you enter in this field and the default 

markup percentage as set in the company preferences. Leave the COGS Account as is.  

5. In the Description field, type Complete exterior door kit and press Tab.  

6. Verify “S” is shown in the tax code field. 

 The New Item window should resemble the following graphic.  

 

 QuickBooks allows you to set any price for assembled items; the price is independent of the sales 

price of the component items. You could change this amount if you wanted. 

 The Sales Price reflects the cost plus the 20% markup you entered in preferences, so leave it as is. 

 In addition, the tax code for the assembled item and the component parts can be different. 

7. In the Income Account field, select Construction Income from the drop-down list.  

8. In the Bill of Materials section click in the Item column.  

9. In the Item drop-down list, select Exterior Material Heading:Exterior Frame.  

10. In the Qty field, type 1, and then press Tab.  

11. In the Item drop-down list, select Materials Heading:Hardware:Doorknobs Locking.  

12. In the Qty field, type 1, and then press Tab.  

13. In the Item drop-down list, select Materials Heading:Hardware:Brass Hinges.  

14. In the Qty field, type 3, and then press Tab.  

15. In the Item drop-down list, select Materials Heading:Wood Door:Exterior Door.  
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16. In the Qty field, type 1, and then press Tab.  

17. In the Item drop-down list, select Assembly Labour.  

18. In the Qty field, type 2, and then press Tab.  

 The New Item window should resemble the following graphic.  

 

19. Click OK to add the Assembly item to the Item list. 

 You can edit the Bill of Materials for an assembly item at any time. However, assembly revision 

history is not tracked; if you need to build a previous version of an assembly, you need to edit the 

assembly and reenter the original bill of materials.  

11.11.5 Entering the build point  

You can have QuickBooks remind you to build this assembly when your inventory quantity reaches a 

certain level. (Assembly Items to Build must be turned on in the Company Preferences Reminders.) 

QuickBooks will remind you to build when the combined value of the quantity on hand and the 

quantity on order (from a purchase order) falls below the value displayed in the Build Point field. 

Reminders appear in the Reminders window. In QuickBooks: Premier or Enterprise Solutions editions, 

you can rebuild directly from the Reminders list in any of these windows. 

11.11.5.1 To enter the build point: 

1. On the Item List select the Exterior Door Kit, click the Item button and select Edit Item. 

2. In the Build Point field, type 5 and press Tab. 

The New Item window should now resemble the following graphic.  
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3. Click OK.  

4. Close the Item List.  

11.11.6 Building finished goods  

Once you’ve defined assembly items that define the pieces you build, you are ready to enter the builds 

into QuickBooks. In this exercise, you build two exterior door kits for White Ridge.  

11.11.6.1 To build an inventory assembly:  

1. From the Vendors menu, choose Inventory Activities, and then choose Build Assemblies from the 

submenu.  

QuickBooks displays the Build Assemblies window.  

2. In the Assembly Item field, select Exterior Door Kit from the drop-down list.  

3. In the Quantity to Build field, type 2.  

 The Build Assemblies window should resemble the following graphic.  
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 QuickBooks warns you when you do not have sufficient inventory items on hand to complete a 

build. 

 If you choose to build an assembly and do not have enough components in inventory to build the 

number of assemblies you have specified, you can postpone the build by marking it pending. If 

you don’t mark the build as pending, you have to reduce the number of assemblies or you won’t 

be able to save the build.  

 You have enough inventory to build two assemblies, so you can proceed with the build.  

4. Click Build & Close.  

11.11.6.2 Understanding the effect of builds on inventory  

When you build an assembly item, QuickBooks decrements the appropriate number of individual 

inventory items from inventory and increments the number of inventory assembly items. It takes the 

inventory asset value of the component items and transfers the value to the assembly item. The parts 

and the values are combined into the quantity and value of the assembly item.  

The following graphics show the number of component and built items before the build.  
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The following graphics show the number of component and built items after the build.  

 

 

11.11.7 Managing pending builds  

A pending build is an inventory assembly build transaction that could not be finalized because there 

were not enough component parts in inventory to build the specified number of assemblies at build 

time. When a build is pending, “Pending” appears in the Build Assemblies window to remind you that 

these assemblies haven't been built.  

If you modify or delete a previous build transaction, or change inventory quantities or the dates of 

purchase orders, invoices, or sales receipts, assembly builds that were finalized could change to 

pending. Finalized builds change to pending when the quantity of at least one component drops below 

the quantity needed to build the specified number of assemblies on the build transaction date. You can 

use the pending builds report to see a list of all builds that are currently pending. 

In addition, you can choose to manually mark a build as pending even if you currently have enough 

components in stock to build the specified quantity. This allows you to set up build information but 

postpone building the assembly until later.  

11.11.8 Disassembling inventory assemblies  

There are several ways to disassemble inventory assemblies and return component items to inventory. 

You can do any of the following:  

 Use the Adjust Quantity/Value on Hand window to adjust the quantity on hand for each 

assembly component and the assembly item.  

 Reduce quantity to build in the Build Assemblies window and then click Build & Close. The 

quantity of assembly units in inventory is decreased and the quantities of component inventory 

parts are increased accordingly.  

 Delete a build transaction completely. The quantity of assembly units in inventory is decreased 

and the quantities of component inventory parts are increased accordingly, but this method 

completely removes the build transaction from QuickBooks and should not be used if you want 

to maintain a record of the transaction.  

11.11.9 Selling finished goods  

When assembly items appear on any form (for example, a sales receipt or in a report), their component 

items are hidden. Only the assembly name, description, and price appear.  



216 |  P a g e
 

If you attempt to sell more assembly units than you have available in inventory, QuickBooks warns 

you that quantities are insufficient to fulfill the order. If you decide to go ahead with this transaction, 

the quantity on hand for the specified assembly changes to a negative value. You can set a build point 

in the Build Assemblies window to remind you when assembly stock is getting low and you need to 

build more units. If you turn on reminders, a list of assemblies that need to be built appear in the 

Reminders window.  

11.12 Using units of measure  

Note:  You must be using certain editions of QuickBooks: Premier or 

QuickBooks: Enterprise Solutions to follow the exercises in this 

section. The exercises in the remainder of this lesson require the 

use of editions of QuickBooks that support units of measure 

functionality. Some of the exercises require the use of an edition 

that supports single units of measure; others require the use of an 

edition that supports multiple units of measure. You’ll find a list 

of the editions that support single and/or multiple units of measure 

below. 

Using units of measure can show what quantities, prices, rates, and costs are based on. You set up the 

units of measure and assign them to Service, Inventory Part, Non-inventory Part, Inventory Assembly, 

and Group items. Some businesses need to track transactions using only a single unit of measure, for 

example, a business buys inventory by the gallon and sells by the gallon. Service businesses also may 

track by only one unit of measure, such as by the hour. Other product-based businesses buy, sell, and 

stock inventory items in multiple units of measure. A business may receive inventory in one unit, store 

it in another, and sell and ship the items in a third unit of measure. Service businesses might also use 

multiple units of measure, for example if they bill by the hour and by the day.  

QuickBooks provides two different ways or modes for assigning units of measure to items: single unit 

of measure per item and multiple unit of measure per item.  

QuickBooks provides two ways to set up the unit of measure modes. You can turn on the mode in 

Preferences, or you can turn it on through the Item list.  

11.12.1 Setting up single unit of measure mode  

In Single mode you can assign different units of measure to different items, but each item can have 

only one unit of measure assigned to it. If you buy, stock, and sell each item by the same unit of 

measure, set up single unit of measure mode. For example, choose this mode if you buy an item by the 

foot, keep track of it in inventory by the foot, and sell it by the foot.  

11.12.1.1 To set up single units of measure:  

1. On the Home page, click Items & Services in the Company area to open the Item List.  

2. Select the non-inventory part item called Carpet (Direct Materials Heading:Flooring 

Materials).  

3. Click the Item menu button and select Edit Item.  

QuickBooks displays the Edit Item window for the non-inventory part called Carpet.  
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4. Click Enable to turn on the Unit of Measure mode.  

 This starts the unit of measure wizard where you set up the base unit.  

 Choosing single units of measure lets you define a base unit. White Ridge buys and sells carpet by 

the foot.  

 

5. Select Single U/M Per Item.  

6. Make sure “Begin defining units of measure” is selected and click Next.  

 Next you’ll select the type or category of measure units.  

7. Since White Ridge will buy and sell by the foot, select Length as the unit of measure type. 
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8. Click Next.  

 Now, you select the base unit.  

9. Select Foot as the base unit.  

 The base unit should be the smallest unit of measure used for an item when purchasing it, tracking 

it in inventory, and selling it. In QuickBooks, the base units of items are used to count inventory, 

generate most inventory reports, and perform quantity-related calculations.  

10. Click Finish. 

11. Click OK in the Edit Item window and close the Item List. 

11.12.2 Setting up multiple units of measure  

Note:  You must be using one of the editions of QuickBooks: Premier or 

QuickBooks: Enterprise Solutions that supports multiple units of 

measure to follow the exercises in this section. 

If you buy, stock, or sell items in different units, set up multiple units of measure. For example, choose 

this mode if you buy an inventory item by the gallon and sell it by the ounce, or if you sell consulting 

services by both the hour and the day.  

If you choose Multiple mode, you define unit of measure sets that you can assign to items. A unit of 

measure set consists of a base unit (usually the smallest unit used to track a certain type of item) and 

any number of related units (defined as containing a certain number of base units). For example, you 

could create a unit of measure set called “Length by the inch” with a base unit of inch and related units 

of foot (containing 12 inches) and yard (containing 36 inches).  

With Multiple mode, you can change or convert the unit of measure when you enter an item on a 

transaction form, such as an invoice or purchase order. For example, suppose you have an item called 

Cable that you've assigned a unit of measure set that contains the inch, foot, and yard units of measure. 

If you enter Cable on an invoice with a quantity of 30 feet, you could then change the unit of measure 

to yards (causing 30 feet to become 30 yards) or convert the unit of measure to yards (causing 30 feet 

to become 10 yards).  
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White Ridge purchases and sells inventory items in different units of measure. To track the different 

units of measure, you need to turn on multiple units of measure.  

11.12.2.1 Turning on multiple units of measure mode  

Depending on how your company file has been set up, you turn on the multiple units of measure mode 

in one of two ways.  

If your file has already been set up with single units of measure, you’ll need to switch from single to 

multiple mode. Follow the next procedure. 

11.12.2.1.1 To switch from single to multiple units of measure: 

1. Choose Preferences from the Edit menu. 

2. Click Items & Inventory, and then click the Company Preferences tab. 

3. From the Unit of Measure drop-down menu, choose Multiple U/M Per Item. 

 

4. Click OK.  

5. Click OK at the message that appears to notify you that QuickBooks must close all open windows 

to switch to multiple units of measure. If desired, click Home to have the home page displayed. 

6. Continue with the procedure in “Assigning units of measure to items” on page 263.  

11.12.2.1.2 To turn on multiple units of measure in a company file for the first time: 

1. Choose Preferences from the Edit menu. 

2. Click Items & Inventory, and then click the Company Preferences tab. 
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3. In the Unit of Measure section, click Enable.  

 

4. Select Multiple U/M Per Item.  

5. Click Finish.  

 QuickBooks returns to the Preferences window.  

6. In the Preferences window, click OK.  

7. Click OK if a message appears to notify you that QuickBooks must close all open windows to 

switch to multiple units of measure.  

8. Continue with the procedure in the next section.  

11.12.2.2 Assigning units of measure to items  

White Ridge sells countertops that can be customized according to a customer’s wishes. One customer 

who is remodeling a kitchen wants Italian marble for the countertop. White Ridge has a non-inventory 

part item called Counter for materials they purchase on behalf of a customer but that they don’t 

normally carry in stock. White Ridge purchases the marble in square meters, but charges the customer 
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by the square foot. To track the different units of measure, you’ll assign units of measure to items.  

11.12.2.2.1 To assign multiple units of measure: 

1. Click Home on the icon bar to open the Home page if necessary. 

2. On the Home page, click Items & Services in the Company area to open the Item List.  

3. Select the non-inventory part item called Counter (Direct Materials - Heading).  

4. Click the Item menu button and select Edit Item.  

 QuickBooks displays the Edit Item window for the non-inventory part called Counter.  

 

5. From the U/M Set drop-down menu, choose Add New.  

 This starts the Unit of Measure wizard where you set up the base unit and any related units. 

 Choosing multiple units of measure lets you define a base unit and multiples of that base unit. 

Since White Ridge buys the marble countertop in square meters and sells the countertop in square 

feet, you define a measure set for area.  

6. Select Area as the unit of measure type. 

 You’ll be defining a measurement set called Area that consists of a base unit and related units. 



222 |  P a g e
 

 

7. Click Next. 

 Now, you select the base unit.  

 

8. Select Square foot (sqft) as the base unit.  

 The base unit should be the smallest unit of measure used for an item when purchasing it, tracking 

it in inventory, and selling it. In QuickBooks, the base units of items are used to count inventory, 

generate most inventory reports, and perform quantity-related calculations.  

9. Click Next.  

 QuickBooks displays the window where you define the units related to the base unit. Related units 

make it possible to show quantities of the same item in different measurements in different places 

in QuickBooks. White Ridge purchases the marble by square meter, counts that item in inventory 

by the square yard, and sells it by the square foot. By creating a unit of measure set with a base 

unit of square foot and related units of square meter and square yard, you can enter a quantity of 

square meters on a purchase order, show the item in square yards on inventory reports, and enter a 

quantity of square foot on an invoice.  
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10. Click in the Add column for square yard and square metre.  

 Notice that QuickBooks has already calculated the number of base units the related unit contains 

in the # of sqft column.  

 

11. Click Next.  

 Next, you’ll select the default unit of measure to use when buying this item and when selling and 

shipping this item.  

12. From the Purchase drop-down menu, select square metre. 

 Since White Ridge buys by the square meter, that’s what you want to appear by default on 

purchase orders for this item.  

 

13. Leave the Sales default as square foot and leave the Shipping default blank.  

14. Click Next.  

 You need to give this measure set a name. Notice that QuickBooks automatically generates a name 
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(although you can change it if you want). 

15. Click Finish to accept the name of this unit of measure set that QuickBooks suggests.  

QuickBooks returns you to the Edit Item window. Notice that the Counter item has been assigned the 

Area measurement set.  

 

16. Click OK in the Edit Item window.  

11.12.2.3 Assigning measure sets  

You can create several measure sets for your company that you can assign to items. You just created a 

measure set for area for White Ridge. Since White Ridge buys and sells other items using different 

measurements, you could create a measure set for count (each, pair, dozen, and so on) and another one 

for length (inch, foot, yard, and so on). The number of measure sets you create will depend on your 

business needs.  

After creating the measure sets, you’ll need to go through the items in your Item List and assign the 

unit of measure set to use for each item.  

11.12.2.4 Using units of measure on sales forms  

White Ridge needs to order the marble for the kitchen remodel. In this exercise, you order the marble 

using a purchase order, and see how you could easily convert from one unit of measure to another unit 

within the same measure set.  

11.12.2.4.1 To convert units of measure on sales forms: 

1. In the Vendors area of the Home page, click Purchase Orders. 

2. In the Vendor field of the purchase order, select Barata’s Building Supplies.  

 White Ridge orders the marble from this vendor.  

3. Click in the Item column and select Counter (Direct Materials – Heading).  

4. In the Qty column, type 10.  
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 Your screen should resemble the following graphic.  

 

 Notice that QuickBooks displays a menu you can use to specify the unit of measure if you want to 

change it. For this exercise, leave the measurement as 10 sqm. 

5. Click the down arrow in the U/M column to open the conversion menu.  

 Notice that QuickBooks uses the default unit you selected for purchasing this item. You can use 

the menu to convert to other units of measure within the Area measure set you created. For this 

exercise, leave the unit of measure as sqm.  

6. Click Save & Close.  

Once you've created a unit of measure set and assigned it to an item, you can easily convert to 

other units of measure within the set when you add the item to a transaction. 
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12 Lesson 11: Tracking and Paying Sales Tax 

12.1 Lesson objectives 

 To get an overview of sales tax in QuickBooks (the steps involved in tracking, collecting, and 

paying it) 

 To see how to set up QuickBooks to track sales tax 

 To see how to apply sales tax to a sale 

 To learn how to determine a business’s sales tax liability 

 To write a QuickBooks cheque to the appropriate tax agency for sales tax liability  

12.2 Supporting materials  

 Handout 7: Sales tax 

 PowerPoint file: Lesson 11 

12.3 Instructor preparation  

 Review this lesson, including the examples, to make sure you’re familiar with the material. 

 Ensure that all students have a copy of qblesson.qbb on their computer’s hard disk. 

 Have Handout 7 ready for distribution.  

12.4 To start this lesson  

Before you perform the following steps, make sure you have installed the exercise file (qblesson.qbb) 

on your hard disk. See “Installing the exercise file” in the Introduction to this guide if you haven’t 

installed it.  

The following steps restore the exercise file to its original state so that the data in the file matches what 

you see on the screen as you proceed through each lesson.  

12.4.1 To restore the exercise file (qblesson.qbb):  

1. From the File menu in QuickBooks, choose Open or Restore Company. QuickBooks displays 

the Open or Restore Company window.  

2. Select Restore a backup copy and click Next.  

3. Select Local backup and click Next.  

4. In the Open Backup Copy window, navigate to your C:\QBtrain directory.  

5. Select the qblesson.qbb file, and then click Open. 

6. In the Open or Restore Company window, click Next.  

7. Navigate to your C:\QBtrain directory. 

8. In the File name field of the Save Company File as window, type lesson 11 and then click 
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Save. 

9. Click OK when you see the message that the file has been successfully restored. 

12.5 Overview of sales tax in QuickBooks  

Although very small businesses are exempt, the Canada Revenue Agency (CRA) recommends that all 

businesses register to collect the Goods and Services Tax (GST) or, in provinces where the provincial 

sales tax has been combined with the GST, the Harmonized Sales Tax (HST). Registered businesses 

track the GST or HST collected from customers on sales and paid on purchases for the business. 

Usually, you collect more sales tax than you pay out and must remit the difference to the CRA. 

(Occasionally, you pay out more than you do collect—for example, when your business is starting 

up—and claim a refund. 

When your company’s sales reach a certain level, you are required to register to collect the GST or 

HST. You should check with the CRA or your accountant for detailed information about how your 

business should handle the GST or HST. 

Many provincial governments also require you to register to collect a provincial sales tax (PST, or in 

Quebec, QST). In most provinces you track only the PST you collect from customers (instead of both 

the amount you collect and the amount you pay) and remit that amount to the government. 

However, in Quebec, the QST works much the same way as the GST: businesses may be able to 

deduct the amount of QST paid on business-related purchases—called an input tax credit—from the 

amount of QST collected from customers, and then remit the difference. 

Check with your province’s Ministry of Finance or your accountant about how your business should 

handle federal and provincial sales taxes. 

 In broad terms, collecting sales taxes in QuickBooks means confirming that QuickBooks is 

handling GST and PST the way your business and government regulations require; assigning tax 

codes to items so that QuickBooks knows what taxes (e.g. non, GST only, PST only, or both 

GST and PST) to apply to items (or services) that you sell or purchase; in rare cases, assigning 

tax codes to customers who have special tax needs; and 

 Filing sales tax returns to the government and creating payments for the amount you owe. 

Once you have confirmed that the default tax codes in QuickBooks meet your needs or else set up sales 

tax codes of your own, then assigned these tax codes to the items you sell and buy, QuickBooks 

automatically applies the correct taxes as you work. The dollar amounts of the taxes appear at the 

bottom of sales and purchase forms. Later, when you’re ready to pay your sales tax liabilities, 

QuickBooks can create a return and a payment for the correct amount for you. 

Refer to Handout 7, “Sales tax,” for the following discussion.  

12.5.1 How QuickBooks calculates the GST and PST  

QuickBooks uses your company address to determine what rates of GST and PST apply to your 

business and sets up the appropriate sales tax items and codes in your QuickBooks company file. You 

then assign these sales tax items and codes to the items you buy and sell. 
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On sales and purchase forms, QuickBooks calculates the GST and PST separately for each item 

according to the sales tax code you assigned to it. It displays the GST and PST totals in their respective 

boxes at the bottom of the sales or purchase form, and then adds these amounts to the cost of the goods 

or services. The HST, if applicable, is calculated as one rate in the GST field. 

Because QuickBooks rounds the individual tax amounts to the nearest cent, the total may be slightly 

different from the total you would get if you combined the taxes into one rate and applied it to the sale. 

Don’t worry about this discrepancy; QuickBooks calculates and reports each individual tax amount 

correctly. 

At regular intervals, you file GST and PST returns to remit the amount you owe to the federal and 

provincial governments. When you do, the sales and purchases covered by the return are marked as 

“filed”. Filed transactions never appear in GST or PST returns. If you enter a backdated transaction 

into a previous GST or PST period after you’ve already sent your return, it will automatically be 

included in the next return you send, but no other transaction from that period will be. 

12.5.1.1 To use QuickBooks to track and pay your sales tax:  

1. Set up your sales vendors, tax items, and tax codes.  

 QuickBooks uses your company address to determine what rates of  HST, GST and PST apply in 

your province, what tax accounts to set up, and the tax agencies (that is, the government 

departments that administer sales taxes) you’ll need. The tax items and codes are set up 

automatically for you. QuickBooks lets you setup additional sales taxes for other provinces if 

required for your business. 

 You can also set up new tax codes if you have additional tax rates or types of tax that are 

applicable to your business. 

2. Indicate what (and occasionally who) gets taxed.  

 For each item, indicate the tax code to be used when that item is purchased and when it is sold. In 

your Customer:Job list you can also indicate whether the Customer:Job has a specific tax code. 

The customer tax code will override item tax codes in a transaction. This is a preference that is 

enabled in the Sales Tax category in QuickBooks Preferences. 

3. Apply tax to each sale or purchase.  

 When you fill out an invoice or sales receipt form, or purchase form, QuickBooks applies the 

appropriate sales tax. If the item does not have a tax code assigned you can add a tax code. 

QuickBooks uses the tax code to calculate the appropriate sales tax for the transaction. If 

necessary, you can override the tax amount calculated.  

4. Find out what you owe.  

 As you record taxable sales, QuickBooks keeps track of the tax you’ve collected in your 

GST/HST Payable or PST Payable account. When you’re ready to pay your sales tax, you can use 

the Manage Sales Tax window to file sales taxes. 

5. File your sales tax return.  

 To file your sales tax return to the applicable tax agency, go to the Home page, and then click on 

Manage Sales Tax. This opens up the Manage Sales Tax window. You can see the amount owing 
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the various tax agencies in your company. You will be able to create a payment and print out a 

return report for your business. If you have a refund due to you, QuickBooks will create an invoice 

for the amount that you are claiming as a refund on your return. 

This lesson walks you through each of these steps.  

12.6 Setting up your tax Vendors, Items, and Codes 

QuickBooks creates sales tax vendors, accounts, items and tax codes based on the province in your 

company file. Sales tax vendors are setup based on your province. The Receiver General is setup 

automatically. Other agencies like the Minister of Finance will be setup if you are located in a province 

where provincial sales taxes are administered. In addition to setting up your sales tax vendors, 

QuickBooks sets up sales tax items and codes that are used in your day-to-day transactions to track 

sales taxes. The sales tax is then tracked to the GST/HST Payable and PST Payable liability accounts.  

12.6.1 Reviewing the default sales tax Vendors 

When you setup QuickBooks for the first time, QuickBooks sets up the appropriate sales tax vendors. 

By default QuickBooks sets up the Receiver General for most businesses. Businesses will remit the 

GST and HST to the Receiver General.  

12.6.1.1 To review how the Receiver General is setup in QuickBooks:  

1. From the Home Page, click Vendors. QuickBooks displays the Vendor Centre.  

2. Double Click the Receiver General. QuickBooks displays the Vendor window.  

 

3. Click the Sales Tax Setting tab.  

4. On the sales tax tab you can edit the vendor setup to match how you pay sales taxes in your 

business.  

5. In the Tax Return drop down arrow, choose the GST/HST Return.  
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6. In the Reporting Period drop down arrow, choose the reporting period in your business. For 

this example choose Quarterly.  

7. In the Period Ending drop down arrow choose the reporting period that matches the reporting 

period for your business. Typically, the reporting period will be assigned to you by the 

Receiver General. 

8. By default QuickBooks tracks your HST/GST to the GST/HST Payable account. You can see 

this in the Receiver General window in the track tax on sales separately on… drop down 

arrow. QuickBooks chooses the GST/HST Payable account for you. If you want to track tax 

on sales or purchases to an account of your choice, select the appropriate account. 

 Your New Item window should now resemble the following figure.  

 

9. Click OK.  

12.6.2 Reviewing the default sales tax Items 

When you setup QuickBooks for the first time, QuickBooks sets up the appropriate sales tax Items. 

The sales tax items are saved in the Items & Services list. By default QuickBooks sets up GST/HST 

and PST items that are linked to the Receiver General and provincial sales tax agencies.  

On a sales form such as invoices or sales receipts, QuickBooks uses tax codes to charge the right 

amount of tax. The sales tax code actually represents one or more tax items, and that is where the sales 

tax rate (or amount) is stored. 

QuickBooks uses sales tax items behind the scenes to calculate the sales tax on transactions and 

associate the tax with the correct sales tax agency (e.g. CRA). Then, the calculated sales tax tracks to 

the liability account for that agency (e.g. GST/HST Payable).  
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12.6.2.1 To review how the sales tax items are setup in QuickBooks:  

1. From the Home Page, click Items & Services. QuickBooks displays the Vendor Centre.  

2. Double Click the item labeled GST on Sales 5.0%.  

 

3. QuickBooks uses the item to track sales tax amounts for GST. The Tax Agency is labeled as 

the Receiver General. The 5.0% is tracked to Line 103 GST/HST collected or collectible. 

4. Click OK.  

12.6.3 Sales Tax Codes 

QuickBooks sets up a list of common sales tax codes for you based on the location of your 
business. All provinces have the tax codes E (for Tax Exempt), and Z (for Zero-Rated). Most 
provinces also have the tax code G (for GST). In some provinces the sales tax codes include H 
(for HST). 

12.6.3.1 To review how the sales tax Codes are setup in QuickBooks:  

1. From the Lists menu, choose Sales Tax Code List. QuickBooks displays the Sales Tax Code 

List. 

2. Double click the G tax code.  Note that the tax code can be used on both sales and purchases. 

When the G tax code is used for purchases the tax amount will track to the GST (ITC) item. 

When the G tax code is used for sales the tax amount will track to the GST item.  

3. Click OK. 
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12.6.4 What the Zero Rated (Z) tax code is for 

Under the GST, certain goods and services are taxed at a rate of 0% instead of the usual 5%. These 

items are called Zero Rated. Zero Rated items are not tax exempt, and should not be assigned the 

Exempt tax code (E). 

If you sell a Zero rated item, you charge your customers 0% GST on it. This means that you do not 

collect any GST to remit to the government. However, because the item is taxable, you can claim input 

tax credits (the GST you paid on the materials you needed to produce the item) for it. When you file 

your GST return, you receive a refund based on these credits. 

Zero Rated Items usually fall into these categories. (However, you should always check with the CRA 

for the status of a specific item!) 

 Prescription drugs and medical devices 

 Basic groceries 

 Products destined for export 

 Professional farming and fishing goods 

 International travel and transportation services 

 Financial services 

12.6.5 Using QuickBooks to track and pay your sales tax 

Assume White Ridge Construction uses the standard S tax code (GST+PST) most often, and it wants 

to set that up as the default sales tax.  

12.6.5.1 To set up a default sales tax:  

1. From the Edit menu, choose Preferences. 

 QuickBooks displays the Preferences window. 

2. In the Preferences window, click the Sales Tax icon in the left panel, and then click the Company 
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Preferences tab.  

 

3. Make sure that Yes is selected for “Do you charge sales tax?”  

4. In the Customer & Vendor Tax Codes area, make sure both the Use Customer Tax Codes and Use 

Vendor Tax Codes are checked. 

This means that you can assign tax codes to customers or vendors, but as these codes will override 

item tax codes on all sales and purchase forms, it is best to assign individual codes only as you 

need them. 

5. In the Assign Sales Tax Codes area, choose S from the drop-down list. QuickBooks will assign 

this tax code to all new items you create (although you can change it if you want.) Leave the Non-

taxable items field as is. 

6. Click OK. 

If QuickBooks displays a Warning window. 

 

7. Click OK again. 

If you’re using sales tax codes, you can use the Preferences window to tell QuickBooks which sales tax 

codes to use as the default taxable and non-taxable codes. You can use the codes that come preset with 

QuickBooks, or define your own. You can also manage sales tax codes using the Sales Tax Code list, 

which is available on the Lists menu when the sales tax feature is turned on in a company data file.  
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12.6.6 Indicating the tax rates on items  

The next step in setting up sales tax is to indicate what tax rates apply to each item.  

In the next exercise, you’ll take a look at an item on White Ridge’s Item list to see how to indicate the 

tax code that is being used.  

12.6.6.1 To assign or change a tax code to an item: 

1. From the Lists menu choose Item List and then in the Item List, select Bathroom Faucet 

(under Plumbing Retail).  

2. Click the Item menu button, and then choose Edit Item.  

 QuickBooks displays the Edit Item window.  

 

 The code in the Purchase Tax Code field tells you how QuickBooks will calculate sales taxes on 

this item when you purchase it from a vendor. When you include this item on a purchase form 

(bill) QuickBooks knows the rate of tax to apply to the item and automatically calculates the tax 

amount for it. 

 The code in the Tax Code field tells you the rate of GST and PST to be calculated on a sales 

transaction. When you choose the item to be included in a sales form (invoice or sales receipt) 

QuickBooks knows the rate of tax to apply to the item and automatically calculates the tax on that 

item. 

3. Click OK to close the Edit Item window.  

4. Close the Item List.  

In the same way that you can specify the tax rate on an item by attaching a tax code to the item, 

you can indicate the tax rate in a particular customer’s record by attaching a tax code. On a sales 

form, the tax code of the customer will override the tax code of the item.  
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12.6.6.1.1 To see an existing customer record: 

1. Click Customer Centre on the icon bar.  

QuickBooks displays the Customer Centre, including the Customers & Jobs list.  

2. Select Bentley, Karen.  

3. Click Edit Customer. 

 QuickBooks displays the Edit Customer window. 

4. Click Sales Tax Settings.  

 

The tax code selected (G) indicates that transactions with this customer are subject to GST sales 

tax only. This code means that this customer will always pay only GST on services purchased 

from you.   

5. Click OK. 

6. Close the Customer Centre.  

12.7 Applying tax to each sale  

When you fill out a sales invoice, or sales receipt, each item will normally have a tax code assigned. If 

an item does not have a tax code assigned, you can enter it directly on the form. QuickBooks uses the 

tax code to calculate the amount of tax for the transaction.  

12.7.1 To apply tax to a sale:  

1. On the Home page, click Create Invoices. 

 QuickBooks displays the Create Invoices window 

2. In the Customer:Job field, choose Nielsen, Clinton:Study Addition  from the drop-down list. 
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(Select both the customer and the job.)  

3. In the dates field make sure 12/31/2014 is selected. 

4. In the Template field, select Intuit Product Invoice from the drop-down list.  

5. In the Ship to field, select “Ship to 1” 

6. Click in the Quantity column and type 5. 

7. Click in the Item column and select Hardware:Doorknobs (Materials Heading) from the drop-

down list. 

 If the “Sales Tax Code” message appears, click OK. When you enter an item QuickBooks 

displays the tax code associated with that item (in this case the standard S tax code) in the Tax 

column. QuickBooks then calculates the sales tax and shows the amounts in the GST and PST 

boxes below the items area. 

Note:  Even if you had assigned a different tax code to this item, in 

this case, QuickBooks would have displayed the S tax code 

anyway because this is the sales tax you assigned to the 

customer, Clinton Nielsen. 

Tip:  You can select a different tax code from the list to change the 

tax that is calculated for each item. 

 The Create Invoices window should resemble the figure below.  
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8. Click Save & Close. If the Job Costing window appears, click in the “Do not show this window 

again” checkbox, and then click No. 

 The following table shows the journal entry for the invoice.  

Account Title  Debit Credit 

 Accounts Receivable  $33.55   

 Retail Sales  
 Inventory Asset  

 $29.95 
$14.95 

 Cost of Goods Sold 
 

14.95 
 

 GST/HST Payable  
 PST Payable (BC) 

 
$1.50 
$2.10  

12.8 Determining what you owe  

If you’re required to collect sales tax from customers, you also have to make periodic payments of the 

sales tax you’ve collected. QuickBooks gives you two primary ways to determine the amount of your 

sales tax liability:  

 The Tax Agency Report (available in the Report Menu, Sales Tax or Vendors & Payables) 

 The Manage Sales Tax window (available in the Sales Tax menu) 

12.8.1 Creating a Tax Agency report  

The tax agency report provides complete information about the sales tax your company owes for a 

particular period of time.  

12.8.1.1 To create the GST/HST Return report:  

1. From the Reports menu, choose Sales Tax, and then click Tax Agency Report. 

2. Choose Receiver General from the Tax Agency drop down menu. 

 Your report should resemble the following figure. 

. 
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3. In the Tax Agency Field, select Receiver General from the drop-down list.  

4. Choose the appropriate date range if necessary.  

 The tax agency report shows the total taxable sales as of a date you choose, and the amount of 

sales tax you owe the chosen tax agency.  

 QuickBooks displays this report on an accrual basis (unless you changed the default setting in the 

Sales Tax Preferences window). The report shows exactly how much sales tax (GST) you 

collected, how much sales tax (GST) you paid (ITCs) and the balance that you owe or have 

coming in a refund.  

5. Close the Tax Agency report. 

6. If QuickBooks asks if you want to memorize the report, click No. 

Note:  There is also a Tax Agency Detail Report, which 

provides in expanded detail the information that is 

contained in the Tax Agency Report. The 

information provided is categorized in the same 

way, but each transaction within the  

12.9 Paying your Sales Tax  

When it's time to pay sales tax, you use the Manage Sales Tax window to pay your sales taxes. 

Suppose White Ridge Construction is ready to make a sales tax payment. 

12.9.1 To make a sales tax payment: 

1. From the Manage Sales Tax window, select File Sales Tax. 

 QuickBooks displays the File Sales Tax window.  
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2. On the Receiver General Click Pay Now. 

3. QuickBooks displays the File Sales Tax window. 

 

4. Review the sales tax return and then Click File Return. 

5. QuickBooks gives you the option about How Would You Like to File a Return?. You can File 

Online or use Paper or other filing method. For this example, choose Paper or other filing method. 

 

6. Click Continue.  

7. Choose if you would like to print your return. 
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8. The Payment window is displayed to give you the option of paying now or later. 

 

9. Click Pay Later. 

 

10. Click OK in the Filing Process Complete window. 

11. To see the account payable to the Receiver General, from the Vendors menu select Pay Bills. 

Your screen should resemble the following: 

 

12. Close the Pay bills window. 
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12.9.2 Creating taxes for other Provinces 

If you need to charge sales tax for an additional province, follow the steps below to add the common 

sales tax codes, sales tax items, sales tax agencies and sales tax accounts for that province.  

12.9.2.1 To setup provincial sales tax for other provinces: 

1. On the Manage Sales Tax window, click Change Tax Setup. QuickBooks displays the 

QuickBooks Sales Tax Setup Wizard. 

 

2. Click Finish. 

3. Select the province you want to add sales taxes for. 

4. Click OK. QuickBooks sets up all of the necessary tax items, codes, and accounts for the 

selected province. 
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13 Lesson 12: Doing Payroll with QuickBooks 

13.1 Lesson objectives  

 To gain an overview of payroll in QuickBooks 

 To learn more about payroll setup 

 To set up employee payroll information 

 To set up payroll schedules 

 To practice writing and printing a payroll cheque 

 To learn how QuickBooks tracks your tax liabilities 

 To practice paying payroll taxes  

13.2 Supporting materials  

 Handout 8: Employer payroll responsibilities 

 Handout 9: Payroll item types 

 Handout 10: List of payroll expenses and liabilities 

 PowerPoint file: Lesson 12 

13.3 Instructor preparation  

 Review this lesson, including the examples, to make sure you’re familiar with the material. 

 Ensure that all students have a copy of qblesson.qbb on their computer’s hard disk. 

 Have Handouts 8 through 10 ready for distribution.  

13.4 To start this lesson  

Before you perform the following steps, make sure you have installed the exercise file (qblesson.qbb) 

on your hard disk. See “Installing the exercise file” in the Introduction to this guide if you haven’t 

installed it.  

The following steps restore the exercise file to its original state so that the data in the file matches what 

you see on the screen as you proceed through each lesson.  

13.4.1 To restore the exercise file (qblesson.qbb):  

1. From the File menu in QuickBooks, choose Open or Restore Company.  

 QuickBooks displays the Open or Restore Company window.  

2. Select Restore a backup copy and click Next. 

3. Select Local backup and click Next. 

4. In the Open Backup Copy window, navigate to your C:\QBtrain directory. 

5. Select the qblesson.qbb file, and then click Open. 
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6. In the Open or Restore Company window, click Next. 

7. Navigate to your C:\QBtrain directory. 

8. In the File name field of the Save Company File as window, type lesson 12 and then click Save. 

9. Click OK when you see the message that the file has been successfully restored. 

13.5 Overview of payroll tracking  

Refer to Handout 8, “Employer payroll responsibilities” for the following discussion.  

This lesson is designed to demonstrate some of the QuickBooks payroll features. The way you process 

payroll for your company may differ from this lesson depending on which (if any) payroll service you 

subscribe to.  

Because payroll information is already set up in the exercise file, you will not go through the payroll 

setup process in this lesson.  

To calculate payroll, QuickBooks uses tax tables. The exercise file includes the tax table data needed 

to complete this lesson. To get the tax tables to use with your own QuickBooks company data file, you 

need to subscribe to the Intuit Payroll Service. To learn about payroll options or subscribe to Payroll, 

visit QuickBooks.ca.  

QuickBooks calculates each employee’s gross pay, and then calculates taxes and deductions to arrive 

at the net pay. With QuickBooks, you can write the paycheque, record the transaction in your 

QuickBooks checking account, keep track of your tax liabilities, and pay them.  

You, as the employer, must subtract taxes and other deductions before issuing an employee’s 

paycheque. Some typical paycheque deductions are Income taxes, Canada Pension Plan /Quebec 

Pension Plan (CPP/QPP), and Employment Insurance. You may also deduct for benefits such as a 

Registered Retirement plans (RRSP), or contributions to your company’s medical/dental plan.  

Then you must submit regular deposits of the withheld tax money (biweekly or monthly, depending on 

the size of your payroll), and file annual forms that list the total amounts you withheld from each 

employee’s paycheque.  

13.5.1 Calculating payroll with QuickBooks  

To do its payroll calculations, QuickBooks needs four kinds of information:  

 Information about your company  

Besides the company name and address, this includes information about your Business Number 

from the CRA. You enter this information in the EasyStep Interview when you set up your 

QuickBooks company data file. (You can view most company information by choosing 

Company Information from the Company menu.)  

 Information about your employees  

The QuickBooks Employee list stores general information about each of your employees, and 

specific information related to payroll (such as the employee’s Social Insurance Number, date of 

birth, salary or hourly rate, Federal and Provincial TD1 amounts, and miscellaneous additions, 

deductions, and company contributions). You can store payroll information that most employees 
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have in common in employee defaults. Whenever you have a new employee to add, simply enter 

information that’s specific to that employee (name, address, and so on).  

 Information about your payroll items  

QuickBooks maintains a list of items that affect the amount on a payroll cheque, including 

company expenses related to payroll. When you specify that you want to use payroll, 

QuickBooks creates a number of payroll items for you. You add others as you need them.  

 Tax tables for federal and provincial withholdings  

QuickBooks uses tax tables to calculate payroll. You get the current tax tables and keep them 

current when you subscribe to the Intuit Payroll. Once you’ve set up your company, employee 

data, and payroll items, to run payroll you enter the number of hours worked during the pay 

period for each employee. QuickBooks calculates the gross wages for the employee, and then 

refers to its tax tables and the company and employee information you’ve entered to calculate 

all withholdings and deductions and to arrive at the net pay amount. QuickBooks also calculates 

your company payroll expenses (for example, your contributions to CPP and EI), and, if you 

want, prints the pay cheque(s).  

13.6 Setting up for payroll 

By default, the QuickBooks payroll feature is turned on and it is turned on in the exercise file. If you 

want to turn off payroll in your own company file, follow the procedure below.  

13.6.1 To turn payroll off in a company data file:  

1. From the Edit menu, choose Preferences, and click Payroll & Employees in the left panel.  

2. Click the Company Preferences tab and select “No payroll.”  

3. Click OK. QuickBooks displays a Warning window. 

4. Click OK again. 

13.6.2 Understanding payroll items  

Refer to Handout 9, “Payroll item types,” for this discussion.  

QuickBooks maintains a list for everything that affects the amount on a payroll cheque and for every 

company expense related to payroll. This list is called the Payroll Item list. There are payroll items for 

compensation, taxes, other additions and deductions, and employer-paid expenses. QuickBooks uses 

payroll items to track individual amounts on a pay cheque and accumulated year-to-date wage and tax 

amounts for each employee.  

QuickBooks adds some items to the list for you, and you can add others as you need them. For 

common payroll items, such as compensation and benefits, QuickBooks provides extra assistance so 

you can set them up quickly and accurately.  

You work directly with payroll items as you do payroll tasks. Behind the scenes, QuickBooks tracks 

your payroll liabilities in the Payroll Liabilities account (an Other Current Liability account) and your 

payroll expenses in the Payroll Expenses account.  
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13.6.2.1 To view the Payroll Item list:  

1. From the Lists menu, choose Payroll Item List. (You must have payroll turned on to see this 

choice.)  

 QuickBooks displays the Payroll Item List.  

 

 You’ve already used the QuickBooks Item list, so this list should look familiar. Just like the 

regular Item list, each payroll item has a Name and a Type. 

 The names of the payroll items are what you’ll see on pay cheques and in payroll reports. 

2. Close the Payroll Item List.  

You won’t add a new payroll item in this lesson, but if you need to add an item after you’ve set up 

payroll in QuickBooks, you can use the following procedure. 

13.6.2.1.1 To add a payroll item: 

1. From the Employees menu, choose Payroll Setup, and then choose Add or Edit Payroll Items  

2. In the Payroll Item List click the Payroll Item menu button, and then choose New.  

3. QuickBooks displays the Add new payroll item window, which steps you through the payroll item 

setup process.  
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4. Select the type of payroll item you want to create, and then click Next. 

5. Follow the onscreen instructions to create any type of payroll item you like. 

6. Press Cancel to terminate the payroll item setup process, and then close the Payroll Item List. 
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Depending on your company’s payroll, you may need additional 

payroll items of the following types: Yearly salary, Hourly Wage, 

Deduction, Addition, Commission, or Company Contribution. 

Consult with your tax advisor. 

  

13.7 Setting up employee payroll information  

QuickBooks calculates payroll for each employee on the basis of that employee’s pay rate, exemptions, 

and so on. The Employee list stores general information about each employee, as well as payroll 

information.  

13.7.1 What information does QuickBooks store?  

You’re going to add a new employee to the White Ridge Construction payroll in a moment. First, look 

at the information QuickBooks stores in the Employee list.  

13.7.1.1 To view information stored in the Employee list:  

1. Click Employee Centre on the icon bar.  

2. Review the employee information stored in the employee centre. 

 

3. Double click the name Sandra Adams in the list..  

 QuickBooks displays the Edit Employee window for Sandra Adams.  
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 The Personal tab contains general information about Sandra Adams, such as her name, social 

insurance number, and date of birth.  

4. Click the Address and Contact tab. 

 This is where QuickBooks stores employees’ addresses, telephone numbers, and other contact 

information. 

 

5. Click the Additional Info tab. 

 The Additional Info tab lets you add custom fields to the Employee list. 

6. Click the Payroll Info tab.  

 QuickBooks displays the Payroll Info tab of the Edit Employee window. This is where 

QuickBooks stores payroll information.  
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 The Payroll Info tab contains an employee’s specific salary or hourly rate, and any additions, 

deductions, or company contributions. You can see tax information for this employee (the type of 

information you require for a T4) by clicking the Taxes button.  

7. Click Taxes and TD1. Note the Tax Table field shows British Columbia. 

 QuickBooks displays the Taxes for Sandra Adams window. 

 

 The checkboxes indicate the types of taxes the employee should have deducted from each pay 

cheque. A checkmark in the Employment Insurance checkbox indicates that this employee should 

have Employment Insurance premiums deducted from her earnings. The EI factor shows that the 

employer’s portion of EI tax will be 1.4 times the amount the employee pays (which is the 

standard amount). 

8. You also enter the employee’s federal and provincial TD1 amounts in this window. 
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9. Click the Employment Info tab. Enter the employee Hire Date and Release date as needed in this 

window. 

10.  Click OK to return to the Employee Centre. 

13.7.2 Using the employee defaults to store common information  

QuickBooks stores a wealth of information about each employee, but it doesn’t require you to enter the 

same information over and over. When you have information that applies to most of your employees, 

you can enter it into your employee defaults. Then, when you add an employee, QuickBooks 

automatically fills in the information stored with the defaults. You just need to add or change any 

information that is different for a particular employee.  

13.7.2.1 To view employee defaults:  

1. With the Employee Centre displayed, click Manage Employee Information menu button and 

choose Change New Employee Default Settings. 

 QuickBooks displays the Employee Defaults window.  

 

 Use this window to set up the payroll information that most of your employees have in common. 

QuickBooks saves the information so you won’t have to re-enter it when you set up the payroll 

record for an individual employee.  

 White Ridge Construction employees are not paid on the same schedule, so you would not enter 

default Payroll Schedule or Pay Frequency here. You’ll learn how to set up payroll schedules in 

the next exercise.  

 Since White Ridge Construction is enjoying substantial business growth, existing employees and 

any new employees will be eligible for a company performance bonus of $50 per pay period. You 

can add it now. 

2. Click the “Use time data to create pay cheques” checkbox to include pay for time entered using 

the time tracking feature.  
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3. In the Additions, Deductions and Company Contributions area, click in the Item Name column, 

and then choose Performance Bonus from the drop-down list.  

4. In the Amount column, type 50 and press Tab.  

 Your screen should look like the following.  

 

5. Click Taxes. 

 QuickBooks displays the Taxes Defaults window. 

 

 The withholding taxes that should be deducted from each employee pay cheque are entered in this 

window.  

6. Click Cancel to close the Taxes Defaults window.  

7. Click Vacation Pay. 

 QuickBooks displays the Vacation Defaults window. 
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 Information regarding earned vacation days is entered in this window. QuickBooks keeps track of 

the earned time each pay period.  

8. Click Cancel to close the Vacation Defaults window.  

9. Click OK to close the Employee Defaults window.  

10. When QuickBooks asks whether you would like to apply changes to all matching employees, click 

Yes. 

The new default you have created will now appear in all employee records if the employee record 

has not been changed from the defaults. 

11. Click the Home Icon to display the Home page. 
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The employee defaults affect employees you set up in the future. If your 

employee list already contains names of employees but does not have 

payroll information for them, the defaults will not be applied to those 

employees. 

  

13.7.3 Setting up payroll schedules  

You can set up payroll schedules to group employees with the same pay frequency (daily, semi-

monthly, bi-weekly, and monthly). You define how often you pay your employees, which date their 

pay cheque is due, and which day you run payroll. QuickBooks calculates your upcoming payroll 

schedule so that you can pay your employees on time.  

Using payroll schedules is a quick and convenient way to pay your employees at each pay period. You 

set up the payroll schedule one time, assign the payroll schedule to the appropriate employees, and 

QuickBooks calculates the due dates for each upcoming pay period.  

Note:  If you do not set up at least one payroll schedule, you can still pay 

employees using Special Unscheduled Payroll in the Payroll 

Centre. 

White Ridge Construction has one payroll schedule: Monthly for salaried employees who are paid 

monthly. They now wish to put hourly rated employees on a weekly pay schedule, and need to set up a 

second payroll schedule. 



252 |  P a g e
 

13.7.3.1 To define a payroll schedule:  

1. From the Employees menu, choose Payroll Setup, and then select Add or Edit Payroll Schedules.  

QuickBooks displays the Payroll Schedule List window.  

 

2. Click the Payroll Schedule menu button, and then choose New.  

QuickBooks displays the New Payroll Schedule window.  

 

3. Type Weekly in the “What do you want to name this payroll schedule?” field. 

4. Press Tab and select Weekly as the pay frequency.  

5. Press Tab and select 12/31/2014 as the pay period end date.  

 A pay period is the duration of time for which you are paying your employee wages. The pay 

period end date is the last date of the pay period you have specified for a specific pay schedule. It 

is the last date of the pay period that you want this pay cheque to cover. QuickBooks uses this date 

to calculate how many weeks an employee has worked in a year and the time information to 

include in the pay cheque.  

6. Press Tab and select 12/31/2014 as the date that should appear on the cheques.  
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 The cheque date is the date when employees know they are getting paid. It is the date you want the 

pay cheque to affect your bank account. For example, your pay period end date could be Friday, 

April 14, but your pay cheque date is 5 business days later on the following Friday, April 21. The 

CRA bases your tax liability and that of your employees on the cheque date  

 Your screen should resemble the following graphic. 

 

7. Click OK. 

 

8. Click OK in the QuickBooks Information window. 

 QuickBooks displays the Payroll Schedule List with the Weekly pay schedule now in the list. 

9. Close the Payroll Schedule List.  

Now that you’ve set up the pay schedules, you can assign the hourly paid employees to the appropriate 

pay schedule. 



254 |  P a g e
 

13.7.4 Assigning employees to pay schedules  

To assign employees to a schedule, choose the payroll schedule on the Payroll Compensation Info tab 

of the employee record. (You can also assign employees during the Payroll Schedule Setup process, 

but for this exercise, we’ll use the employee records.) 

13.7.4.1 To assign a pay schedule: 

1. From the Employees menu, choose Employee Centre. 

2. Click the Employees tab if it is not already selected. 

3. Select Kelly Lawson and then click Edit Employee. 

4. Click Payroll Info. 

 

5. From the Payroll Schedule drop-down list, select Weekly to change the payroll schedule. 

 Kelly Lawson is an hourly paid employee who is now paid weekly. Notice that QuickBooks 

changes the Pay Frequency to weekly 

6. Click OK. 

7. Change each employee that falls under this payroll schedule as needed. 

13.7.5 Adding a new employee  

Suppose you have a new employee on the payroll, and want to add him to your records.  

13.7.5.1 To add a new employee: 

1. With the Employee Centre displayed, click New Employee. 

 QuickBooks displays the New Employee window. 

2. On the Personal tab, enter the employee data as shown below.  
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3. On the Address and Contact tab, enter the employee data as follows.  

 

4. Click the Employment Info. Tab. 

5. In the Hire Date field, enter 11/29/2014. 

6. Click Payroll and Compensation Info. 

7. In the Earnings section of the window, click the Item Name column, and select Hourly Rate from 

the drop down list and press Tab. (Notice that the Performance Bonus item is displayed already.)  

8. In the Hourly/Annual Rate column for the Regular Pay payroll item, type 15. Then press Tab. 

9. From the Pay Schedule drop-down list, choose Weekly.  
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The Payroll Info tab should look like the following.  

 

10. Click Taxes and TD1.  

 QuickBooks displays the Taxes for Michael M. White window. 

 QuickBooks automatically calculates the correct amount of income tax to withhold based on the 

information an employee has entered on their TD1 form. You need to copy the total claim 

amounts from the federal and provincial TD1 forms into QuickBooks using this tax window for 

each employee. 

11. Click OK.  

 QuickBooks returns to the New Employee window.  

12. Click OK.  

13. When QuickBooks asks whether you want to set up additional payroll information, click Leave As 

Is.  

QuickBooks returns to the Employee Centre, where the new employee’s name is now displayed.  

14. Close the Employee Centre.  

13.8 Running a payroll schedule  

QuickBooks lets you print payroll cheques in a batch based on payroll schedules. You may want to 

process the pay cheques of salaried employees in one batch, and do payroll for the weekly employees 

as another batch.  

13.8.1 To run a pay cheque:  

1. On the Home page, in the Employee area, click Payroll Centre.  

QuickBooks displays the Payroll Centre.  
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2. In the Pay Employees section, choose the Weekly pay schedule.  

 

3. Click Start Scheduled Payroll.  

QuickBooks displays the Enter Payroll Information Window. 

 

 Notice that QuickBooks has filled in the Pay Period Ends field and the Cheque Date field  

based on the Weekly pay schedule you set up.  

4. Click in the Hourly Rate column for Kelly Lawson’s name and enter 40.  

5. Click in the Hourly Rate column for Michael M. White’s name and enter 25.  

6. Click Continue. If a warning message regarding payroll calculations is displayed, click OK. 
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Your screen should resemble the following graphic.  

 

7. QuickBooks displays the Review and Create Pay Cheques window. To review an employee’s pay 

cheque, click the employee name.  

 

8. In the Employee column click Michael White. (Be sure to click the underlined link for the 

employee name.)  

9. Click OK at the two warning messages that occur.  

If payroll tax information is not up to date, QuickBooks cannot calculate the Federal and 

Provincial taxes. QuickBooks fills in the Employee Summary area of the Review Or Change Pay 

Cheque window, showing the gross regular pay and all of the deductions from Michael’s pay 

cheque. The net amount of the cheque appears at the bottom.  
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 Because payroll tax rates change regularly, your numbers will vary from this illustration. 

 The Company Summary area of the window shows company-paid taxes and contributions that 

don’t affect the amount of the pay cheque (company-paid benefits). 

10. Click Save & Close to return to the Review and Create Pay Cheques window.  

11. In the Review and Create Pay Cheques window, ensure Print pay cheques from QuickBooks is 

selected. 

12. Click Create Pay Cheques. If a warning message appears, click OK. 

 QuickBooks writes a payroll cheque for each employee in the weekly payroll schedule for the 

correct net amount, showing the deductions in the voucher area. QuickBooks confirms that you 

have created the pay cheques. You can then choose to print the pay cheques.  

13. You don’t want to print the pay cheques now, so click Close.  

14. Close the Payroll Centre.  

13.8.2 Viewing the paycheque 

QuickBooks records payroll cheques in your QuickBooks chequing account register. You can see the 

cheque by going to the register.  

13.8.2.1 To view the pay cheque from the register: 

1. From the Lists menu, choose Chart of Accounts. 

2. Double-click “Chequing.” 

QuickBooks displays the Chequing account register.  

3. Select the pay cheque transaction for Michael M. White, and click Edit Transaction.  
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 QuickBooks displays the Pay Cheque – Chequing window for Michael. Notice that the Pay 

Cheque Summary shows a summary of the cheque’s deductions. If you want to see the deductions 

that make up this total, you can click the Pay Cheque Detail button.  

 

4. Click Save & Close to close the Pay Cheque – Chequing window.  

5. Close the Chequing account register, but leave the Chart of Accounts open.  

13.8.3 Printing pay cheques and pay cheque stubs  

You can print pay cheques as you would any QuickBooks cheque. If you use voucher cheques, 

QuickBooks prints the payroll item detail in the voucher area. If you don’t use voucher cheques, you 

can print paystubs to give to your employees.  

13.8.3.1.1 To print a pay cheque:  

1. From the File menu, choose Print Forms, and then choose Pay Cheques.  

QuickBooks displays the Select Pay Cheques to Print window.  

2. In the First Cheque Number field, type 106 if necessary. 
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3. Make sure there’s a checkmark next to all the employee names, and then click OK. 

4. The Print Cheques window is displayed. This is where you choose the Cheque style and other 

options.  

 

5. Close the Print Cheques window. 

6. Click Cancel in the Select Pay Cheques to Print window. 

13.9 Tracking your tax liabilities  

Refer to Handout 10, “List of payroll expenses and liabilities.”  

As an employer, you need to track both payroll expenses and payroll liabilities. These are the company 

payroll expenses you need to track: 

 Employees’ gross pay  

 Company-paid payroll taxes, such as the employer portions of EI and CPP/QPP 
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 Company-paid benefits for employees, such as company-provided medical/dental plans  

QuickBooks uses an expense account called Payroll Expenses to track these actual costs to your 

company. (The funds you deduct from employee pay cheques aren’t considered an actual cost because 

they’re monies you’re holding for the government; they don’t come directly from your company 

assets.) Whenever you run your payroll, QuickBooks keeps track of your company’s expenses for each 

employee. You can then see totals for these expenses on the payroll summary by employee report and 

on the profit and loss statement.  

QuickBooks uses the Payroll Liabilities account (an Other Current Liability account) to track what you 

owe to the government. When you do your payroll, QuickBooks calculates how much you owe for 

each tax, deduction, or company contribution payroll item and records that information as a transaction 

in the liability account. This produces a record of how much tax you owe at any time, so you can plan 

to have the cash available for payment. When you pay your payroll taxes or other payroll liabilities, 

QuickBooks decreases the balance of the liability account.  

Look at the payroll expense and liability accounts, so you can see how QuickBooks recorded expenses 

and liabilities related to Michael White’s pay cheque.  

13.9.1 To display the payroll expenses QuickReport:  

1. In the Chart of Accounts window, select the Payroll Expenses account.  

2. From the Reports menu button, choose QuickReport: Payroll Expenses.  

3. From the Dates drop-down menu, choose Custom, enter 12/01/2014 in the From field, and 

12/31/2014 in the To field. Press Tab. 

 QuickBooks displays the QuickReport. You can scroll through the report to see the items paid by 

the company.  

 

4. Close the QuickReport.  

5. You can review other employee and earnings reports as summarized in the tip below.  
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The Employee Earnings Summary report summarizes the wages, taxes, 

and adjustments, the gross pay (total and adjusted), and the taxes 

withheld for each employee and the entire company. 

The Payroll Summary report shows information similar to the employee 

earnings summary report, but in a much different layout. The report has a 

column for each employee and a row for each payroll item. 

To create either of these reports, choose Employees & Payroll from the 

Reports menu. 

  

13.10 Paying payroll taxes  

As long as you have a valid subscription to QuickBooks Payroll Service, QuickBooks uses current tax 

tables to keep track of your tax liabilities as they accrue, so you know how much you owe at any time.  

13.10.1 Figuring out what you owe  

If you’re about to pay taxes or other liabilities, the PD7A report shows you how much to pay. Suppose 

you are ready to make a tax payment, and you want to see how much you owe.  

13.10.1.1 To create a PD7A report:  

1. From the Reports menu, choose Employees & Payroll, and then choose PD7A Report. 

2. In the Dates field, select Custom, type 01/12/14 in the From field and 12/31/2014 in the To field. Press Tab. 

QuickBooks displays a report that shows what you owe for each payroll item by month, as well as 

the balance.  

 

3. Close the report. 

4. Click No at the message asking if you’d like to memorize the report. 
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13.10.2 Writing a cheque for payroll taxes  

QuickBooks recommends that you set up scheduled tax payments for your payroll taxes. But you can 

also make an unscheduled tax payment if, for example, you don't have an active QuickBooks Payroll 

subscription, you have a payroll tax that isn't set up as a scheduled payment, or you need to make an 

adjustment to a payroll tax.  

When it’s time to deposit payroll taxes with your deposit institution, use the Liability Cheque window 

to fill out a QuickBooks cheque.  

Note:  Don’t just open the Write Cheques window and write a cheque 

from there. QuickBooks can’t properly adjust your Payroll 

Liabilities account unless you use the Pay Liabilities feature. 

13.10.2.1 To pay payroll liabilities:  

1. From the Employees menu, choose Payroll Liabilities, and then click Pay Payroll Liabilities. 

 QuickBooks displays the Select Date Range For Liabilities window.  

 In the “From” field type 12/01/2014, and then type 12/31/2014 in the “Through” field.  

 

2. Click OK. 

 QuickBooks displays the Pay Liabilities window. Ensure the Payment Date is 12/31/2010. 

 

3. Click in the column to the left of the CPP-Company payroll item.  
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 QuickBooks places a checkmark in the column to show that the item will be paid. It also places 

checkmarks next to EI and Federal Income Tax items.  

4. Make sure “Review liability cheque to enter expenses/penalties” is selected and then click Review. 

 QuickBooks displays the Liability Cheque - Chequing window, with your cheque displayed. 

 

5. In the Memo field, type BN 123456789 as a reference number for the CRA. 

6. Click Save & Close to record the cheque.  

7. Click Yes if QuickBooks asks if you wish to record changes made to this transaction.  

Whenever you make a payment and record your cheque this way, QuickBooks decreases the balance of 

the Payroll Liabilities account.  

When you record the transaction, QuickBooks creates a journal entry. The following table shows the 

journal entry for the payroll liability transaction.  

Account Title  Debit Credit 

Chequing   $573.80 

 Payroll Liabilities  $573.80  

13.10.3 Preparing T4 slips 

At the end of the year, you’ll need to provide T4 slips for your employees and the CRA. QuickBooks 

can help you create these. 
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13.10.3.1 To create a T4 slip: 

1. From the Employees menu, select Payroll Forms, then Process T4s.  

QuickBooks shows the Process T4s window. If a warning message appears, click OK. 

2. Check that the Year drop-down menu is showing the correct year (for this example, 2010 – though 

usually you would want the year that just finished). 

3. Click in the checkmark column to the left of the employees paid in the year. 

 

4. Click the Review button to review the employee’s T4’s.  
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Notice that the information on the T4 summarizes the information from the pay cheques processed 

for the employees. If you’re not sure what a box on this form is for or how amounts should be 

entered, click the Help button, then you can find out more about individual boxes. The online help 

contains a good deal of information about how T4 slips should be completed. 

5. Double-click the EI Premium box (Box 18). 

 

 In the Adjustments window, you can adjust amounts on the T4 slip, if necessary, and enter a 

memo to remind you why you made the adjustment (the Description field). The amount you enter 

is added to what is already showing on the T4 (the amount field). To decrease the amount on the 

T4, you would enter a negative number. 

6. Click Cancel. 

7. Click OK to close the Employee T4 window. 

You are returned to the Process T4s window. 

8. Click Print  –  

In the Print T4s window, choose the printer you want to use and the printer type. 

You can then choose whether to print on blank paper (the default if you have an inkjet or laser 

printer), or pre-printed, multipart forms from the CRA. Finally, you select who you are printing 

the forms for: the CRA, your own records, or to give to the employee. 
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9. Close the Print T4s window and click OK in the Reminders window. 

10. Close the Process T4s windows. 

13.10.3.2 Preparing a T4 summary report 

When you file the T4s you created for your employees, you need to include a T4 Summary that totals 

the amounts on all the T4 slips. You can use a report to fill in your T4 Summary form quickly. 

13.10.3.2.1 To create a T4 summary report: 

1. From the Reports menu, choose Employees & Payroll, then T4 Summary.  

QuickBooks displays a summary of your T4s. 

 

2. For this example, ensure This Calendar Year is selected in the Dates field.  

 When you work with your own company file, you will likely want to select “Last Calendar Year” 

when you use this report. 

 You can now use the information in the report to fill in the T4 Summary form. 

If you want to print the report, click Print in the report button bar. 

3. Close the report. 
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14 Lesson 13: Estimating and Progress Invoicing 

14.1 Lesson objectives  

 To learn how to create job estimates  

 To find an estimate in a data file  

 To learn to duplicate an existing estimate  

 To create an invoice from an estimate  

 To display project reports for estimates  

 To update a job’s status  

 To make an estimate inactive  

14.2 Supporting materials  

 PowerPoint file: Lesson 13  

14.3 Instructor preparation  

 Review this lesson, including the examples, to make sure you’re familiar with the material.  

 Ensure that all students have a copy of qblesson.qbb on their computer’s hard disk.  

14.4 To start this lesson  

Before you perform the following steps, make sure you have installed the exercise file (qblesson.qbb) 

on your hard disk. See “Installing the exercise file” in the Introduction to this guide if you haven’t 

installed it. 

The following steps restore the exercise file to its original state so that the data in the file matches what 

you see on the screen as you proceed through each lesson. 

14.4.1 To restore the exercise file (qblesson.qbb): 

1. From the File menu in QuickBooks, choose Open or Restore Company. 

QuickBooks displays the Open or Restore Company window.  

2. Select Restore a backup copy and click Next.  

3. Select Local backup and click Next.  

4. In the Open Backup Copy window, navigate to your C:\QBtrain directory.  

5. Select the qblesson.qbb file, and then click Open.  

6. In the Open or Restore Company window, click Next.  

7. Navigate to your C:\QBtrain directory.  
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8. In the File name field of the Save Company File as window, type lesson 13 and then click Save.  

9. Click OK when you see the message that the file has been successfully restored.  

14.5 Creating jobs and estimates  

An estimate is a description of work or products you propose to sell to a current or prospective 

customer. You can create multiple estimates for each name (customer or customer:job combination). If 

the customer accepts an estimate, you can turn the estimate into an invoice, modifying it as necessary. 

When you have actual costs and revenues, you can compare them to your estimated costs and revenues 

to see if you were over or under the estimate.  

Estimates are “non-posting” transactions—they do not affect any financial reports or income and 

expense balances. QuickBooks allows you to create invoices from estimates either by transferring the 

entire estimate to an invoice or by allowing you to choose a percentage or selected items to invoice 

from the estimate. The ability to bill for only a percentage of the estimate or selected items on an 

estimate is called progress invoicing.  

When you create a new QuickBooks company using the EasyStep Interview, QuickBooks asks you if 

you use estimates and/or progress invoicing. If you respond yes, QuickBooks turns on these features 

for you. If you respond no, you need to turn on these features in order to use them. White Ridge 

Construction already has estimates and progress invoicing turned on, but you’ll review how to do this 

so you become familiar with QuickBooks preferences.  

14.5.1 Turning on estimates and progress invoicing  

14.5.1.1 To turn on estimates and progress invoicing:  

1. From the Edit menu, choose Preferences.  

2. Click Jobs & Estimates in the left panel.  

3. Click the Company Preferences tab to display the job and estimate preferences. 

 QuickBooks displays the Jobs & Estimates section of the Preferences window.  

4. Click Yes for “Do You Create Estimates?”  

5. Click Yes for “Do You Do Progress Invoicing?”  
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6. Click OK to record your selections and close the Preferences window.  
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If your industry uses a term other than “estimate” (for example, “bid” or 

“proposal”), you can change the title that appears on the QuickBooks 

estimate form. 

To change the title of the form: 

1. From the Lists menu, choose Templates. 

2. In the Templates list window, click the Templates menu button and choose New. 

3. In the Select Template Type window, select Estimate and click OK. 

4. In the Basic Customization window, click the Manage Templates button. 

5. In the Template Name field, enter a name for the template and click OK. 

6. Click the Additional Customization button. 

7. In the Additional Customization window, enter the title you want (Proposal, for 

example) in the field next to the Title checkbox (this is the first field on the 

Header tab). Click OK. 

8. If the Layout Design message window appears, click OK. 

9. Click OK again to save the template. 

10. Close the Templates list window. 

 

  

14.5.2 Creating a new job  

With the estimates feature turned on, you can add a new job for a bathroom remodel project for your 

customer, Jeremy Greene. Then you’ll create an estimate for the job.  

14.5.2.1 To create a new job: 

1. Click Customer Centre on the icon bar. 

2. In the Customers & Jobs list, select Greene, Jeremy. 

3. Click the New Customer & Job menu button, and then choose Add Job.  

QuickBooks displays the New Job window.  
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4. In the Job Name field, type Bathroom remodel.  

5. Click OK. QuickBooks returns you to the Customer Centre. The new job displays in the Customer 

& Jobs list.  

   

 

14.6 Writing an estimate 
Now that you’ve created a new job for the bathroom remodel, you can create an estimate  

for it.  

14.6.1 To create an estimate:  

1. In the Customers & Jobs list, if necessary, select Greene, Jeremy: Bathroom remodel.  

2. Click the New Transactions menu button, and then choose Estimates.  

Click this button to expand 

 the Customers & Jobs list 
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 QuickBooks displays the Create Estimates window for this customer and job. You learned in 

Lesson 6 how to fill out an invoice form, so this form should look familiar.  

3. Press Tab to accept Greene, Jeremy:Bathoom remodel in the Customer:Job field.  

 Notice that QuickBooks enters the customer’s name and address in the appropriate area of the 

form.  

4. If necessary, select “Custom Estimate” in the Template field.  

 

5. Click in the Item column in the middle of the form.  

 A down arrow appears, indicating that a drop-down list of choices is available.  

 The Item list, which contains all the services and goods your business provides, is the same list 

that is available to you on invoice forms and throughout QuickBooks. 

6. Select Direct Labour:Demolition Labour from the Item drop-down list. If the Sales Tax Codes 

message window appears, click OK. 

7. Press Tab twice to move to the Qty column.  

8. Type 10 in the Qty column, and then press Tab and type 35.00 in the Rate column. Press Tab.  

 The total amount is calculated by QuickBooks when you move out of this field.  

9. Click the line under “Demolition Labour” in the Item column.  

10. Choose Direct Labour:Framing Labour.  

11. Press Tab twice to move to the Qty column, type 40, Tab and type 25 in the Rate column. 

Press Tab.  

12. In the line under Framing Labour in the Item column, select Direct Materials - 
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Heading:Framing Materials.  

13. Press Tab three times to move to the Rate column, and then type 2500.  

14. Press Tab to move to the Markup column.  

15. Type 15%, and then press Tab twice.  

 

 Notice that QuickBooks has filled in most of the information for the estimate based on the items 

selected.  

16. Click Save & Close to save the estimate. 

14.7 Creating multiple estimates  

Just as you’ve completed the estimate for this customer, he calls and asks you to prepare a second 

estimate for the same job. He’d like you to price a couple of different options.  

14.7.1 Finding estimates  

Because you just created the estimate, you can open the Create Estimates window and press the Prev 

button and that will take you to the correct estimate. However, when you don’t know where an 

estimate is, there are a couple of methods you can use to locate the estimate you want quickly. You’ll 

use one of them here.  

14.7.1.1 To find an estimate:  

1. From the Customers menu, choose Create Estimates.  

2. Click Find on the button bar. 

 QuickBooks displays the Find Estimates window. 
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3. In the Customer:Job drop-down list, select Greene, Jeremy:Bathroom remodel. 

4. Click Find. 

 QuickBooks displays the estimate that you’ve already created for this job (Estimate # 6).  

5. Keep the estimate open; you’ll use it in the next exercise.  

14.7.2 Duplicating estimates  

Your customer wants you to prepare a second estimate for the bathroom remodel job because he is 

considering buying the cabinets from you in addition to having you do the installation work.  

First, you’ll create a duplicate of the original estimate, and then make the modifications necessary for 

the second bid.  

14.7.2.1 To create a duplicate of an existing estimate:  

1. Right-click in the body of the estimate (not in the item list area) and choose Duplicate Estimate 

from the list that displays. Click OK at the QuickBooks information window that displays. 

 QuickBooks duplicates the estimate and displays the new version on your screen. Notice that 

QuickBooks assigns the next available estimate number to the new form.  

 

2. Click in the Item column in the line below Framing Materials, and select Materials 
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Heading:Cabinets:Cabinet Wall Unit from the drop-down list.  

3. Press Tab twice and type 6 in the Qty column.  

4. In the Mark-Up column, type 15%, press Tab 

5. Click in the Item column in the line below Materials Heading:Cabinets: Cabinet Wall Unit and 

select Materials Heading:Hardware:Door Pulls from the drop-down list. 

6. Press Tab twice and type 12 in the Qty column.  

7. Press Tab twice and type 15% in the Mark-Up column. 

8. Press Tab 

 Your estimate should look like the following figure.  

 

9. Click Save & Close.  

14.8 Creating an invoice from an estimate  

Once you have created an estimate and the customer has approved it, you can use the estimate to 

invoice the customer. In this exercise, you’ll be using the QuickBooks progress invoicing feature.  

Progress invoicing (also known as progress billing), lets you invoice for jobs that you work on and 

complete in phases. When using progress invoicing, you start by creating an estimate for the job (you 

don't have to give this estimate to the customer). Then, as you complete each phase, you can easily 

transfer items from the original estimate to an invoice. You can specify which items to include on each 

invoice and change estimated amounts or percentages. When you use estimates to create progress 

invoices, you can run reports to help you track your estimated versus actual costs.  

14.8.1 To create an invoice from an estimate:  

1. Click Customer Centre on the icon bar.  
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2. In the Customers & Jobs list, select Greene, Jeremy: Bathroom remodel.  

3. Click the New Transactions menu button, and then choose Invoices.  

 QuickBooks displays the Create Invoices window.  

4. Press Tab to leave the Customer:Job field. 

 QuickBooks displays a list of estimates created for this job. 

 

5. The customer accepted the first estimate you created, so select estimate number 6, and click OK. 

 QuickBooks displays the Create Progress Invoice Based On Estimate window. 

 

 White Ridge Construction typically bills for one-third of the job before starting work, one-third 

when the project is one-third complete and the final one-third when the job is completed.  

6. Select “Create invoice for a percentage of the entire estimate.”  

7. Type 33.333 in the “% of estimate” field. 

 If you need to invoice for only selected items on an estimate or for varying percentages or 

amounts for different items, select the option “Create invoice for selected items or for different 

percentages of each item.” QuickBooks then displays a table of all items on the estimate and 

allows you to select which items you want to include and the amounts for each item.  

8. Click OK.  

 QuickBooks completes the invoice for one-third of each item on the estimate. Your invoice should 

resemble the following figure.  
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 Notice that QuickBooks changed the invoice template to Progress Invoice. QuickBooks also tracks 

that one-third of the Green kitchen renovation job has been invoiced and that two-thirds has not 

yet been invoiced.  

Note:  If you want your customers to see more detail on the invoice 

you send them, such as Estimate Amount, Prior %, and 

Current % you can customize the invoice template to add 

some of these columns from the printed form. See Lesson 15, 

“Customizing forms and writing QuickBooks Letters,” for 

more information. 

9. Click Save & Close to record the invoice.  

10. Close the Customer Centre.  

14.9 Displaying reports for estimates  

QuickBooks provides five reports on estimates, as described in the following table. You can create 

these reports from the Jobs, Time & Mileage submenu of the Reports menu.  

Report  Description  

Job Estimates vs. Actuals Summary  Compares estimated cost to actual cost and 
estimated revenue to actual revenue for all 
customers and jobs.  

Job Estimates vs. Actuals Detail  
(for one job)  

For a particular customer or job, compares 
estimated costs to actual costs and estimated 
revenues to actual revenues.  

Job Progress Invoices vs. Estimates  Compares each estimate with progress invoices 
based on the estimate.  

Item Estimates vs. Actuals  For each item, compares estimated cost to actual 
cost and estimated revenue to actual revenue.  

Estimates by Job  Lists all estimates by job.  
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14.9.1 Displaying the job progress invoices vs. estimates report  

Because you’ve just completed a progress invoice, you can see how QuickBooks records this on the 

job progress invoices vs. estimates report. This report shows job status, estimate total, total invoiced 

from the estimate on progress invoices, and the percentage of the estimate already invoiced on progress 

invoices.  

14.9.1.1 To display the job progress invoices vs. estimates report: 

1. From the Reports menu, choose Jobs, Time & Mileage.  

QuickBooks displays a submenu of project reports that deal with customer jobs and estimates.  

2. Choose Job Progress Invoices vs. Estimates. 

 QuickBooks displays the Job Progress Invoices vs. Estimates report. 

3. Choose Custom for the Dates field, then 12/01/2014 for the From field and 12/31/2014 for the To 

field, and then press Tab. 

Your report should look like the following figure. 

 

 Notice that the progress invoice you completed for Jeremy Greene is listed in the Progress Invoice 

column. The % Progress column shows how much of the total estimate you’ve invoiced for so far.  

4. Close the report window. Click No in the Memorize Report window. 

14.9.2 Making estimates inactive  

Now that the customer has accepted one of the estimates for the bathroom remodel job and you have 

started work, you might want to make the unaccepted estimate inactive. When you make an estimate 

inactive QuickBooks keeps a record of it, but does not use the numbers in reports.  

14.9.2.1 To mark an estimate inactive: 

1. From the Reports menu, choose Jobs, Time & Mileage. 

2. Choose Estimates by Job from the submenu.  

QuickBooks displays the Estimates by Job report.  
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3. Scroll to the section of the report that displays the estimates for Jeremy Greene. 

4. Double-click anywhere on the line for Estimate #7.  

 QuickBooks displays the estimate.  

 

5. Click Mark as Inactive.  

6. Click Save & Close.  

7. Answer Yes to the message asking if you want to save the changes you made to the transaction.  

8. Close the report.  
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15 Lesson 14: Tracking Time 

15.1 Lesson objectives  

 To learn how to track time worked on a project  

 To learn how to invoice a customer for time worked on a project  

 To create project reports for time tracking and learn about other project reports  

 To learn how to set up items used to track time worked by owners or partners  

 To learn how to pay nonemployees for time worked  

15.2 Supporting materials  

 PowerPoint file: Lesson 14  

15.3 Instructor preparation  

 Review this lesson, including the examples, to make sure you’re familiar with the material.  

 Ensure that all students have a copy of qblesson.qbb on their computer’s hard disk.  

15.4 To start this lesson  

Before you perform the following steps, make sure you have installed the exercise file (qblesson.qbb) 

on your hard disk. See “Installing the exercise file” in the Introduction to this guide if you haven’t 

installed it.  

The following steps restore the exercise file to its original state so that the data in the file matches what 

you see on the screen as you proceed through each lesson.  

15.4.1 To restore the exercise file (qblesson.qbb):  

1. From the File menu in QuickBooks, choose Open or Restore Company. QuickBooks displays 

the Open or Restore Company window.  

2. Select Restore a backup copy and click Next.  

3. Select Local backup and click Next.  

4. In the Open Backup Copy window, navigate to your C:\QBtrain directory.  

5. Select the qblesson.qbb file, and then click Open.  

6. In the Open or Restore Company window, click Next.  

7. Navigate to your C:\QBtrain directory.  

8. In the File name field of the Save Company File as window, type lesson 14 and then click 

Save.  

9. Click OK when you see the message that the file has been successfully restored.  
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15.5 Tracking time  

QuickBooks provides time tracking for any job. Time tracking lets you keep track of the time a person 

spends on each job (including vacation time and time spent for general overhead). The person whose 

time you track can be an employee, an owner or partner, or a subcontractor. 

You can use time data to do the following: 

 Invoice the customer for the time spent doing a job. 

 Provide hours worked on an employee's pay cheque or a cheque to a nonemployee (vendor, 

owner, or partner).  

 Track the cost of employees’ gross pay by job.  

 Report on the number of hours worked—by person, by job, or by item.  

15.5.1 Turning on time tracking  

The following procedure shows how to turn on the time tracking feature, (it is already turned on in the 

exercise file).  

15.5.1.1 To turn on time tracking:  

1. From the Edit menu, choose Preferences.  

2. Click Time & Expenses in the left panel. Then click the Company Preferences tab. 

 QuickBooks displays the Time Tracking Preferences window.  

 

3. Make sure Yes is selected as the answer to the question “Do You Track Time?”  

4. Click OK to save the preference setting.  
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15.5.2 Entering time data  

There are three ways to get time data into a company file: 

 Enter time directly onto a weekly timesheet or single activity form in QuickBooks.  

 Use the Stopwatch to time an activity while you are performing it.   

When you track time with QuickBooks, you have a choice of two forms to enter time: Weekly 

Timesheet or Time/Enter Single Activity window. If you want to enter time for multiple jobs or 

multiple days, then the Weekly Timesheet is the best choice.  

You can access time sheets by clicking on Enter Time in the Employee area of the Home page, and 

then choosing which Timesheet you require. 

 

A single activity entry shows the time spent by one person doing a single activity for a single job on a 

single date. If you tend to enter a lot of detailed notes about your activities, or you prefer to enter time 

data as you complete an activity, use the Time/Enter Single Activity window instead.  

For example, a lawyer could use a single activity entry to record the time he or she just spent on a 

phone conversation with a client.  
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Information you enter in the Time/Enter Single Activity window displays in the Weekly Timesheet, 

and vice versa. They’re different views of the same information.  

If you have employees who don’t have access to a computer or who don’t have access to QuickBooks, 

you can print blank copies of the weekly timesheet for your employees to fill out by hand.  

15.5.2.1 To print a blank timesheet:  

1. From the Employees menu, choose Enter Time and then choose Use Weekly Timesheet.  

QuickBooks displays the Weekly Timesheet window. 

2. From the Print drop-down menu, choose Print Blank Timesheet.  

3. In the Print Timesheets window, click Print. Close the Weekly Timesheet window. 

15.5.3 Recording employee time on a weekly timesheet  

In this exercise, you’ll complete a weekly timesheet for Reynaldo Lopez. In a later exercise, you’ll 

learn how to invoice a customer for the time Reynaldo spent working on a job for that customer.  

15.5.3.1 To enter information on a weekly timesheet:  

1. In the Employee area on the Home page, click Enter Time, and then click Use Weekly 

Timesheet. QuickBooks displays the Weekly Timesheet window.  

2.  In the Name field, select Reynaldo Lopez from the drop-down list.  

 QuickBooks will track the time you enter for this employee and display it when you are ready to 

pay employees.  

3. In the week of field, select Dec 8 to Dec 14, 2014. 

4. Click in the Customer:Job column, and then choose Uchman, Roy:2nd Story from the drop-

down list.  

 QuickBooks will associate the time that you enter in this window with the work being completed 

for Roy Uchman.  

5. In the Service Item column, select Direct Labour:Drywall Labour.  

 The Item list, which contains all the services and goods your business provides, is the same list 

that is available to you on invoice forms and Direct Labour:Drywall Labour throughout 

QuickBooks.  

6. In the Payroll Item column select Hourly Rate.  

 Reynaldo Lopez is paid by the hour. QuickBooks has his hourly rate stored in the Employee 

Centre, on the Payroll Info tab in the Edit Employee window.  
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Tip:  If you try to select a payroll item that is not associated with this 

employee, QuickBooks displays a warning message. For example, 

if you try to select Salary as the payroll item for Reynaldo Lopez, 

QuickBooks tells you that you do not have that type of payroll item 

set up for the employee. (It still lets you make the selection, but it 

warns you that the Salary is set up with a $0.00 rate.) 

7. Click in the M 8 column for the row in which you entered Roy Uchman’s job.  

 M stands for Monday and 8 for the date, Monday, the 8th of December, 2014. Note that you can 

change the first day of your work week in the QuickBooks time tracking preferences. (From the 

Edit menu, choose Preferences, and then click Time Tracking.)  

8. Type 8 to enter the number of hours worked on Monday.  

9. In the Tu field, type 8.  

10. In the W field, type 8, and then press Tab.  

 As you enter hours for each day, the Total column displays the total hours for the week. 

 Your screen should resemble the figure below. 

 

 The Billable column to the right of the Total column tells QuickBooks if the time will be 

transferred onto an invoice. A checkmark in the field indicates that you do want to invoice the 

customer for time worked.  

 If you do not plan on invoicing the customer for time worked, you can click the checkbox to 

remove the checkmark.  

11. Click Save & Close to record the Weekly Timesheet.  

 QuickBooks records the time for Reynaldo Lopez and for Roy Uchman’s 2nd Story job.  

This time can now be transferred onto an invoice for Roy Uchman’s 2nd Story job and to create a 

pay cheque for Reynaldo Lopez.  



286 |  P a g e
 

15.6 Invoicing a customer for time  
Now you can invoice Roy Uchman for the time White Ridge Construction’s employee, Reynaldo 

Lopez, spent on the 2nd Story job.  

15.6.1 To invoice a customer for time: 

1. On the Home page in the Customers area, click Create Invoices. 

2. Select Uchman, Roy:2nd Story job as the Customer:Job. 

 

3. In the Billable Time/Costs window, make sure the first option is selected and click OK. 

The Choose Billable Time and Costs window is displayed.  

4. Click beside the three entries for Reynaldo Lopez. 

 

Note:  QuickBooks can combine time for activities that have the 

same service item, and list them as one line item on the 

invoice instead of individual line items. In the Options for 

Transferring Billable Time window, you can also select to 

transfer notes about time activities (in addition to 

descriptions) onto invoices. 
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For this exercise, you’ll choose to show the activities as one line item on the invoice. 

5. Click the Options button and select Combine activities with the same service item and rate. 

 

6. Click OK. Then click OK again to close the Choose Billable Time and Costs window. 

7. If necessary type 12/31/2014  in the Invoice Date field. 

8. From the Template drop-down list, select Intuit Service Invoice.  

 The top part of the invoice should resemble the figure below.  

 

9. Keep the invoice open. You’ll use it in the next exercise.  

15.6.2 Creating an invoice from a list of time and expenses 

You can invoice for time and expenses using the procedure described in the previous exercise, in 

which you start by creating an invoice for a customer and then choosing which time and expenses for 

that customer to add to the invoice. 

QuickBooks also provides a list of all billable time and expenses by customer and job that you can use 

as the starting point for billing customers. 

15.6.2.1 To display a list of time and expenses for all customers: 

1. From the Edit menu, choose Preferences. 

2. Click Time & Expenses in the list on the left, and then click the Company Preferences tab. 

3. Click to select the “Create invoices from a list of time and expenses” checkbox. 
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4. Click OK. 

When you turn on this preference, QuickBooks adds a new item to the Customers menu and a 

drop-down menu next to the Invoice icon on the Home page. You can use either option to open the 

Invoice for Time & Expenses window. 

15.6.2.1 To invoice from a list of time and expenses: 

1. From the Customers menu, choose Invoice for Time & Expenses. Click OK on the message for 

Choose Multiple customers to Invoice for Time and Expenses. 

QuickBooks displays a list of all billable time and expenses for all customers and jobs. Note that 

the amounts are broken down by category: time, expenses, mileage, and items. 
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2. Select the customers that you would like to invoice. In this example, Select Allin Hilda:600 sq ft 

Addition. 

3. Click Create Invoice to invoice Hilda for all outstanding billable items for this job. 

QuickBooks creates an invoice that includes all billable items for the 600 sq ft addition for Hilda 

Allin. 

 

If you wanted to include only some of the items on the invoice, you would select the 

“Let me select specific billables for this Customer:Job” checkbox in the Invoice for Time & 

Expenses window. This would allow you to add items to the invoice from the Choose Billable 

Time & Costs window.  

4. From the Template menu, ensure Intuit Service Invoice is selected. 

5. Click Save & Close. Click No if the Available Credits window is displayed. 

6. Close the Invoice for Time & Expenses window. 

15.6.3 Displaying project reports for time tracking  

QuickBooks provides four reports on time, as described in the following table. You can create these 

reports by choosing Jobs, Time & Mileage from the Reports menu.  

Project report  Description  

Time by Job Summary  
Shows hours worked subtotaled first by customer or job and 
then by service item.  

Time by Job Detail  

Lists each time activity (that is, work done by one person for a 
particular customer or job on a specific date), and shows 
whether the work is billed, unbilled, or not billable. The report 
groups and subtotals the activities first by customer and job 
and then by service item.  



290 |  P a g e
 

Time by Name  

Shows hours worked (or tracked as sick or vacation time), 
subtotaled first by the name of the person who performed the 
work and then by the customer or job the person performed 
the work for.  

Time by Item  
Shows the hours worked, subtotaled first by service item and 
then by customer or job.  

15.6.4 Displaying the time by job report  

The time by job summary report summarizes the total hours for each job, and the time by job detail 

report breaks down those summary figures into hours for each service item and hours for each 

customer:job.  

15.6.4.1 To create a time by job report: 

1. From the Reports menu, choose Jobs, Time & Mileage.  

2. From the submenu, choose Time by Job Summary. 

 QuickBooks displays the Time by Job Summary report. 

3. In the Dates field, choose Custom, and the range from 12/01/2014 to 12/31/2014. 

 

 Notice that the report shows the 24 hours for Drywall Labour work performed by Reynaldo 

Lopez.  

15.6.5 Viewing time data in more detail  

Like all QuickBooks reports, you can QuickZoom any of the numbers in a report to see more detail.  

15.6.5.1 To view time data details:  

1. Position your mouse pointer over the 24 hours for Drywall Labour on the Uchman, Roy: 2nd Story 

job, and then double-click.  

 When you position your mouse pointer over the number, the pointer changes into a magnifying 

glass with a Z in it. After you double-click, QuickBooks displays a Time by Job Detail report for 

the time data you selected. (This functionality is called QuickZoom.)  
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 You can see that Reynaldo Lopez did the work and the time has already been billed to the 

customer.  

2. Close the Time by Job Detail report. 

3. Close the Time by Job Summary report.  

15.6.6 Displaying other project reports  

In addition to the estimate and time reports, QuickBooks provides several project reports to track job 

profitability, as described in the following table.  

Project report  Description  

Job Profitability Summary  

Compares the actual cost to the actual revenue for all 
customers and jobs. The report subtotals the data first by 
customer and then by job.  

Job Profitability Detail (for 
one customer:job)  

For a particular customer or job, compares actual costs to 
actual revenues and shows the difference between the two 
amounts. The report subtotals the data first by item type and 
then by item.  

Item Profitability  

For each item, compares the actual cost to actual revenue 
and shows the difference between the two amounts. The 
report subtotals the data first by item type and then by item.  
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15.7 Paying nonemployees for time worked  
When the company file has time data for a person who is not on your payroll, you can write cheques 

based on the time worked. QuickBooks can transfer time data for a specified date range to a cheque. 

QuickBooks prefills the Items tab of a cheque with information from the time data, including hours 

worked and rate.  

You can pay a subcontractor, owner, or partner for time worked. The person must be on one of the 

following lists:  

 Vendor (appropriate for subcontractors, especially if you must report payments to them on Form 

T5018)  

 Other Names (appropriate for owners and partners)  

Note:  To pay an ordinary employee for time worked, use the payroll 

feature to write a pay cheque. 

15.7.1 Creating service items for subcontractors, owners, or partners  

When you use service items for subcontractors, QuickBooks records expenses and income for the work 

in separate accounts. You can use such items on both purchase forms and sales forms. 

In this section, you learn how to do the following: 

 Set up a service item to use to track work performed by a subcontractor 

 Enter time worked for a subcontractor 

 Prepare a cheque to pay a subcontractor for time worked 

15.7.1.1 To set up a service item for subcontractors: 

1. From the Lists menu, choose Item List. 

2. Click the Item menu button, and choose New. 

3. In the Type field of the New Item window, choose Service from the drop-down list. 

4. In the Item Name/Number field, type Planning & Estimates. 

5. Select the “This service is used in assemblies or is performed by a subcontractor or partner” 

checkbox. 

 QuickBooks changes the window to display fields for sales and purchase information. 
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6. In the Description on Purchase Transactions field, type Job Planning & Costing and press Tab. 

 QuickBooks copies the text into the Description on Sales Transactions field.  

7. In the Cost field, type 50 and press Tab.  

8. In the Purchase Tax Code, select G. 

9. From the drop-down list in the Expense Account field, choose Subcontractors. 

Note:  If you pay owners (or partners) for time worked, you need a 

service item that records the cost of the work as a draw 

against equity, rather than an expense. 

10. In the Sales Price field, type 90.  

11. In the Tax Code drop-down list, select G.  

12. In the Income Account field, Construction Income and press Tab.  

 Your screen should now look like this. 
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13. Click OK to close the New Item window. 

14. Press Esc to close the Item List window. 

In the next section, you learn how to use the Planning & Estimates item you’ve just created to track 

time performed by a subcontractor for White Ridge Construction.  

15.7.2 Recording nonemployee time worked  

You record data for time worked by nonemployees the same way you enter it for employees.  

15.7.2.1 To enter time for nonemployee time worked:  

1. From the Employees menu, choose Enter Time., and then choose Time/Enter Single Activity from 

the submenu.  

 QuickBooks displays the Time/Enter Single Activity window.  

 

2. In the Name field, choose Rick’s Plumbing from the drop-down list.  

Note:  When you selected the subcontractor’s name, QuickBooks 

removed the Payroll Item field from the window. (When class 

tracking is on, this field is replaced with the class field.) 

Owners and partners should be set up on the Other Names 

list, because they are also not paid with payroll cheques. 

3. In the Customer:Job field, choose Allin, Hilda:600 SQ Ft Addition.  

4. In the Service Item field, select Planning & Estimates from the drop-down list and press Tab.  

5. Type 8 in the Duration field and press Tab.  
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Your screen should resemble the following.  

 

6. Make sure that the date is set to 12/31/2014 and click Save & Close.  

15.7.3 Preparing a cheque to pay for nonemployee time worked  

In this section, you’ll learn how to create a cheque to reimburse a subcontractor for time worked on a 

specific job. 

15.7.3.1 To write a cheque for time worked:  

1. On the Home page in the Banking area, click Write Cheques. 

 QuickBooks displays the Write Cheques window.  

2. Make sure that Chequing is selected in the Bank Account field. 

3. If necessary, click to put a checkmark in the “To be printed” checkbox. 

4. In the Pay to the Order of field, choose Rick’s Plumbing from the drop-down list. 

5. Click Yes at the message QuickBooks displays asking if you want this cheque to pay for time 

worked.  

 QuickBooks displays the Select Time Period window.  

 

6. Type 12/01/14 in the Start Date field and press Tab.  

7. Type 12/31/2014 in the End Date field and click OK. 

 QuickBooks prefills the Items tab of the cheque with information from the time data, including 

hours worked and rate. 
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 Notice that time activity is marked nonbillable so that it is not billed twice—as a time activity and 

an item. 

8. Click Save & Close in the Write Cheques window.  

When you record the transaction, QuickBooks creates a journal entry. The following table shows the 

journal entry for the cheque.  

Account Title  Debit Credit 

Chequing   $420.00  

 Subcontractors  $400.00   

 GST Paid on Purchases $  20.00  
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16 Lesson 15: Customizing Forms in QuickBooks 

16.1 Lesson objectives  

 To learn how to modify a preset invoice form  

 To design 

  a custom invoice form  

 To see how to print invoices  

 To learn how to prepare a collection letter for overdue customers  

 To learn how to edit a prewritten letter in QuickBooks  

16.2 Supporting materials  

 PowerPoint file: Lesson 15  

16.3 Instructor preparation  

 Review this lesson, including the examples, to make sure you’re familiar with the material.  

 Ensure that all students have a copy of qblesson.qbb on their computer’s hard disk.  

16.4 To start this lesson  

Before you perform the following steps, make sure you have installed the exercise file (qblesson.qbb) 

on your hard disk. See “Installing the exercise file” in the Introduction to this guide if you haven’t 

installed it.  

The following steps restore the exercise file to its original state so that the data in the file matches what 

you see on the screen as you proceed through each lesson.  

16.4.1 To restore the exercise file (qblesson.qbb):  

1. From the File menu in QuickBooks, choose Open or Restore Company. QuickBooks displays the Open 

or Restore Company window.  

2. Select Restore a backup copy and click Next.  

3. Select Local backup and click Next.  

4. In the Open Backup Copy window, navigate to your C:\QBtrain directory.  

5. Select the qblesson.qbb file, and then click Open.  

6. In the Open or Restore Company window, click Next.  

7. Navigate to your C:\QBtrain directory.  
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8. In the File name field of the Save Company File as window, type lesson 15 and then click Save.  

9. Click OK when you see the message that the file has been successfully restored.  

16.5 About QuickBooks forms  

Each form you use in QuickBooks has its own layout—that is, its own arrangement of fields and 

columns for entering information. If the layout of a particular form doesn’t meet your needs, you can 

create your own custom layout and use your version instead of the QuickBooks version.  

In Lesson 6, you learned about the three preset formats for invoices: professional, service, and product. 

If these formats don’t precisely meet your needs, you can create your own invoice templates. You can 

also create templates for other sales and purchase forms.  

For each form, you can decide which fields and columns to include, what they are called, and where to 

place them. Once you have created your forms, you can save the new layouts as templates—to use 

whenever you wish, and to modify whenever you want. The forms you can customize in QuickBooks 

are the invoice, sales receipt, credit memo, statement, purchase order, estimate, and sales order 

(QuickBooks: Premier and higher editions only).  

16.6 Customizing invoices  

QuickBooks lets you customize an invoice form to suit the needs of your business, but there may be 

times when you want to design a completely different invoice form. QuickBooks lets you do that, too. 

You can use the Layout Designer to create a new form design for your business. In the Layout 

Designer, you can move, resize, or change the width of columns, turn borders around fields on or off, 

and control font type and size for each field.  

In the following exercises, you’ll use both the customize forms and Layout Designer features in 

QuickBooks to create a custom invoice.  

Note that these features affect only the printed forms; you cannot customize the onscreen version of 

QuickBooks forms.  

16.6.1 Creating new templates  

16.6.1.1 To create a new invoice template: 

1. From the Lists menu, choose Templates.  

 QuickBooks displays the Templates list.  
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2. Click the Templates menu button, and then choose New.  

 QuickBooks displays the Select Template Type window.  

 

3. Click OK to select the Invoice template. 
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 QuickBooks displays the Basic Customization window. 

 

4. Click the Manage Templates button to give the template a name.  

5. In the Template Name field, type My Invoice and click OK.  

 This is the name you’ll use for the new template.  

6. Look at the options in the Logo & Fonts section of the Basic Customization window.  

 Use this section to change the fonts for various textual elements on the form and to choose a 

colour scheme. 

 If you wanted to add your company logo to the form, you would select the Use logo checkbox and 

tell QuickBooks which file to use. QuickBooks supports BMP, JPEG, TIFF, PNG, WMF, EMF, 

and GIF graphic formats.  

7. In the Company & Transaction Information section, select the Phone Number checkbox.  

 Use this section of the window to specify which pieces of company information to include on your 

sales and purchase forms.  

 QuickBooks displays a message that you can use the Layout Designer to change the layout of your 

form. You’ll learn how to use the Layout Designer later in this lesson.  



301 |  P a g e
 

8. Select the “Do not display this message in the future” checkbox, and then click OK.  

 Your window should look like the following graphic. 

 

 If you don’t want QuickBooks to print the status stamp (paid, pending, etc.) on forms, clear the 

Print Status Stamp checkbox on this tab.  

9. Leave the Basic Customization window open. You’ll use it in the next exercise.  

16.6.2 Customizing fields on forms  

You can further customize your invoice template by setting formatting options and changing how 

fields display.  

16.6.2.1 To customize fields on a template:  

1. Click the Additional Customization button at the bottom of the window.  

 QuickBooks displays the Additional Customization window, which uses multiple tabs to display 

several sets of formatting options. Each area of the form is represented by a tab. To display the 

available formatting options, click the tab for the area of the form you want to change. 

QuickBooks shows you a preview of the invoice as you make selections on the tabs.  
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 Notice that the Header tab is currently selected. The Header tab is where you select which fields 

you want to appear onscreen, on paper, both, or neither. You can specify your own title (label) for 

each field. You can enter a new title by highlighting the current title text and typing your new one.  

 If you want to track information about a particular invoice, but don’t want your customer to see 

this information, select the Screen checkbox and clear the Print checkbox.  

 Suppose you want to remind customers of payment due dates at the time you send the invoice. 

You can customize the invoice form to display the Due Date field.  

2. To have the Due Date field display both on screen and on the printed form, click the Screen 

checkbox for Due Date to select it.  

3. Click the Print checkbox for Due Date. 

 Checkmarks appear in both checkboxes. 

4. Clear the Screen and Print checkboxes for the P.O. No. field to remove the field from the form.  

 Notice that the invoice preview shows the changes you’ve made.  

16.6.3 Adding fields on forms  

The lower half of the standard QuickBooks invoice form is where you enter details about the items or 

services purchased by the customer. You can add fields to appear on your invoices.  

The Order column shows you how fields display from left to right on the invoice form. Currently, 

Description is the first column and Amount is the last column. Suppose you want the Item field to 

appear on the printed form.  

16.6.3.1 To add fields to a form: 

1. Click the Columns Tab. 
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2. Click in the Print box for Item. 
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The screen now shows the item column inserted before the description column. Note that the 

numbers in the Order column reflect the order in which the fields are displayed. 

16.6.4 Changing field order on forms 

Now that we have added a column to the form, suppose we wish the quantity field to appear after the 

item field, and before the description field. 

16.6.4.1 To change the order of fields on a form: 

1. Ensure the Columns tab is selected. 

 

2. Double-click the Order column in the Quantity row to select the number. 

3. Type 2, press Tab. 

4. Look at the Order column in the Description row. Note the change. (If it has not changed to 3 

automatically, type 3.) 
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Your screen should look like the following figure.  

 

 If you use progress invoices or sales orders, use the Prog Cols tab to customize the columns on 

those forms.  

5. Click the Footer tab. 

 The Footer tab contains information that you usually find at the bottom of the form. It also 

provides a place for you to enter free-form text, such as a disclaimer, on your form. In the next 

exercise, you’ll learn how to move fields on forms.  

6. Click the Print tab.  
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 Use the Print tab to associate print settings with individual form templates. For example, if you 

print most forms in Portrait mode, but have one form that you print in Landscape, you can 

associate the Landscape print setting with that form’s template. When you send the form to the 

printer, QuickBooks knows to print it in Landscape. 

 If your forms print on multiple pages, select whether or not you want to print page numbers.  

7. Click OK to record the changes made.  

8. Click OK again and then close the Templates window.  

16.6.5 Displaying your customized form  

Now display the customized form to see the changes you made in the previous exercise.  

16.6.5.1 To display the custom form: 

1. From the Customers menu, choose Create Invoices. 

 QuickBooks displays the Create Invoices window with a standard Intuit Invoice template 

displayed.  

2. In the Template field, choose My Invoice from the drop-down list.  

 

Notice how this form reflects the changes you made in the Customize Invoice window. The Due 

Date field now displays onscreen and the Qty column appears in its new order before the 

Description field.  

3. Leave the Create Invoices window open, you’ll use it in the next exercise.  
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16.7 Designing custom layouts for forms  

With the QuickBooks Layout Designer, you can change the design or layout of a form. In the Layout 

Designer, you can move, resize, change the width of columns, turn on or off borders around fields, add 

coloured backgrounds, and control the font type and size for each field.  

Here are a few examples of what you can do with a custom layout:  

 Give your company name, address, and logo special treatment on the form. For example, you 

could center your logo at the top of the form and put your company name and address in a 

special font immediately below the logo.  

 Enlarge a custom field so that it can display more information.  

 Position the customer’s billing address so that it coincides with the address window in the 

envelopes you use.  

 Change the borders on fields, add background colours, and add extra text fields.  

 Add multiple graphics to a form.  

16.7.1 Changing the position of fields on forms  

Next, you’ll use the Layout Designer to move the Phone # and Invoice To fields, and to decrease the 

width of the Quantity column.  

16.7.1.1 To move fields on forms:  

1. In the Create Invoices window, click the formatting tab, then click customize data layout icon (the 

icon with the pencil and ruler). (Don’t click the down arrow next to the customize icon; that 

displays a menu you won’t be using for this exercise.)  

 QuickBooks displays the Basic Customization window that you used to customize the form. 

 Now, you’ll use the Layout Designer to change the design of the form. 

 



308 |  P a g e
 

2. Click the Layout Designer button.  

 QuickBooks displays the Layout Designer window.  

 

 By clicking the Zoom buttons, you can zoom out to see an overall view of the form or zoom in for 

a closer look at a small section of the form.  

3. Click the Invoice To field.  

4. Press and hold the Shift key.  

 Holding down the Shift key when clicking on an object allows you to select multiple fields at the 

same time. Having multiple fields selected lets you move the fields together.  

5. Click the field directly below the Invoice To field (the field containing the words “This is sample 

text”). 

 Notice the four-directional arrow that appears when you move the cursor over the selected fields.  

 The selected fields on your screen should look like this. 

 

6. Release the Shift key.  
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7. With the cursor over the selected fields, press and hold the left mouse button.  

8. Drag the selected fields down about one inch.  

Note:  If you see that the fields are too wide to fit, deselect both fields by clicking 

outside the fields. Select each field separately. Move the mouse over the dark 

square along the right edges of the fields. Hold the mouse button and drag to 

the left to reduce the width of each field. 

9. Release the mouse button.  

 Your screen should now look like this.  

 

10. Select the field containing White Ridge’s address.  

11. Move the mouse over one of the dark squares on the bottom of the field and then hold the mouse 

button while you drag the bottom of the field up to a point just below the address—the goal being 

to get rid of the extra space below the address so you can place the phone number directly beneath 

it. 

12. Scroll to the bottom of the screen and select the Phone # field. 

13. Click Remove.  

14. Select the field containing the numbers 555-555-5555.  

15. Holding down the mouse button, drag the field so that it sits just below White Ridge’s address.  
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16.7.2 Changing field widths  

In the next exercise, you’ll change the font size for White Ridge’s phone number to make it match the 

address, but first you want to make the field wider so that the phone number isn’t cut off.  

16.7.2.1 To change the width of a field: 

1. Select the field containing the telephone number and drag the right border further to the right 

while holding down the mouse button.  

 The fields should resemble the figure below.  

 

 White Ridge Construction rarely enters a quantity greater than two characters, so you want to 

make the Qty column smaller. Decreasing the width of the Qty column also increases the width of 

the Description column.  

2. In the Layout Designer window, scroll until the Qty column is visible.  

3. Click the Qty column to select it.  

 Your screen should resemble the figure below.  

 

 Notice that when the cursor is positioned between the Qty and Description columns, it turns into a 

two-directional arrow.  

 

4. Click and hold the left mouse button on the line separating the Qty and Description columns.  

5. While holding down the mouse button, drag the column line to the left (to approximately ½ the 

original size).  

6. Release the mouse button.  

 The forms area on your screen should resemble the figure below.  
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16.7.3 Changing fonts, borders, and colours  

Using the Properties window in the Layout Designer, you can change font size and style, and text 

justification. You can also add, remove, or change the borders around fields.  

16.7.3.1 To change fonts, borders, and colours:  

1. With the Phone # field selected, click Properties. 

 QuickBooks displays the Properties window. 

 

2. On the Text tab, select Left for horizontal justification.  

3. Click Font.  

4. In the Size list, select 12, and then click OK.  

5. Click the Border tab.  

6. Click to remove the Top, Bottom, Right, and Left checkboxes.  

7. Click OK to save your changes in the Properties window. 

8. Click OK to save the changes in the Layout Designer. 

9. Click OK to close the Basic Customization window. 

This exercise covers only a portion of the changes you can make with the customization and layout 

tools. For example, if you wanted to add a background colour to the field, you could do so using the 

Background tab. You could use the Add button to add empty fields into which you can enter your own 

text—or to add data fields that you forgot to select in the Customize window. If you want a field to 

appear on a form more than once, select the field and click Copy.  

We encourage you to experiment with the tools available to create your own custom forms. For 

examples of what you can achieve, visit the forms library at http://www.quickbooks.ca/templates.  
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You can download templates from the forms library to use in your own business.  

16.7.4 Previewing new forms  

Notice that the invoice form displayed by QuickBooks doesn’t show the changes you just made in the 

Layout Designer. This is because changes made in the Layout Designer only affect the printed invoice 

and not the invoice QuickBooks displays onscreen for data entry.  

16.7.4.1 To preview the invoice:  

1. To see how the printed invoice form will look, click the Preview button (in the Formatting tab in 

the transaction ribbon) in the Create Invoices window.  

 QuickBooks displays the Print Preview window.  

 

 The invoice displayed in the Print Preview window shows exactly how the printed invoice will 

look. Notice that the changes you made in the Layout Designer are reflected in this preview.  

2. When you are finished looking at the preview, click Close.  

3. Press Esc to close the Create Invoices window without saving.  
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17 Lesson 16: QuickBooks: Premier Accountant Edition 

17.1 Lesson objectives 

 To get an overview of the features and benefits of using the QuickBooks: Premier Accountant 

Edition 

 To learn the specific features that are only available in this edition 

 To Learn how to use this version to manage client files 

17.2 Supporting materials  

 PowerPoint file: Lesson 16 

17.3 Instructor preparation  

 Review this lesson, including the examples, to make sure you’re familiar with the material. 

 Ensure that all students have a copy of qblesson.qbb on their computer’s hard disk. 

17.4 To start this lesson  

Before you perform the following steps, make sure you have installed the exercise file (qblesson.qbb) 

on your hard disk. See “Installing the exercise file” in the Introduction to this guide if you haven’t 

installed it.  

The following steps restore the exercise file to its original state so that the data in the file matches what 

you see on the screen as you proceed through each lesson.  

17.4.1 To restore the exercise file (qblesson.qbb):  

1. From the File menu in QuickBooks, choose Open or Restore Company. QuickBooks displays the Open 

or Restore Company window.  

2. Select Restore a backup copy and click Next.  

3. Select Local backup and click Next.  

4. In the Open Backup Copy window, navigate to your C:\QBtrain directory.  

5. Select the qblesson.qbb file, and then click Open.  

6. In the Open or Restore Company window, click Next.  

7. Navigate to your C:\QBtrain directory. 

8. In the File name field of the Save Company File as window, type lesson 16 and then click Save. 

9. Click OK when you see the message that the file has been successfully restored. 
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17.5 Overview of QuickBooks: Premier Accountant Edition  

There are thousands of small businesses who use QuickBooks across Canada. In order to support 

QuickBooks customers, Intuit has designed the QuickBooks: Premier Accountant Edition to help 

accountants, bookkeepers and QuickBooks consultants to better train, manage and support their 

QuickBooks clients.  

The QuickBooks: Premier Accountant Edition contains a list of features that are designed to do the 

following 

 Make communication with your client faster and more efficient 

 Make your accounting, consulting, or bookkeeping practice more efficient 

 Provide you with a set of features that lets you review and make changes effectively and 

efficiently for your client 

Most of these features are specific to the Accountant Edition. NOTE: The QuickBooks: Premier 

Accountant Edition is only available to members of the QuickBooks ProAdvisor Program. To learn 

more about this program visit, www.proadvisor.ca. 

17.6 Accountant Centre 

QuickBooks: Premier Accountant Edition contains a feature called the Accountant Centre. The 

Accountant Centre gives easy access to the QuickBooks features that accountants use most.  

17.6.1 Using the Accountant Centre 

17.6.1.1 To open the Accountant Centre:  

1. From the Accountant menu, choose Accountant Centre. QuickBooks displays the Accountant 

Centre.  
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2. Use the Tools section to perform the function. Click a link in the Tools section to use that feature.  

When you click a link, QuickBooks opens that feature.  

 

For example if you click the Make General Journal Entries link, QuickBooks opens the 

appropriate window 

 

3. To add or remove links from the Tools section, click the Customize link. This section includes 

tools also available in the Client Data Review. When you click Customize the following window 

appears 

 

4. Choose any tool from the Available Tools to Add column, and then click Add to add them to the 
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Tools section of the Accountant Centre.  

5. To Remove any tool from the Chosen Tools. Select the the tool to be removed and then click the 

Remove button. This feature lets you customize QuickBooks to fit your personal working style. 

Click OK.  

6. The Reconciliation section lets you easily reconcile your client’s accounts. For each bank or 

Credit card account in the company file, the Reconciliation sections shows the date of the last 

reconciliation, the reconciled balance, and the current balance. 

 

7. The Memorized Reports section lists memorized reports. Click the Select Group drop-down arrow 

to select a group from the memorized reports list. Click the Display Group button to view or print 

multiple reports. 

 

8. Click the links in the Accountant Updates section to stay up to date with Intuit updates from 

QuickBooks and the ProAdvisor program.  

 

9. If you want QuickBooks to open the Accountant Centre when QuickBooks starts select the Show 

Accountant Centre when opening accompany file option. 
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10. Close the Accountant Centre. 

17.7 Batch Transaction Entry 

The QuickBooks: Premier Accountant Edition lets you save time by entering multiple cheques, 

deposits and credit card charges and credits in a spreadsheet format. This is faster that using the 

transaction forms because you can determine which fields appear int eh widow and which order to 

match your source document.  

You can also copy and paste information from Excel or from one cell to another in the window.  

17.7.1 To Batch Enter Transactions:  

1. Choose Accountant, then click Batch Enter Transactions. QuickBooks displays the Batch Enter 

Transaction window 

 

2. Click the Transaction Type drop down arrow and select the type of the transaction you want to 

enter. You can only enter one type of transaction at a time.  

3. If you want to customize the view of the Batch Enter transactions window, click Customize 

Columns. This feature lets you choose the columns you want to work with. This will help you 

focus on the information you have to enter.  
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4. Add or remove columns to match your spreadsheet data. This window will be specific to the type 

of transaction you are working on. Click OK to save the changes.   

5. To add a transaction, click in the first row and enter the information. You can also copy data from 

Excel and paste it into the Batch Enter Transactions window.  

 

6. Click Save Transactions to enter the batch of transactions. 

7. Click Yes to confirm the account. Then click OK on the Transaction Saved message. 

8. Click Close. 

17.8 Client Data Review 

The Client Data Review Centre has features that automate tasks that you perform to fix errors in your 

clients’ books. By using the CDR, you can reduce the time it takes to clean up a client’s book 

significantly. The wrench icon indicates that the tool is a CDR tool. These tools are exclusive to the 

Client Data review. In the centre you can:  

 Customize and track the review tasks 

 Add review notes 

 Add notes to each task 

 Complete and print a review or summary 

 Mark the Review complete 

 The Sales Tax Payable register (GST or PST) 

 The File Sales Tax window (available in the Sales Tax menu) 
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17.8.1 Start the Client Data Review 

You can start the Client Data Review from the Accountant Centre or the Accountant menu.  

17.8.1.1 To start the Client Data Review:  

1. From the Accountant menu, choose Client Data Review, and then choose Client Data Review.  

 

2. Enter the dates for the review, then click Start Review. QuickBooks opens the Client Data 

Review. 

 

3. To use the client data review features. Click the link in the Cleanup Tasks column. QuickBooks 

opens the task window.  
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4. Click Troubleshoot Prior Account Balances to review the client account balances and any changes 

made since the last review. This tool uses balance from the previous period to find descrepancies.  

 
 

5. Click Reclassify Transactions. QuickBooks opens the Reclassify transactions window.  This 

feature is only available in the Client Data Review. This feature lets you re-categorize transactions 

from one account to another. It also lets you reclassify transactions to different classes. To use this 

feature, click Reclassify Transactions. 

Choose the account on the left hand side. QuickBooks displays the transactions in the right 

side of the window. Select the transactions to reclassify. Choose the account at the bottom 

of the window. Click Reclassify.  
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6. Another tool available in the CDR is the Review list changes. This tool lets you review the 

changes made to accounts, items, fixed assets and payroll items since the last review. Click the 

Chart of Accounts link. Review the changes made. After reviewing the Chart of Accounts you can 

review other lists like Items, Fixed Asset Items, Payroll Items, and others. 

 

7. In the Accounts Receivable section there are several cleanup task including fixing unapplied 

customer payments and credits, undeposited funds and write off invoices. As an example click the 

write Off Invoices link. This tool lets you write off overdue invoices as bad debt. Instead of 

writing off each invoice individually you can do all of them at once.  

Select the invoices to write off. Choose the write off item from the drop down arrow. Select the 

Write off Date. Click Preview & Write off to complete the process.  
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8. Use the Sales Tax cleanup tasks like find tax with no tax line and adjust sales tax payble to 

cleanup unfiled or sales tax that was handled incorrectly.  

 

9. Use the Inventory section of the CDR to ensure that inventory is being managed accurately in 

QuickBooks. Click the Compare Balance Sheet and Inventory Valuation link to make sure that the 

balance sheet and the inventory valuation summary match. This ensures that inventory has been 

recorded sales, purchases and adjustments are being hanlded correctly. 

 

10. Use the remaining sections of the Client Data Review to complete the review of  your client files. 

The remaining features let you review and correct and issues with payroll, bank reconciliations 

and other miscellaneous items.  
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17.9 Send General Journal Entries 

At the end of the fiscal year, most small businesses send their QuickBooks accounting file to their yearend 

accountant or tax professional for review. To make communication with your accountant easier, the 

QuickBooks: Premier Accountant Edition includes a feature called Send General Journal Entries. This 

feature lets the accountant create the yearend journal entries and then send them to their client. This makes 

the yearend entries easy to enter for the small business user.  

1. Click Accountant, then click Send General Journal Entries… 

2. Select the journal entries to send to the client.  

3. QuickBooks lets you send them via email as an attachment or Save as File to send them later. 

 

  

 


